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License and Warranty 

  
License Agreement 

Copyright laws of the United States and international treaty protect this software. Verity 
Software House provides this software under the following conditions: 

Software is intended to be installed and used on one computer. An additional computer 
license is required for each additional installation. 

Network versions of software require one serial number for each simultaneous use. Network 
versions are intended for installation and use on a local area network; other uses are not 
supported. 

Backups of the software must be used only for archival purposes. 

Duplication of the manual is strictly prohibited without the expressed written permission of 
the copyright holder. 

If you transfer the use of this software to another party, that party must accept the terms of 
this agreement, and you must transfer all copies of the software or destroy them. 

Your license to use this software will terminate if you are found to be in violation of this 
agreement. 

The laws of the State of Maine and the United States of America govern this license. 
  
Limited Warranty 

Verity Software House (VSH) warrants the physical media and the physical documentation, if 
included, to be free of defects in materials and workmanship for a period of 30 days from 
date of purchase. If VSH receives notice of defects in materials or workmanship within the 
warranty period, VSH will replace the defective media or documentation. 

VSH makes no other warranties, either expressed or implied, with respect to this manual or 
with respect to the software described in this manual, its quality, performance, 
merchantability, or fitness for any particular purpose. VSH software is licensed "as is". The 
entire risk as to its quality and performance is with the buyer. Should the software prove 
defective following their purchase, the buyer (and not VSH, its distributor, or its retailer) 
assumes the entire cost of all necessary servicing, repair, or correction and any incidental or 
consequential damages. In no event will VSH be liable for direct, indirect, incidental, or 
consequential damages resulting from any defect in the software, even if VSH has been 
advised of the possibility of such damages. Some states do not allow the exclusion or 
limitation of implied warranties or liability for incidental or consequential damages, so some 
of the above limitations or exclusions may not apply to you. 
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Latest Versions 

  

To find the latest versions for this software and documentation, visit the Verity Software 
House web site at www.vsh.com. This site provides a complete version of the latest 
documentation, service packs, and technical support information for the program. 
  

You can also email us at verity@vsh.com to determine whether you have the latest version. 
Please include the version that appears on the start-up dialog box and the program file date 
for the program. 
  

The program also has a Check for Updates command in the Help menu. Use this command 
periodically to see if there are updates for your software. 

  

http://www.vsh.com/
mailto:verity@vsh.com
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Naming Convention 

  

This manual and ModFit LT's analysis results use shortened forms of ploidy terms to improve 
readability. We use the term "Diploid" when referring to "DNA diploid". Similarly, we use the 
terms "Aneuploid" and "Tetraploid" when referring to "DNA aneuploid" and "DNA tetraploid" 
respectively. 

When using analysis results in publications or other contexts outside of the software, we 
suggest that the explicit "DNA" terms be used. See "Convention on Nomenclature for DNA 
Cytometry", Hiddeman et, al., Cytometry 5:445-446 (1984) for additional details. 
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New Features 

  

Version 6.0 

  

Projects 

Organize you experiments quickly and easily with Projects in ModFit LT. Projects collect your 
analysis setup, output files, and the list of FCS files that have been selected.  A project can 
also contain a copy of the FCS files themselves, making it easy to move and archive your 
experiments. 

Projects also provide improved guidance for the different kinds of analysis ModFit LT can 
perform.  Project types include cell cycle, synchronization cell cycle, cell tracking, and 
custom. 

Projects offer enhanced options for batch processing and collect output into well-defined 
locations. 

  

User Interface 

The user interface has been updated to support high DPI monitors, including updated icons 
and dynamic sizing. 

The MacOS version is now compatible with ARM and Intel processors and MacOS 10.14, 11, 
and 12 

The Windows version is now compatible with Windows 10 and 11. 

ModFit LT now supports translation into different languages.  

  

Analysis 

Improved logic for internal and external reference populations in Auto Analysis. 

Gating keywords update when gates are moved. 

A new normalized RCS value (nRCS) provides better comparison of the goodness of fit for 
samples with a large number of cells. 

The VLog transform is now available for log-like data. 

  

Output 

SVG output has been greatly improved. 

PDF output now offers user-selectable resolution. 
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Database wizard now adds all results from the Sync wizard. 

  

Bug fixes 

MF-267: Ranges disappear from range view when a report is saved, auto saved, or opened. 

MF-275: Additive Factor displays histogram channel values even in ADC mode.  

MF-609: Hyp, Dip cycles change order in Choose Model.   

MF-725: Sync wizard adjust dialog shows peak at a negative position. Corrected.  

MF-608: Changing the G2/M to Disabled in Choose Model turns off S-phase, even if manually 
checked to enable.   

MF-711: Cell tracking model fails for DDE data from WinList. 

MF-620: Failure with the cell tracking wizard and generations that are off scale.   

MF-411: Shortcut keys for actions only work on the current tab.  

MF-753: Save Image context menu output does not use correct background. 

MF-602: Wide-open gate is eliminating events on the axis. 

MF-295: Canceling during batch processing can lead to unexpected behavior.   

MF-312: Result text is clipped at 50% zoom. 

MF-306: Update results after switching the axis scale.   

MF-735: Crash after editing full model while using the sync wizard.  

MF-661: Fixed issue in remote connection with WinList that could occur if the FCS file name 
contained a Unicode character (e.g. the micro symbol). 

MF-385: Crash if the user deleted a gate and then clicked on the axis to change 
measurements on the gate that should no longer be displayed. 

MF-340: Crash if the user opened an FCS file, showed the range view, clicked New, and then 
loaded an FCS file. 

MF-353: Crash if the user deleted the last tissue type in the S-Phase Cutoffs dialog. 

MF-351: Crash if the user loaded an FCS file that had fewer measurements and a gate 
referred to measurements that did not exist in the data.   

MF-342: Crash if the user used a Gaussian component shape for S-phase.  

MF-332: Crash if the user opened malformed FCS files that contained $PnR (range) values 
that were negative. 

MF-318: Crash if the user opened an pre version 5 report with gate 2 or 3 active and the 
lower number gates inactive.   
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MF-328: Crash if the user opened certain LT 3.2 reports and clicked cancel in the analysis 
setup dialog.  

And additional bug fixes... 
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System Requirements 

  

NOTE: Your software will only run on the operating system you select at the time 
of purchase. 

  

Minimum System Configurations 

For PC Version: Windows 10 version 1607 (build 14393) or newer, Windows 11 or greater 
with 50MB free disk space for program files. 

For Mac Version: MacOS 10.14, 11.x, 12.x on ARM or Intel processor,  50MB free disk space 
for program files.  

 

Optimal Configurations 

Faster CPUs with more cores, SSD drives, and greater RAM will improve performance. 
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Installation and Running ModFit LT 

  

IMPORTANT NOTES: 

• Stand-alone versions of the program are designed to be installed and 
registered on a single computer. 

• You must have administrative rights to the computer during installation and registration 
of the software. After registration, the program can be run by users with restricted 
access to the computer. 

• You will need to register the software with Verity Software House in order to unlock the 
program on the computer. This can be done using the online registration process or by 
contacting technical support. 

• If your program is an update version, you will need the serial number for the previous 
version in order to register and unlock the software. 

• If your program is an additional computer license, you will need the serial number for 
the primary license in order to register and unlock the software. 

  

Windows Stand-alone Version 

Stand-alone version is designed to be installed and registered on a single 
computer. 

  

Installation 

• Log on to your computer with an account that has Administrator privileges. You must 
have administrative rights during installation. 

• If you downloaded the software, extract the installation files from the download into a 
temporary folder. If you have an installation CD, insert the program CD into the CD-ROM 
drive.  

• Run the program named ModFitLTSetup.exe. Follow the directions on the screen to 
complete the installation. 

• See the section on registering your software for information on how to register your 
software. 

  

Using the software 

• Log on to your computer with your own user account. This should be the account that 
you normally use on the computer. 

• Open the Start menu and navigate to the Verity folder. Choose ModFit LT 6.0. 
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Macintosh Stand-alone Version 

Stand-alone version is designed to be installed and registered on a single 
computer. 

  

Installation 

• Log on to your computer with an account that has Administrator privileges. 
• If you downloaded the software, extract the installation files from the download into a 

temporary folder. If you have an installation CD, insert the CD into the CD-ROM drive.  
• Run the ModFit LT Installer. Follow the directions on the screen to complete the 

installation. 

  

Using the software 

• Log on to your computer with your own user account. This should be the account that 
you normally use on the computer. 

• Start the program by double clicking on the ModFit LT application in the 
Applications/ModFit LT folder. 
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Registering your new software 

  

Why You Should Register 

Registration is a key step in setting up the software to run on your computer. In fact, your 
software will not be fully functional until you register. Here's why. 

This version of the program uses software security, which requires you to register your 
software in order to receive an Unlock Code to make the program fully functional. An 
unregistered installation will be fully functional for 30-days, and then become a "trial version" 
with limited functionality until it is registered. 

Of course, registration is useful for other reasons, too. We can inform you of bug fixes and 
updates, and provide you with better technical support. 

  

How to Register 

When you start the program for the first time, it will automatically start the Registration 
Wizard. You can access this dialog at any time by clicking the Registration button on the 
dialog box that is displayed when the program starts up. 
  

 

  

Click the Next button to begin the registration process. 
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The wizard will ask how you want to register the program. Select the appropriate option and 
click Next. 

 

  

The next step in the wizard shows some information about the program. There are 3 fields 
that you need to fill in for this step: Serial #, CD Key, and Email. You can also enter or edit 
the Computer Name, End User Name, and End User Email fields. 
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The Serial number and CD Key can be found on the outside of the box the program came in, 
or in email if the program was provided to you by download. Enter these exactly as they 
appear; they are case-sensitive. If you have lost or misplaced the Serial number or CD Key, 
contact Verity technical support at tech@vsh.com or (207) 729 6767. 

For the Email field, make sure to enter a valid email address. Otherwise, you may not receive 
the Unlock Code and the program will not be fully functional. 

Click Next to continue the registration process. 

If you have more than one user account at vsh.com, you will be presented with another step. 
This step only appears if you have more than one account. 

 

Choose the web account that you want to use for registration, and then click Next. 

At this point, the program will request an unlock code from the registration server at 
vsh.com. If successful, you will see the confirmation step and the Unlock Code for your 
computer. 
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You can print the registration information by clicking the Print button. Click Finish to close 
the wizard and continue working with the program 

If there was a problem with the registration, an informative message will explain the problem 
and steps to take to correct it. 

Once you have completed the registration successfully, the program will be fully functional. 

  

If the registration wizard cannot connect to vsh.com... 

Sometimes firewalls can prevent the registration wizard from connecting to vsh.com. In this 
case, you can try registering with your browser. Choose the second option in the list and click 
Next to launch your browser with the correct registration information. 
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Follow instructions on screen to complete the process. 

  

To register your software using email... 

The registration wizard can help you send email to Verity Software House with your 
registration information. Choose the third option in the list and click Next to create an email 
message. 
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Follow instructions on screen to complete the process. 

  

To register your software using another computer... 

When the installation computer does not have internet access but another computer does, 
you can use the fourth option in the list and click Next to begin the process. 

 

  

On the installation computer, write down the Computer ID displayed in the 
Register Software dialog. 

Next, go to the computer that has Internet access, launch a browser, and navigate to 
www.vsh.com. 

Click the Register Software link. 

If you already have a web account, login with your user name and password.  If you do not 
have a web account, create a new account that will be associated with this registration. 

After you login, the Software Registration page will be displayed on the web site.  Fill in 
the information in the form on this page to register the product. If you are registering an 
update version, you will need the serial number of the previous version to complete the 
registration. If you are registering an additional user license, you will need the serial number 
of another copy of the program that is registered to your institution. 

Getting an Unlock Code is a two-step process. First, you fill in and submit the registration 
form on the web site. This sends a registration request to Verity. Your Unlock Code is then 
emailed to you, so make sure you provide a valid email address. 

http://www.vsh.com/
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When you receive your Unlock Code via email, paste or type it into the Unlock Code field in 
the Registration dialog box on the installation computer. When possible, use Copy and Paste 
to do this, to ensure that the characters are correct. Then click the OK button. 

Your program will become fully functional once the Unlock Code is entered correctly. 

  

If you do not have Internet access... 

If you do not have access to the Internet, you can send the registration information below to 
Verity Software House by fax, mail, or telephone. Our technical support staff can register the 
software for you with the information you provide, and supply you with the Unlock Code to 
enter into the Registration Wizard. 

Here is the information we need. You can print this page and fill it in. 

These fields are found in the Registration dialog box. 

Program Name: 
Program Version: 
Computer ID: 
Serial number: 
CD Key: 

User Information 

Name: 
Institution: 
Address: 
City: 
State/Province: 
Zip/Postal Code: 
Country: 
Phone: 
Fax: 
Email: 

Our technicians will use the information below to create a web user account for you on our 
web site. 

Name to use on VSH web: 
Password to use on VSH web: 
A question we can ask to verify who you are: 
The answer to the question to verify who you are: 

If you are updating from a previous version, you will need to supply the serial number of the 
previous version. 

Serial Number of previous version: 
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Contact Verity Software House 

Click here for contact info. 
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Tutorials 
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Auto Analysis with a Cell Cycle Project 

  

This tutorial will introduce you to some of the key features of ModFit LT, including creating a 
new project, adding files to it, and setting up the processing options for Auto Analysis. 

• Start ModFit LT by following instructions in Installing and Running ModFit LT. 
• Click the OK button on the opening dialog, if it appears. 

 

  

The ModFit LT ribbon bar appears at the top of the application window. Buttons are grouped 
to give you quick access to the most common commands in ModFit LT. 

  

Create a new project 

We start by creating a new project. 

• Click the New button in the Project panel on the ribbon. 

 

  

The New Project dialog is displayed.  

• Choose Cell Cycle for the Type. 

• For the Name, enter Tutorial 1. 

• Click the More button and enable the Copy Data Files option. 

• Click OK 
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ModFit LT will create a folder in your Documents ModFit LT Projects folder named Tutorial 
1.  When we select FCS files for this project, ModFit LT will copy the files into the project 
folders. 

What is a project? 
A project in ModFit LT is a folder on disk used to organize an analysis or 
experiment.  It keeps track of the kind of analysis you're doing, the files you 
analyze, the output of the analysis, and even a database of analysis results. 
For more on projects, see Projects in ModFit LT. 

Add files to the project 

With our Cell Cycle project created, let's add some FCS files. 

• Click the Open FCS button on the ribbon.  The Open Data dialog is displayed. 
• Navigate to the location where ModFit LT is installed: 

• Windows: Program Files\Verity Software House\ModFit LT 6.0 
• MacOS: Applications\ModFit LT 6.0 

• In the Samples folder, select the four (4) DNA sample files: DNA-Sample1.fcs, DNA-
Sample2.fcs, DNA-Sample3.fcs, and DNA-Sample4.fcs. 

• Click Open. 
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The files will be added to the file list for the project, and the first file will be opened.  

  

Select the measurement to analyze and setup a gate 

When the first file is opened, the Analysis Setup dialog is displayed.  This dialog allows us to 
set up one or more gates and to select the measurement that we want to analyze. 

The measurement that we want to analyze is already correctly selected: FL3 PI. 
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Let's add a gate so that we can better visualize the data. 

• Click the Add Gate button in the dialog.  A new gate is added and displayed. 
• Click the X-axis label "FS". This opens a list of the measurements in the FCS file. 
• Click FL3 PI in the list to display the DNA measurement on the X axis. 
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• Click OK. 
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The dialog closes and the file is read.  The report page shows a 1P histogram of the DNA 
measurement "FL3 PI", as well as a gate plot of FL3 PI vs SS.  On the left of the main 
window, the FCS files appear in a list.  Below the list of files, processing options are shown. 
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Choose processing options 

The processing options in the lower-left portion of the screen determine what actions ModFit 
LT will perform when it analyzes each of the FCS files we added to the list.  The Type is 
already set to Cell cycle; we chose that when we created the project.  The Analysis is set to 
Auto Analyze, and that's what we want for this project.  Let's enable two output options. 

• Enable Save Report and Save PDF in the options list. 

 

With these settings, each file will be Auto Analyzed, a report will be saved, and a PDF will be 
created. 

Other options 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 37 

For details about each of the processing options, take a look at Batch 
Processing.   

  

Processing the files 

We are ready to analyze the files in this project.  This is done using the controls at the very 
bottom-left of the main window. 

• Click the Run button to analyze the first file in the list. 

 

  

Batch toolbar 
The batch toolbar has controls to move through the list of files in your project 
one at a time, or automatically to the end of the list.   

  

ModFit performs its automatic analysis of the sample. It scans the histogram for peaks, and 
based on the sizes and positions, ModFit LT determines the number of cell-cycles in the 
sample. It performs a non-linear least squares analysis of the data.  The results of the 
analysis are shown to the right of the DNA histogram. 

 

  

We can process the rest of the files in the list automatically. 

• Click the Auto Advance button on the toolbar. 
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Processing the remaining files will not take long. Notice that the file list indicates that a file 
has been analyzed as each one is processed. 

  

 

Create a database 

Let's use the Database Wizard to set up a database of the analysis results for the project.   

• Click the Edit tab of the ribbon. 

• Click the Database Wizard button in the Database panel. 

  

 

  

The Database Wizard dialog is displayed. 
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• Click Next. 
• On the next page of the wizard, select "Tutorial 1" as the database. 
• Click Finish. 

When the wizard closes, a new Database Viewer window appears on the screen.  This 
window will allow us to view records as they are added to the database.  The fields in the 
database were added by the wizard, based on the analysis we performed. 

Since it was so quick to analyze the files in our project, let's analyze them again so that the 
results can be added to the database we just created. 

• Click the Choose button on the batch toolbar and select DNA-Sample1.fcs from the 
menu. 

 

• Click the Auto Advance button to reprocess all four files in the project. 

 

  

The Database Viewer window fills with four records of analysis from the four files. 

 

Project database 
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When a new project is created, a database is created for it.  Use the Database 
Wizard to add fields quickly to the project's database.  You can show or hide the 
viewer without affecting the database, and records will be added as files are 
analyzed as long as the database is "active".  A button on the Database Viewer 
toggles the active state of the database on or off. 

Optional step 
Creating a database is an optional step for a project.  It is a useful step if you 
want to export your experimental results to another program, such as Excel, for 
further analysis.   

Review the analysis 

At this point, we have a working database and we should also have a PDF and report for 
each of the FCS files in our project.  Let's take a look at a report and PDF. 

• Double click the first file in the list.  A dialog is displayed with a set of choices.   
• Choose Open Report 

 

  

The analysis report for the first file is opened and we can review or modify the analysis. 

• Double-click the first file again, and this time choose Open PDF. 

The PDF for this analysis will open in your computer's default PDF viewer.  It will match the 
report in the ModFit LT window. 

Reports can also be opened using the Open Report button on the Home tab of the ribbon. 

  

Re-save the project 

It's always a good idea to use the Save Project button after making changes to the project. 
This is done automatically for some changes you make, but not for all. 

• Click the Save button in the Project panel of the Home tab. 
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• A dialog will appear asking if you want to save an updated report template.  Click Yes. 

 

  

Report template 
The report template contains information about the measurement selected for 
analysis, the gate, and any other elements you might add to the report.  The 
template is opened whenever you reopen the project.   

  

Reopen the project 

Let's reopen the project to verify that it saved correctly. 

• From the Project panel of the Home tab, click Open. 

 

• The Select a Project dialog is displayed, showing the Projects folder. 

• Select Tutorial 1 in the list and click the Select Folder button. 

The project will open.  The list of files and the processing options should be the same as we 
left them. The database viewer is shown. The report template is loaded, but it will show No 
Data in the DNA and gate plots. 
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To review one of the reports already analyzed, double-click the file in the list and choose 
Open Report. You can add files to the project to analyze more.  You can also save the 
project under another name and it will be set up just like this project. 

Welcome to ModFit LT! 
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Analysis with a Sync Wizard Project 

  

This tutorial focuses on using the Sync Wizard to analyze samples that were blocked in G0G1 
and then released.  We'll create a project to help manage the FCS files and output. 

• Start ModFit LT by following instructions in Installing and Running ModFit LT. 
• Click the OK button on the opening dialog, if it appears. 

 

  

The ModFit LT ribbon bar appears at the top of the application window. Buttons are grouped 
to give you quick access to the most common commands in ModFit LT. 

  

Create a new project 

We start by creating a new project. 

• Click the New button in the Project panel on the ribbon. 

 

  

The New Project dialog is displayed.  

• Choose Synchronized cell cycle for the Type. 

• For the Name, enter Sync Wizard Tutorial. 

• Click the More button and enable the Copy Data Files option. 

• Click OK 
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ModFit LT will create a folder in your Documents ModFit LT Projects folder named Sync 
Wizard Tutorial.  When we select FCS files for this project, ModFit LT will copy the files into 
the project folders.  See Projects in ModFit LT for more info. 

  

Add files to the project 

With our project created, it is time to add FCS files. 

• Click the Open FCS button on the ribbon.  The Open Data dialog is displayed. 
• Navigate to the location where ModFit LT is installed: 

• Windows: Program Files\Verity Software House\ModFit LT 6.0 
• MacOS: Applications\ModFit LT 6.0 

• In the Samples\Sync folder, select the seven (7) sample files: cho074dn.fcs through 
cho080dn.fcs. 

• Click Open. 
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The files will be added to the file list for the project, and the first file will be opened.  

Setting gates 
The example files used in this tutorial are histogram format FCS files, so there is 
no gating to set up.  In most cases, FCS files are listmode format, and ModFit LT 
would allow you to select the measurement to analyze as well as to set up gates. 

  

Choose processing options 

The processing options in the lower-left portion of the screen determine what actions ModFit 
LT will perform when it analyzes each of the FCS files we added to the list.  The Type is 
already set to Synchronized cell cycle. The Analysis is set to Fit with current 
model.  Let's enable two output options. 

• Enable Save Report and Save PDF in the options list. 
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With these settings, each file will be analyzed with the Sync Wizard's model, a report will be 
saved, and a PDF will be created. 

  

Setting up the Sync Wizard 

We are ready to launch the Sync Wizard to set up the analysis. 

• Click the Sync Wizard button in the Analysis panel of the Home tab. 

 

  

The Synchronization Wizard dialog is displayed, showing the Start tab.   

 

  

• Click the G0-G1 tab.   

The G0-G1 tab displays the DNA histogram.  In this sample, all of the cells are blocked in G0-
G1, so we see only one peak.  

A red arrow appears above the peak, indicating where ModFit LT has found a peak.  The 
position of this peak is shown in an edit box below the plot.  If you move the red arrow with 
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your mouse, the value in the edit box updates with the new position.  You can also type a 
position directly into the edit box to set the peak's position.  Since the correct peak was 
found (~401), we will use that value in this tutorial. 

 

On the right side of the dialog, we can tell the wizard to Lock position and SD for the G0-
G1 peak or Adjust automatically.  Since there is a well defined peak, leave this setting on 
Adjust automatically.   

Another option tells the wizard what to do if it cannot find a peak in subsequent FCS 
files.  Set this to Use the last G0-G1 position. 

• Click the G2-M tab. 

This tab also displays a plot of the DNA histogram.  Now the red triangle has moved to ~802 
and there is no peak under it.   
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If there is no peak found on this tab, the wizard will assume that the G2-M position is two 
times the G0-G1 position.  We note this in the G2-M position (803) and the G2/G1 ratio 
(2) edit boxes. In the Sync Wizard, the position of the G2-M peak is always dependent on the 
position of the G0-G1 peak. Similarly, the standard deviation of the G2-M peak is dependent 
on the standard deviation of the G0-G1 peak. 

With the samples for this tutorial, we know that the G2/G1 ratio is closer to 1.92, so we can 
enter that value in the G2/G1 ratio edit box. 

• Enter 1.92 in the G2/G1 ratio edit box. 
• Click the S-Phase tab 

The S-Phase tab displays options for the S-Phase shape, number of compartments, and 
spacing of the compartments.   

The S-Phase Shape can either be Rectangle or Trapezoid.  A rectangle is more conservative 
and robust, and a trapezoid has an additional degree of freedom.  Leave the selection on 
Rectangle for this tutorial. 

The Number of Compartments determines how many rectangles or trapezoids to use 
when fitting the S-Phase.  More compartments provides more flexibility, but it can also allow 
the wizard to overfit the data.  We'll use 3 compartments in this tutorial. 

Leave the Compartment Spacing set to Equal spacing. 

For more on these options, see Sync Wizard: S-Phase tab. 
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• Click the Other tab. 

This tab shows a few other analysis options: Debris and Aggregates.  We will leave both of 
these unchecked for this example. 

 

• Click the Report tab. 
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This tab provides some reporting options, which we will not change in this example. 

 

  

• Click the Analyze button to initiate the analysis. 

ModFit LT analyzes the data for the first file with the Sync Wizard model and displays the 
results on the report page. Information about the G0G1, G2M, and S-Phase is reported on 
the right. 
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Create a database 

Now that we have analyzed a file, we can use the Database Wizard to set up a database of 
the analysis results for the project.   

• Click the Edit tab of the ribbon. 

• Click the Database Wizard button in the Database panel. 

  

 

  

The Database Wizard dialog is displayed. 

 

  

• Click Next. 
• On the next page of the wizard, select "Sync Wizard Tutorial" as the database. 
• Click Finish. 

When the wizard closes, a new Database Viewer window appears on the screen.  This 
window will allow us to view records as they are added to the database.  The fields in the 
database were added by the wizard, based on the analysis we performed. 

Optional step 
Creating a database is an optional step for a project.  It is a useful step if you 
want to export your experimental results to another program, such as Excel, for 
further analysis.   
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Processing the files 

We can process the rest of the files in the list one at a time or automatically.  To do this, we'll 
use the control on the batch toolbar, shown on the bottom-left side of the main window. 

• Click the Next button on the batch toolbar. 

 

  

Before ModFit LT reads the next file, it saves the report and PDF for the file we just finished - 
the first file in the list.  It also adds a record to the database for the first file, which appears 
in the Database Viewer window.  Then it reads the next file in the list and analyzes it using 
the Sync Wizard model.   

This second sample is very similar to the first, but more cells have moved into S-Phase. 

 

Let's add a zoomed view of the plot to the report so that we can see the S-Phase in more 
detail. 

• In the Insert tab of the ribbon, click Y Zoom in the Graphs panel. 

 

  

A zoomed version of the plot is added directly below the full-scale view.  The details of the S-
Phase are magnified. 
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Use the Save Project button after making changes to the project to save your changes. 

• Click the Save button in the Project panel of the Home tab. 

 

• A dialog will appear asking if you want to save an updated report template.  Click Yes. 

 

  

• Click the Next button on the batch toolbar, and even more cells have moved into S-
Phase. 
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• Click the Auto Advance button on the toolbar to process the remaining files in the list. 

 

  

When it finishes processing, the analysis for the last file remains on the report.  The cells in 
this sample are mostly in S-Phase and G2-M. 

  

 

The database Viewer shows records for all files in the project. 
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Review the analysis 

ModFit LT created a PDF and report for each of the FCS files in our project as we analyzed 
them.  Let's take a look at a report and PDF. 

• Double click one of the files in the list.  A dialog is displayed with a set of choices.   
• Choose Open Report 

 

  

The analysis report for the selected file is opened and we can review or modify the analysis. 

• Double-click the same file, and this time choose Open PDF. 

The PDF for this analysis will open in your computer's default PDF viewer.  It will match the 
report in the ModFit LT window. 

Reports can also be opened using the Open Report button on the Home tab of the ribbon. 

  

Reopen the project 

Let's see what the project looks like when we open it again. 
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• From the Project panel of the Home tab, click Open. 

 

• The Select a Project dialog is displayed, showing the Projects folder. 

• Select Sync Wizard Tutorial in the list and click the Select Folder button. 

The project will open.  The list of files and the processing options should be the same as we 
left them. The database viewer is shown. The report template is loaded, but it will show No 
Data in the plot. 

  

 

  

To review one of the reports already analyzed, double-click the file in the list and choose 
Open Report. You can add files to the project to analyze more.  You can also save the 
project under another name and it will be set up just like this project. 

  

Summary 

The Sync Wizard is a tool designed to allow you to analyze samples with perturbed S-Phase 
and G2-M populations. It is divided into "tabs" that allow you to describe your data and 
choose options to use in modeling your data. 
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Control the model's flexibility by adjusting the shape used and number of compartments in S-
Phase. The default setting, 3 rectangles, is good for most cases. The trapezoid shape more 
closely approximates the shape of the perturbed S-Phase distribution, but it can provide the 
model too much flexibility. 

Once you have created a model with the Wizard, use the buttons on the batch toolbar to 
analyze your sample files. 
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Analyzing with a Cell Tracking Project 

  

The Cell Tracking Wizard is used to analyze samples stained with CFSE or other cell tracking 
dyes.  In this tutorial, we will create a cell tracking project to demonstrate how it works. 

• Start ModFit LT by following instructions in Installing and Running ModFit LT. 
• Click the OK button on the opening dialog, if it appears. 

 

  

The ModFit LT ribbon bar appears at the top of the application window. Buttons are grouped 
to give you quick access to the most common commands in ModFit LT. 

  

Create a new project 

We start by creating a new project. 

• Click the New button in the Project panel on the ribbon. 

 

  

The New Project dialog is displayed.  

• Choose Cell proliferation tracking for the Type. 

• For the Name, enter Cell Tracking Tutorial. 

• Click the More button and enable the Copy Data Files option. 

• Click OK 
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ModFit LT will create a folder in your Documents ModFit LT Projects folder named Cell 
Tracking Tutorial.  When we select FCS files for this project, ModFit LT will copy the files into 
the project folders.  See Projects in ModFit LT for more info. 

  

Add files to the project 

With our project created, it is time to add FCS files. 

• Click the Open FCS button on the ribbon.  The Open Data dialog is displayed. 
• Navigate to the location where ModFit LT is installed: 

• Windows: Program Files\Verity Software House\ModFit LT 6.0 
• MacOS: Applications\ModFit LT 6.0 

• In the Samples\Proliferation folder, select two files: nonprol.fcs and prol.fcs. 
• Click Open. 
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The files will be added to the file list for the project, and the first file will be opened.  

  

Select the measurement to analyze and setup a gate 

When the first file is opened, the Analysis Setup dialog is displayed.  This dialog allows us to 
set up one or more gates and to select the measurement that we want to analyze. 

The Analysis Population is showing FL1-Height LOG.  We want to select a different 
measurement with the cell tracking dye. 

• Click the FL1-Height LOG label and choose FL2-Height LOG from the menu. 
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This is the measurement we want to analyze. 

 

  

If we need to do additional gating, we could add gates now.  In this case, we will analyze the 
data without additional gates. 

• Click OK. 

The dialog closes and the file is read.  The report page shows a 1P histogram of the cell-
tracking measurement "FL2-Height LOG". On the left of the main window, the FCS files 
appear in a list.  Below the list of files, processing options are shown. 
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Choose processing options 

The processing options in the lower-left portion of the screen determine what actions ModFit 
LT will perform when it analyzes each of the FCS files in the list.  The Type is set to Cell 
proliferation tracking. The Analysis is set to Fit with current model.  Let's enable two 
output options. 

• Enable Save Report and Save PDF in the options list. 

 

  

With these settings, each file will be analyzed with the Cell Tracking Wizard's model, a report 
will be saved, and a PDF will be created. 
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Setting up the Cell Tracking Wizard 

We are ready to launch the Cell Tracking Wizard to set up the analysis. 

• Click the Cell Track Wizard button in the Analysis panel of the Home tab. 

 

  

The Cell Tracking Wizard dialog is displayed showing the Start tab. 

 

  

• Click the Parent tab. 
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A plot of the selected measurement is shown on the left.  A red triangle identifies the 
brightest peak that the wizard found in the sample. This is assumed to be the parent 
population.  If the wizard did not find the correct location for the parent population, you can 
move the red triangle to the correct position or type the position into the edit box on the 
right.  In this sample, the correct position was found so no change is needed. 

This tab gives us the ability to Lock SD for the parent.  This option is useful with noisy data 
or in cases where the parent population may become very small in subsequent samples.  In 
this tutorial, leave the option unchecked. 

• Click the Generations tab. 
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On this tab, the plot indicates the parent position with a red vertical line.  Dotted lines are 
drawn in the computed locations for daughter generations, each having half of the intensity 
of its predecessor. 

The number of generations can be set using the combo box on the right.  As we can see, 
nine (9) is the correct value for this sample so no change is necessary.  This value should be 
set to capture all daughter generations between the parent and 0 on the axis. 

We will leave the model option as Standard for now. 

• Click the Other tab. 
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This tab determines the generation that is the start of true proliferation and several other 
useful settings.  These are all in the correct state for this tutorial, so no changes are required. 

• Click the Analyze button to initiate the analysis. 

  

ModFit LT analyzes the first sample file with the Cell Tracking Wizard model and displays the 
results on a report page.  A plot of the cell tracking measurement and a legend appear on 
the left. On the right the report shows the position and fraction for the parent and each 
daughter generation, as well as key results from the proliferation analysis. 
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Create a database 

Now that we have analyzed a file, we can use the Database Wizard to set up a database of 
the analysis results for the project.   

• Click the Edit tab of the ribbon. 
• Click the Database Wizard button in the Database panel. 

  

 

  

The Database Wizard dialog is displayed. 

 

  

• Click Next. 
• On the next page of the wizard, select "Cell Tracking Tutorial" as the database. 
• Click Finish. 

When the wizard closes, a new Database Viewer window appears on the screen.  This 
window will allow us to view records as they are added to the database.  The fields in the 
database were added by the wizard, based on the analysis we performed. 

Optional step 
Creating a database is an optional step for a project.  It is a useful step if you 
want to export your experimental results to another program, such as Excel, for 
further analysis.   



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 68 

  

Processing the files 

We can process the rest of the files in the list one at a time or automatically.  To do this, we'll 
use the controls on the batch toolbar, shown on the bottom-left side of the main window. 

• Click the Next button on the batch toolbar. 

 

  

Before ModFit LT reads the next file, it saves the report and PDF for the file we just finished - 
the first file in the list.  It also adds a record to the database for the first file, which appears 
in the Database Viewer window.  Then it reads the next file in the list and analyzes it using 
the Cell Tracking Wizard model.   

In this second sample, most of the cells have divided at least once.  The daughter 
generations have more cells than the parent generation. 

 

Let's make the plot larger so that we can see the populations better. 

• Click the plot to select it.  Sizing handles will appear on its borders. 
• Using the sizing handles, make the plot larger. 
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Any time you make revisions to your report layout, use the Save Project button to save your 
changes. 

• Click the Save button in the Project panel of the Home tab. 

 

• A dialog will appear asking if you want to save an updated report template.  Click Yes. 

 

Note 
You would need to reanalyze the 2 files in this project to update their reports 
and PDFs with the modified report template.    

If there were additional files in this experiment, we could use the Auto Advance button on 
the batch toolbar to analyze them.  In this case, our two files are analyzed and saved. 

The database Viewer shows records for all files in the project. 
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Review the analysis 

ModFit LT created a PDF and report for each of the FCS files in our project as we analyzed 
them.  Here is the quick way to view them. 

• Double click the second file in the list.  A dialog is displayed with a set of choices.   
• Choose Open Report 

 

  

The analysis report for the selected file is opened and we can review or modify the analysis. 

• Double-click the second file again, and this time choose Open PDF. 

The PDF for this analysis will open in your computer's default PDF viewer.   

• When you have finished reviewing the PDF, close the PDF viewer. 

  

Adjusting the model 

You may be interested in trying several other options in the Cell Tracking Wizard, found in 
the Other tab. To try these, you need to display the wizard dialog. 
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• Click the Cell Track Wizard button on the wizard toolbar at the bottom of the main 

window. The Cell Tracking Wizard dialog is displayed. 

 

  

The wizard opens in editing mode so that you do not have to recreate the wizard model from 
scratch. Visit the tabs in the wizard to make changes you want to try out. 

• On the Other tab, uncheck Save project template.  You may not want to save these 
changes to disk until after you review them. 

• Click the Analyze button. The sample is analyzed with the modified cell tracking model. 

If you decide to keep the changes, use the Save Project button in the Project panel of the 
Home tab to update the project.  When prompted to save the report template, click Yes. 

  

Reopen the project 

Let's see what the project looks like when we open it again. 

• From the Project panel of the Home tab, click Open. 

 

• The Select a Project dialog is displayed, showing the Projects folder. 

• Select Cell Tracking Tutorial in the list and click the Select Folder button. 

The project will open.  The list of files and the processing options should be the same as we 
left them. The database viewer is shown. The report template is loaded, but it will show No 
Data in the plot. 
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To review one of the reports already analyzed, double-click the file in the list and choose 
Open Report. You can add files to the project to analyze more.  You can also save the 
project under another name and it will be set up just like this project. 

  

Summary 

The Cell Tracking Wizard is a tool designed to allow you easily to analyze samples prepared 
with cell tracking dyes. It is organized by categories into tabs which allow you to describe 
your data and choose options to use in modeling your data. 
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Creating a Custom Project 

  

In this tutorial, we will create a custom project to analyze DNA cell cycle in yeast samples. As 
shown in the diagram below, yeast cell cycle is quite different from mammalian cell 
cycle.  ModFit LT's automatic analysis was not designed to analyze samples from yeast 
populations.  However, ModFit LT allows the user to create models from scratch for novel 
applications, such as yeast DNA analysis, and we can create a project to organize the model, 
sample files, and output we generate. 

  

 

We will use a yeast model previously developed and learn how to incorporate the model into 
a new project.  Let's get started. 

• Start ModFit LT by following instructions in Installing and Running ModFit LT. 
• Click the OK button on the opening dialog, if it appears. 
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The ModFit LT ribbon bar appears at the top of the application window. Buttons are grouped 
to give you quick access to the most common commands in ModFit LT. 

  

Create a new project 

We start by creating a new project. 

• Click the New button in the Project panel on the ribbon. 

 

  

The New Project dialog is displayed.  

• Choose Custom for the Type. 

• For the Name, enter Yeast Custom. 

• Click the More button and enable the Copy Data Files option. 

• Click OK 

 

  

ModFit LT will create a folder in your Documents ModFit LT Projects folder named Yeast 
Custom.  When we select FCS files for this project, ModFit LT will copy the files into the 
project folders. 
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Open the previously-created report with custom model 

For this example, we have a custom model and report that were created in a previous 
version of ModFit LT. We will use that as the basis for this new project. 

• Click the Open Report button in the Report panel of the ribbon.  The Open Reports 
dialog is displayed. 
 

 
• Navigate to the location where ModFit LT is installed: 

• Windows: Program Files\Verity Software House\ModFit LT 6.0 
• MacOS: Applications\ModFit LT 6.0 

• In the Samples\Yeast folder, open Yeast.mfl. 

The report opens in ModFit LT showing the analysis from a previous version of ModFit LT. 
This report contains a custom model designed to analyze yeast cell cycle. 
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To make this model part of the new project, all we have to do is save the project again. 

• Click the Save button in the Project panel on the Home tab of the ribbon. 
 

 

At this point, our project is all setup to use this custom model as part of the project's report 
template. 

Projects and Report Templates 
Each project you create in ModFit LT will contain a report template file that is 
opened each time the project is opened.  The report template is automatically 
given the same name as the project.  The report template contains the models, 
the gates, the report layout, and other information. 
If you open a report or report template manually and want to use it in your 
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project, simply use the Save Project command and click "Yes" when asked if you 
want to save the project template. 

Add files to the project 

With the custom model added to the new project, let's add some FCS files. 

• Click the Open FCS button on the ribbon.  The Open Data dialog is displayed. 
• Navigate to the location where ModFit LT is installed: 

• Windows: Program Files\Verity Software House\ModFit LT 6.0 
• MacOS: Applications\ModFit LT 6.0 

• In the Samples\Yeast folder, select the four (4) yeast sample files: yeast-1.fcs, yeast-
2.fcs, yeast-3.fcs, and yeast-4.fcs. 

• Click Open. 

 

  

The files will be added to the file list for the project, and the first file will be opened.  

  

Choose processing options 

The processing options in the lower-left portion of the screen determine what actions ModFit 
LT will perform when it analyzes each of the FCS files we added to the list.  The Type is 
already set to Custom, which we chose that when we created the project.  The Analysis is 
set to Fit with current model, and that's the only option for a custom project.  Let's enable 
two output options. 

• Enable Save Report and Save PDF in the options list. 
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With these settings, the custom model will be used to analyze each file after it is read.  Then, 
a report and PDF will be created. 

  

Analyze the first file 

We are ready to analyze the first file.  This is done using the controls at the very bottom-left 
of the main window. 

• Click the Run button to analyze the first file in the list. 

 

  

The first file is read and analyzed with the custom yeast model in our project.  

If the gates need to be adjusted, this is the time to do that.  The first gate is used to remove 
some low PI events, and the second gate removes some of the brightest events that may be 
pegged. 

  

The next step for custom models is to check the positions of the ranges used by the 
model.  Ranges are positioned over the peaks in the sample to provide initial estimates for 
the model.  Here's how to view and adjust the ranges. 
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• Click the Range button in the View panel on the Home tab of the ribbon.   
 

 

This switches ModFit LT into Range view, where the model's ranges are displayed.  The filled 
area under each range represents the initial estimate for the peak that is under the 
range.  The idea is to position and size the ranges over the peaks to give a reasonable first 
estimate to the modeling routine. 

With this yeast model, the 2C range should be positioned over the first peak (on the left) at 
~200.  The 4C range should be at ~2X the position of the 2C range at ~400.  The 6C range 
should be at ~3X the 2C range at ~600, and the 8C range should be at ~4X the 2C range at 
~800.  If needed adjust the ranges so that they are centered on those positions. Once a 
range is selected, you can also adjust the width of the range with the handle that 
appears.  The width can be fairly narrow; it is better to provide a narrower width estimate, 
not an overly broad width estimate. 

 

When the ranges are adjusted, you are ready to re-fit the model to the data. 

• Click the Fit button in the Analysis panel of the Home tab on the ribbon. 

 

ModFit LT switches back to Analysis view and shows the analyzed sample.  The analysis will 
look similar to the one shown below. 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 80 

 

  

  

Create a database 

Now that we have analyzed the first file, we can use the Database Wizard to set up a 
database of the analysis results for the project.   

• Click the Edit tab of the ribbon. 
• Click the Database Wizard button in the Database panel. 

  

 

  

The Database Wizard dialog is displayed. 
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• Click Next. 
• On the next page of the wizard, select "Yeast Custom" as the database. 
• Click Finish. 

When the wizard closes, a new Database Viewer window appears on the screen.  This 
window will allow us to view records as they are added to the database.  The fields in the 
database were added by the wizard, based on the analysis we performed. 

  

Processing other files 

We can process the rest of the files in the list one at a time or automatically.  If the gates or 
ranges might need to be adjusted, it is best to advance one file at a time through the 
project.    

• Click the Next button on the batch toolbar. 

 

  

Before ModFit LT reads the next file, it saves the report and PDF for the file we just finished - 
the first file in the list.  It also adds a record to the database for the first file, which appears 
in the Database Viewer window.  Then it reads the next file in the list and analyzes it using 
the project's custom model.   

The workflow for each file follows the pattern for the first file: 

• Check the gates and make any adjustments needed. 
• Click the Range button to switch to Range view. 
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• Adjust the ranges to identify the correct peaks and adjust peak widths if needed. 
• Click the Fit button to re-analyze the file with any adjustments you made. 
• Click Next on the batch toolbar to move to the next file. 

Process the remaining files using these steps. 

  

Review the analysis 

ModFit LT created a PDF and report for each of the FCS files in our project as we analyzed 
them.  Let's take a look at a report and PDF. 

• Double click one of the files in the list.  A dialog is displayed with a set of choices.   
• Choose Open Report 

 

  

The analysis report for the selected file is opened and we can review or modify the analysis. 

• Double-click the same file, and this time choose Open PDF. 

The PDF for this analysis will open in your computer's default PDF viewer.  It will match the 
report in the ModFit LT window. 

Reports can also be opened using the Open Report button on the Home tab of the ribbon. 

  

Summary 

Custom projects are used for samples that don't fit the traditional DNA, synchronization, or 
cell tracking approaches. In this case, we opened a report file that contained a custom model 
designed to analyze DNA of yeast samples. 

After creating a new, custom project, you can use Open Report or Open Report Template to 
read a previously created model into the project. You can also create a model from scratch or 
by using one of the built in tools such as Auto Analysis, the Sync Wizard, or the Cell Tracking 
wizard.  Be sure to use the Save Project command to make your model and report part of the 
project's report template. 
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Use the batch toolbar to process samples in a custom project. You can process files one at a 
time, adjusting gates and ranges before moving on to the next file. 

  

  



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 84 

Manual analysis with ModFit LT 

  

If ModFit LT has difficulty detecting peaks or identifying the ploidy patterns of a sample using 
automatic analysis, you can use manual analysis to analyze the data. 

Manual analysis involves several steps. First, you open the sample you want to analyze. Next, 
you use the Choose Model dialog box to select a model that matches your assessment of the 
sample. Once the model is selected, you need to position ranges over important peaks, and 
finally tell the program to analyze the sample. 

  

When to Use Manual Analysis 

Here is an example. 

• Click the Open FCS button on the Home tab of the ribbon. 
• Open the file "Problem1.fcs" from the Samples folder. 

 

  

There are several problems with this histogram, the most important being that its peaks are 
very broad and indistinct. In order for Auto Analysis to succeed, the important peaks in the 
histogram must be correctly identified. Peaks are shown by the small black triangles under 
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the graphic. The program probably missed one or both of the dominant peaks in the 
histogram. 

This is a circumstance where you must use manual analysis to model the sample. Even if the 
peaks are all detected, you can still continue with this tutorial. 

  

Choosing a Model 

• Click the Choose Model button on the ribbon bar  and a dialog is 
displayed. 

This dialog allows you to define the model that you want to use for the histogram. Based on 
the options you choose, the program will construct a model to match those assumptions. This 
is a DNA Aneuploid sample, so the selections we make in the dialog need to reflect that. 

 

  

• Enable Auto Debris by checking the Auto Debris checkbox. 
• Enable Auto Aggregates by checking the Auto Aggregates checkbox. 
• Disable Apoptosis by clearing the check in the Apoptosis checkbox. 
• Set Linearity to 2.0. This is the default G2/G1 ratio. 
• Set Internal Standards to 0. There are no internal standards in this file. 
• Set Number of cycles to 2. We want to model 2 cell cycles in this data file: a Diploid 

and an Aneuploid cycle. 
• For the Model template, choose "Dip Ane". This tells the program the ploidy to assign 

to each cycle. 
• For the Range positions, choose "Compute range positions". If you use this dialog to 

modify a model, you might choose "Use current range positions" so that the program 
did not move existing ranges. 

• Click OK to confirm your choices and close the dialog. 

  

Adjusting Ranges 
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The program will construct the model and try to position the model ranges over detected 
peaks. It switches to the Range view automatically. You can switch to this view anytime by 
clicking the Range button on the ribbon. 

In the Range view, you can position ranges over the peaks in the sample. You move a range 
by clicking on the range label, and dragging it to a new location with the mouse button 
down. When finished, you release the mouse button. To adjust the width of a range, click the 
black handle and drag to choose a new size. If a range is already correctly positioned and 
sized, do not move or resize it. 

• Make sure the Debris range is located over the starting point of debris at the left edge 
of the histogram. This range is always used to identify the start of debris. The right side 
of the range should be placed at approximately two-thirds of the histogram scale. 

• Next, move the Dip G1 range over the first peak, the DNA Diploid G0-G1. It does not 
need to be stretched to encompass the peak as long as it is centered on the peak. You 
should see a red fill in the first peak that indicates the range estimate of the size of the 
peaks. 

• Move the An1 G1 range over the center of the second peak, the DNA Aneuploid G0-G1. 
This peak will fill with yellow to indicate the range estimate. 

Notice that as you move a range, the left pane on the status bar displays information about 
the range position. The left and right values are in the units shown on the X-axis; the top is 
in number of events. When the mouse button is released, the status bar indicates the fitted 
estimates for the range. 

• Move the Dip G2 range over the portion of the histogram that is about twice the 
position of the Dip G1 range. This is the approximate position of the Diploid G2-M. 

• Move the An1 G2 range to about twice the position of the An1 G1 range. This is the 
approximate position of the Aneuploid G2-M. 
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Fitting the Model 

With the ranges in position, you are ready to analyze the sample. 

• Click the Fit button on the ribbon to perform the non-linear least squares fit. The 
results will be similar to the one shown here. 

  

 

  

• Review the analysis to ensure that the model correctly matches the sample. If it does 
not, you should make sure you selected the correct model and that its ranges are 
correctly positioned. 

  

Summary 

The manual analysis mode should be used when the peak finder or automatic analysis mode 
fails, or you need to make your own decisions about how to model a sample. It enables user-
intervention at the key points in the analysis: model selection and range positioning. 

Models are selected using the Choose Model option on the Home tab of the ribbon bar. 

Ranges used to identify peaks must be positioned so that each range identifies a unique 
peak; they should not overlap. For example, the Dip G1 range is used to identify the Diploid 
G0G1 peak, and no other peak range should be placed over the same peak. You should not, 
for example, place the An1 G1 range over the same peak as the Dip G1 range. The Debris 
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range is the only exception. Since it does not identify a peak, it should be stretched across 
about two-thirds of the histogram. 

  

See also: 

Model Descriptions 

Choose Model command 

Ranges command 
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Enhanced Cell Tracking Analysis 

  

Features in ModFit LT and WinList provide unparalleled capabilities to analyze cell 
proliferation. 

ModFit LT performs sophisticated least squares analysis in just a few clicks of a mouse and 
reveals the secrets of the proliferation data: proliferation index, non-proliferative fraction, 
and precursor frequency, and fractions for each proliferating generation. The proliferation 
results can be exported so that other applications can extend the analysis. 

Enter WinList. NStat regions can import the proliferation results from ModFit LT, and then 
partition the generations according to the proliferation analysis. This enhancement sets the 
stage for exciting new analysis capabilities. 

This tutorial will explore these new features to examine a CFSE-stained sample containing 
several other markers. 

  

The big picture 

From the Cell Tracking Wizard in ModFit LT... 

 

... into WinList for exciting, new explorations of proliferation. 
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Getting started 

To start, we will use the Cell Tracking Wizard in ModFit LT and export its results. Then, you 
will set up WinList to import those results into an NStat region. 

You will need both ModFit LT and WinList for this tutorial. WinList must be version 
9.0 or greater. 

• Launch WinList and pass through the opening dialogs. 
• Launch ModFit LT and pass through the opening dialogs. 
• Using ModFit LT's Open FCS command, navigate to the Samples folder located in the 

WinList application folder. Select "CFSE sample.fcs" and click Open.  Note, the dialog 
may look different than the one shown below, depending on the version of ModFit LT 
you are using. 
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• Choose "FL1-H-CFSE" as the analysis parameter. 
• Next, right-click on the histogram and choose Edit X Parameter. Choose Log for the 

Transform and click OK. 

 

The axis now displays the Log transform.  We don't need to create any gates - we'll do that 
later in WinList. 

• Click OK. 
• On ModFit LT's home tab choose Cell Track Wizard. 
• In the Cell Tracking Wizard dialog, click the Generations tab and choose the "Floating" 

model option from the drop-down list.  
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• Click the Other tab, and enable Export partition table and Prompt for file name 
checkboxes. These options will cause the program to create the export file after analysis 
and allow you to enter a name for the export file.  

 

• Finally, click the Analyze button to perform the analysis. 
• When the analysis is complete, the Choose Location to Save Partitions dialog will be 

displayed. You can save the file to any location. For this tutorial, save the export file to 
the desktop so that it's easy to find later. 

When you choose the Export option for the Cell Tracking Wizard, the program 
determines the boundaries between adjacent generations and writes that information 
to the export file. The boundaries are the points of intersection between the Gaussian 
components in the model. 

 

  

Setting up WinList 

• Activate WinList and click the Open FCS button on the ribbon bar. 
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• Navigate to the Samples folder located in the WinList application folder. Select the "CFSE 
sample.fcs" file and click Open. 

• In the Create Histograms dialog, select CFSE in the X Axis list and CD69 PE in the Y 
Axis list. Click Add to List two times. This will create two copies of CFSE vs. CD69 PE. 
Click OK to close the dialog. 

 

  

You can change the graphical display for the histograms you've just created. Right 
click on the histogram and choose Graphics. Try out the different display options to 
see what you like best.. 

For this analysis we need to use a standard Log transform for the X and Y axis, not 
HyperLog. The exported information from ModFit LT is in Log units. 

• Move the mouse over the CFSE label on the X-axis and click the small triangle that 
appears.  Select Log from the list of transformations.  Repeat this for the CD69 Y-axis. 
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• Click on the title bar of the first dot plot to activate it. Click the NStat region tool in the 
histogram toolbar. 

• In the NStat Properties dialog, click the Import button. 

 

  

• Navigate to the Desktop folder and select CellTrackingWizardPartitions.txt and click 
Open. 

• Edit the NStat rows to 1 and check the Show Vertices, Results, and Enable gates 
checkboxes. The number of columns should already be 10 from the Import.  Click OK. 
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WinList creates the NStat partitions using the imported Cell Tracking information and displays 
a results window with statistics. 

 

  

Isolating the generations 

At this point, you have completed the basic import process. Let's extend the WinList analysis 
to explore other markers as a function of the proliferation analysis. 

• Click the title bar of the second histogram, and click the NStat region tool button to 
create another NStat. For this one, set NStat rows to 2 and NStat columns to 1.  Check 
the Enable gates option and uncheck other options. Click OK. 
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Now, one of the histograms contains an NStat that shows the proliferation partitions, and the 
other histogram has an NStat that will allow us to define the CD69 negatives and positives. 

• Drag the region by the label to adjust the second NStat so that it approximately divides 
the two major populations in the second histogram, as shown. 

You can change the graphics for any histogram by choosing Graphics from the 
right-click context menu for a histogram. 
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To analyze and visualize the generations better, we will create a calculated parameter using 
the FCOM function. This function creates a new parameter that will allow us to look at each 
population independently. It uses gates as input, and we'll use the gates from the NStat 
regions we just created. 

Let's create a few FCOM calculated parameters to help isolate the generations. 

• Click the Add Parameter button on the main ribbon bar.  Alternatively, you can right-

click in the data source and choose Add Parameter from the context menu. 

 

  

• Click the Add button in the Edit Calculated Parameters dialog. 
• Type Proliferation in the Name edit box.  Type or copy this expression into the 

Equation edit box, and then click OK. 

FLOG(FCOM(G1,G2,G3,G4,G5,G6,G7,G8,G9,G10)+0.5)*256/FLOG(1024)+FR
ND(3) 

This expression deserves some explanation. Let's break it apart, starting with the FCOM 
portion. FCOM is a "gate combination" function. It takes any number of gates as arguments; 
the result of the equation depends on how many gates are in the expression. With a single 
gate, there are 2 possible event classifications: an event is "in" or "not in" the gate. With two 
gates, there are 4 possible event classifications. With the ten gates in our expression, FCOM 
can produce 1024 different event states. 

However, since these gates do not overlap at all, most of the 1024 possible states have no 
events in them. In fact, the only states that contain events are the 10 single-positive event 
states, resulting in values of 1, 2, 4, 8, 16, 32, 64, 128, 256, and 512. If we plotted the result 
of the FCOM function as a histogram, we would see 10 spikes of events, and the spikes 
would be exponentially spaced. 

Our goal is to see these 10 spikes evenly spaced across the histogram. This is where the 
FLOG function comes in. By taking the log of the FCOM output and scaling it by 1024, we 
redistribute the 10 FCOM values evenly across 256 channels. The final portion of the 
expression, "+FRND(3)", changes the spikes of events into Gaussian distributions so that 
they can be better visualized. 

Take a look at the WinList reference sections on Add Parameters and FCOM for 
details on the complete set of WinList functions. 

• Once again, click the Add button in the Edit Calculated Parameters dialog. 
• Type CD69 Expression in the Name edit box.  Type or copy this expression, and click 

OK. 
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(FCOM(G11)+0.5)*256/2+FRND(3) 

 

  

• Click OK. 

  

CD69 expression as a function of proliferation 

We're now ready to explore this data file in really interesting ways. Wouldn't it be nice to see 
CD69 as it relates to proliferation, viewing each generation as a discrete cluster? Could we 
quantify the CD69 expression of CD69-positive cells for each generation? Yes and yes. 

• From the Insert tab on the ribbon bar, click the Density plot. This creates a Density 
plot in a default location on the data source.  Click the X Axis label and choose 
Proliferation. Click the Y Axis label and choose CD69 PE. 

Let's create another histogram to isolate the CD69 positives and negatives. 

• Right-click on the histogram that we just created and choose Clone from the context 
menu.  A duplicate copy of the histogram is created. 

• Change the Y Axis to show CD69 Expression. 
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In the graphics we can see the generations separated into discrete populations along the X-
axis. That's the first FCOM function we created. The Parent generation has the highest 
intensity.   

The Y-axis shows the continuous CD69 parameter in the histogram on the left. We can see 
that the parent generation had the greatest expression of CD69, with diminishing expression 
for each subsequent daughter generation.  In the second plot. the CD69 positives and 
negatives are distinctly separated using the CD69 Expression FCOM parameter that we 
created. This makes it very easy to get statistics on the "CD69-activated" cells for each 
generation by simply creating regions on the subsets. 

You can, of course, explore how other parameters relate to cell proliferation. Simply create 
additional histogram to display the parameter combinations you are interested in. 
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Making life easier 

You have done the real work in setting things up with this tutorial. If you save this setup as a 
WinList protocol or protocol bundle, the calculated FCOM parameters, NStat regions, and 
selected histogram can be recalled very easily from disk. 

When you analyze new data files with ModFit LT's Cell Tracking Wizard, you can export new 
partition files. Then, open the same data file into your WinList protocol and import the 
partitions into the NStat region as we have demonstrated in this tutorial. All of the calculated 
parameters will update based on the new data and partitions. 
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Creating a report template 

  

One of the best ways to save time with ModFit LT is to design one or more reports to use as 
templates. You can open a template and use it as the starting point of your analysis, with 
your customized comments, graphics, and layout. 

In this tutorial, we will design a simple report using ModFit LT's built-in text and graphics 
tools. 

  

• Launch ModFit LT. 
• Click the Open FCS button on the Home tab. Choose one of the sample files, and then 

click Open to load it. 

You will see a histogram, but no results. In order to display the results, we have to analyze 
the data. 

• Click the Auto button to automatically analyze the sample. Once finished, ModFit LT will 
show us the results in textual format. 

  

Suppose that we want to create a report that looks something like the one pictured below. 
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We have added four objects to this report and moved things around a bit. The top of the 
report contains a circle, arrow, and title text, and there is a new free-form text object in the 
lower half of the report. 

We will build a report template like this simple example. 

  

Building the example 

• Adjust the Zoom  so that you can see the whole report page on the screen. 
• Click the histogram graphic and drag it down the report page about two inches. 
• Move the legend down about two inches. 
• Click the results text and drag it down the page, as well. Align the top of the text with 

the top of the graphic. 

• From the Insert tab, click the Ellipse tool  . This will insert an ellipse object onto 
the report page. 

• Move and size the ellipse to resemble the example. 
• Double-click the new ellipse object to edit its properties.  Change the Fill Color to a color 

you like, and click OK. 
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• Click the Arrow tool on the Insert tab  . An arrow will be inserted into the 
report. 

• Drag the arrow so that its tip is next to the right hand side of the circle. Then, click and 
drag the other end of the arrow across the page to form a horizontal line. 

• Click the Text tool on the Insert tab  . The Edit Text dialog will appear.  Click 
the Properties button. 

• Click the Label Font to display the font dialog. Increase the font size to 26. You can 
change the font and color as well. Click OK when you are done adjusting the font. 

• Type "My Very Own DNA Report" (or some other title that suits you) into the text edit 
box, then click OK. The text is inserted into the report. 

• Move and resize the text so that it is positioned correctly over the arrow. 

  

OK, we have just one more item to add. 

• Click the Text tool once again. In the Edit Text dialog, type a comment that you might 
make about the data you analyze. Then click OK. 

• Move this last text to the lower portion of the report page. 

  

Great. You are done. All that is left is to save the report under some name that we will 
remember. 

• From the File menu, click the Save Report Template button. In the Save Template 
dialog, enter the name "PRACTICE".  

• Click the Save button. 

  

Using the template 

The report template has been saved. So how does one use a report template? It is really 
quite simple. 

Any time you create a new project in ModFit LT, use the Open Report Template command 
in the File menu to open your customized report template.  After opening your template, use 
the Save Project button on the Home tab to save your report template as the project's 
report template. 

If you want to use your custom template without creating a project, simply use the Open 
Report Template command in the File menu to open your customized report template. 
Once the report template is loaded, open a new data file, and analyze it. All of the results in 
the template reflect the new sample. 
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If you want to protect your reports from someone accidentally overwriting them, you can 
make them "read-only". If someone accidentally tries to save a report by the same name, 
ModFit LT will require the user to choose a new name for their report. 

Note: If you have saved reports with a previous version of ModFit LT, you should load them 
into this version of the program and save them again to upgrade them to the latest version 
format. 

  

Summary 

You can design report templates that include graphics, text, and the layout you want. 
Templates can be opened in ModFit LT and used as the starting point for the analyses you do 
with the program. They can save you time and energy, since you design them only once and 
use them over and over again. 
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Reference 
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Main Window 

  

ModFit LT offers two interfaces for the main window.  The Ribbon Bar provides easy access 
to the most common commands without having to drill down in menus.  The Toolbar and 
menu interface is a good option for users who want to keep the legacy version of the 
interface. 

The program must be restarted when changing from one to the other. 

To switch to the Toolbar and menu interface, select the Options tab on the ribbon bar and 
click the Switch to menu-toolbar button.   

 

To switch to the Ribbon Bar interface, choose Switch to ribbon bar interface in the View 
menu. 

 

  

Main window with Ribbon Bar 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 107 

 

  

  

Main window with Toolbar and Menu 
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Ribbon Bar 

  

The Ribbon Bar provides easy access to the most common commands without having to drill 
down in menus.  It is divided up into tabs that group commands based on function. 

  

File tab 

 

  

Command Description 

New Project Create a new project folder 

Open Project Open an existing project 

Save Project Save the project 

Archive Project Archive the project as a ZIP file 

Project Info Display and edit project information 

Show Project Folder 

Open the project folder in Explorer 
(Windows) or Finder (MacOS) 

    

Open FCS Open an FCS data file for analysis 

Change Data Set Select a different FCS dataset 
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New Report Template command  Create a new, empty report 

Open Report Template Open a report template from disk 

Save Report Template Save a report template 

    

Export PDF, Export Histogram Graphic, 
Export Report Graphic 

Export PDF and graphics 

    

Print Print the report 

Page Setup Set the page size and margins 

    

Recent Projects Shows a list of recently-opened projects 

Recent Files Shows a list of recently-opened data files 

Recent Reports Shows a list of recently-opened reports 

    

Exit (Quit) Closes the program 

  

  

Home tab 

 

  

Clipboard Project Analysis View Report 

Paste 

Open Project  Open FCS Analysis Open 

Copy 

New Project  Auto Analyze Scale  Save 

  Save Project  Auto with Auto Linearity Range Save As 

  Save Project As  Fit with Current Model Zoom 

  

    Auto Linearity     

    Sync Wizard     

    Cell Track Wizard     

    Choose Model     
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Insert tab 

 

  

Text Shapes Graphs 

Text Line X Zoom graph 

Keywords Arrow Y Zoom graph 

  Rectangle Fit Diagnostics graph 

  Ellipse   

  

  

Edit tab 

 

  

Setup Model Database QC 

Logging Quick Editor Edit Databases Fit Diagnostics 

Gates Full Editor Add Record S-Phase Cutoffs  

Analysis 

Fit with Current 
Model 

Database Wizard   

  Colors     

  

  

Options tab 
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Interface Settings 

Switch to menu-toolbar Report Batch Settings 

  Auto Analysis settings 

  Peak Finder settings 

  Options and Configuration 

  User Equations 

  Manage settings 

  
Select Shared Folder  
(Only ModFitAdmins in 
Compliance mode) 

  

  

Help tab 

 

  

Online Learn 

Updates Application Info 

Website User Guide 

Ask Tech Support 

About 

Make a Suggestion 

  

Report a Problem 

  

  

  

http://www.vsh.com/
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Toolbar 

  

The toolbar is displayed across the top of the application window, below the menu bar. It can 
be moved by clicking and holding the mouse down on a blank portion of the toolbar, then 
dragging to a new location. The toolbar provides quick mouse access to common ModFit LT 
functions. 

  

The buttons appearing in the Toolbar are shown below along with an explanation of the 
functions they perform. 

 

  

Click To 

 

Open an FCS data file for analysis. This is a 
split button, which also contains a command 
to open reports.. 

 

Perform an automatic analysis. 

 

Adjust the scaling of the data, and the lower 
and upper boundaries of the analysis. 

 

Select a model to be used for manual 
analysis. 

 

Adjust the range positions on the data. 

 

Analyze the data with the current model, 
scaling, and range positions. 

 

Perform auto-linearity on the current data 
with the current model. 

 

Evaluate the fit for S-Phase variability and 
compare with Consensus Conference 
recommendations. 
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Edit and lay out the report. 

 

Automatically name, then save the report. 

 

Print the report. 

 

Select a zoom factor for viewing the report 
page on the screen. 

 

Select a tissue type for the data sample. By 
selecting a type, you apply the cutoffs for 
that type. You must enter your own cutoff 
values in the S-Phase cutoffs dialog. 

 
 

This text indicates whether the program is 
running in "Compliance" or "RUO" mode.   

 

Display the ModFit LT User Guide. 
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Shortcuts 

ModFit LT provides keyboard shortcuts for many of its commands. 

  

Action Name Windows Shortcut MacOS Shortcut 

New Report Template Ctrl+N Command+N 

Open FCS Ctrl+F Command+F 

Open Report Ctrl+O Command+O 

Save Report Ctrl+S Command+S 

Print Ctrl+P Command+P 

Exit  (Quit on MacOS) Alt+F4 Command+Q 

Copy command Ctrl+C Command+C 

Paste command Ctrl+V Command+V 

Automatic Analysis Ctrl+A Command+A 

Auto Analyze and Auto 
Linearity 

Ctrl+Shift+A Command+Shift+A 

Fit with Current Model Ctrl+M Command+M 

Change Data Set Ctrl+Shift+F Command+Shift+F 

      

  

  

HID_ANL_AUTOANAL.htm
Auto_Analyze_and_Auto_Linearity.htm
Auto_Analyze_and_Auto_Linearity.htm
HID_ANL_FITDATA.htm
Change_Data_Set_.htm
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Projects 

Projects in ModFit LT 

  

ModFit LT can help organize your work into Projects, making it easy to keep files together 
and to move your work from one place to another. 

  

What is a Project? 

A Project is a folder structure containing information about your experiment: 

• The type of project.  For example, projects types can be Cell Cycle, Synchronization 
Wizard, etc. 

• A report template file, which can be customized. 
• A list of the FCS files you have added to the project 
• The actions that you want to perform when you open an FCS file 
• The output that is generated by the analysis, such as reports, PDFs, image files, and 

database results. 
• A copy of the preferences and settings that were in place when the project was saved. 
• Optionally, a project folder can also contain copies of the FCS files in your experiment. 

  

What is the Project Type? 

The project Type determines how the project will be used:  

Project Type Usage 

Cell cycle 
Cell cycle analysis using Auto-Analysis or a model created with the 
Choose Model dialog.  Supports multiple cell cycles, debris and 
aggregate subtraction 

Synchronized cell 
cycle 

Analyze samples that have been synchronized (e.g. blocked in G0-
G1 and then released).  Supports one cell cycle, debris and 
aggregate subtraction 

Cell proliferation 
tracking 

For cells stained with cell-tracking dyes such as CFSE. Computes all 
cell proliferation statistics (e.g. Proliferation Index, Replication 
Index, Precursor Frequency, etc.) 

Custom For an unrestricted analysis with a custom model 

ModFit LT will enable the tools that are appropriate for the type you select. 

  

Where are Projects stored? 
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Projects are stored in a folder named Projects within the ModFit LT folder in the user's 
Documents, by default. Each project is contained in its own folder within the Projects 
folder.  It is recommended that Projects are stored in the default Projects folder to make it 
quick and efficient to open projects.  However, users can save a Project to any writable 
location, and Projects can be opened from any readable location accessible to the user.   

The diagram below illustrates the structure a Project folder. 

 

  

Folder Contents 

Database Contains the tab-delimited database file and related files. 

FCS Files 
If the project is set up to Copy Files, the FCS files added are copied into this 
folder. 

Output Graphics, PDFs, and Reports are stored in folder under the Output folder. 

Settings 
The program settings that were in place when the project was last saved are 
contained in this folder. 

  

  

Do I have to use Projects? 

Projects are intended to make your work easier to organize and structure, but there is no 
requirement to use Projects.   

New Project 

  

This command creates a new project.  When selected, the New Project dialog is displayed. 
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Type 

The project Type determines how the project will be used:  

Project Type Usage 

Cell cycle 
Cell cycle analysis using Auto-Analysis or a model created with the 
Choose Model dialog.  Supports multiple cell cycles, debris and 
aggregate subtraction 

Synchronized cell 
cycle 

Analyze samples that have been synchronized (e.g. blocked in G0-
G1 and then released).  Supports one cell cycle, debris and 
aggregate subtraction 

Cell proliferation 
tracking 

For cells stained with cell-tracking dyes such as CFSE. Computes all 
cell proliferation statistics (e.g. Proliferation Index) 

Custom For an unrestricted analysis with a custom model 

  

ModFit LT will enable the tools that are appropriate for the type you select. 

  

Name 

Enter a name for the project.  The name will be used to create a project folder on disk, so 
the characters in the name have to be compatible with file names on your operating system. 

  

Location 

By default, projects are saved in the ModFit LT subfolder of the user's Documents folder and 
in most cases you do not need to edit the location.  However, you can select any location 
accessible to your computer using the Browse button. 

  

More 
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Click the More button to show additional properties of the new project. 

  

Project Description 

Use this field to describe your project. It can also be left blank. 

  

Project Creator 

By default, the creator is the user logged onto the computer.  This field can be edited. 

  

Copy Data Files 

When this option is enabled (checked), FCS files that are added to the project are copied into 
the project folder.  This makes it easier to move projects to different locations. 

Open Project 

  

This command displays the Select a Project dialog: 

  



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 120 

 

  

A project is a folder on disk, usually located in the ModFit LT\Projects folder under the user's 
Documents.  Find the project folder you want to open, select it in the list, then click the 
Select Folder button to open the project. 

Save Project 

  

This command will save the current state of the project, including the files added, the layout 
of the report template, and the batch processing options. 

Save Project As 

  

Use this command to save the current project with a new name.  This command displays the 
Save Project As dialog.   
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The current project's file list, batch settings, and report template are copied to the new 
project folder.  If the current project has the Copy Data Files option enabled, the FCS files 
that have been added to the project will be copied to the new project. 

Archive Project 

  

This command creates a Zip file of the current project.  The file is written to the ModFit 
LT\Projects folder in the user's Documents folder.  A message is displayed when the archive 
operation is completed. 

The Zip file compresses the project files and makes it easy to move the project to another 
location. 

Files in the original project folder are not changed by the archive operation.  They remain on 
the disk in the project folder. 

Project Info 

  

This command displays the Project Info dialog to show the properties of the project: 
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Several properties can be edited in this dialog.  In addition, the Show Folder button 
provides a convenient way to open the project's location in Explorer (Windows) or Finder 
(MacOS). 

Show Project Folder 

  

Use this command to open the project folder in Windows Explorer or MacOS Finder.   It 
provides a quick way to get to the actual folder on disk where the project files are stored. 
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Data Files 

Open FCS 

 

Use this command to open a data file. Choosing this option will display the File Open dialog 
to select a file to open. 

A data file is an FCS (Flow Cytometry Standard) format histogram or listmode data file. It can 
also open some formats of ASCII-encoded histogram files.  You can load one data file at a 
time into a report document. 

If a listmode file is selected, the Analysis Setup dialog is displayed to allow selection of the 
analysis parameter and to set up gates. 

  

Batch Processing 

When more than one file is selected in he Open FCS dialog, they are added to a batch list 
that appears on the left side of the main window.  See Batch Processing for details. 

To select a batch of files, click the mouse on the first item you want to select and drag the 
mouse over sequential files in the list. Alternately, you can click the first item, hold down the 
Shift key and click the last item to select a group of files. Hold down the Ctrl key to select 
non-adjacent files in the list. 

  

Shortcuts 

Keys: CTRL + F on PC; Command + F on Mac 

File Open dialog box 

  

This dialog is used to open data files or reports in ModFit LT. This is the standard File Open 
dialog box for the operating system, so its appearance and features are different on Windows 
and Mac versions. 
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Analysis Setup 

 

When you open an FCS listmode file, ModFit LT will present a dialog that allows you to 
choose which parameter you want to analyze and parameters to use for gating. 

 

The dialog contains a tree on the left side showing available gates and the analysis 
population. A graphical view of the selected item is shown on the right side of the dialog. 
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Analysis Population 

Choose the parameter you want to analyze by clicking the label on the X axis and selecting a 
parameter from the list. 

 

  

You can right-click the X-axis and choose Edit X Parameter to change the transformation 
used for the parameter. See Edit Properties for Parameter for additional info. 

 

  

Gates 

After you choose the Analysis parameter, you can create gates. Use the Add Gate button to 
create a new gate, and the Remove Gate button to remove an unneeded gate.  Gates are 
logical "AND" gates, which means that events must satisfy all active gates to display in the 
analysis histogram. 

Select a gate item in the tree to display the gate in the right-hand panel of the dialog. With 
the item selected, click the X- and Y-axis labels to pick the gating parameters for the plot. 
Use the region tools on the right to define a gating region on the plot. 
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Graphics for the gating plot can be edited by right-clicking the plot area and selecting Edit 
Properties. See Edit 1P Graphics and Edit 2P Graphics for additional details. 

Define each gate for your analysis. The active gates will appear on the report page and can 
be modified there once created. 

The Auto Layout Gates option can be enabled to automatically organize gates on the 
report.  Uncheck this option if you create your own arrangement for gates. 

Click OK to finish the gate and analysis population selection. 

Change Data Set 

  

This dialog is used to choose a "data set" for some FCS files. For example, Beckman Coulter 
files from FC500, Navios, and Gallios instruments commonly create 2 data sets in each FCS 
file: one in FCS2 format and the other in FCS3 format. 

If the file you select contains more than one data set, the Change Data Set dialog will be 
displayed. 
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Select the data set from the list of choices, then click OK. The program will re-read the FCS 
file, extracting the data from the selected dataset for gating and analysis. 

Recent Files list 

  

This menu is a convenient list that shows the most recent data files that have been opened in 
ModFit LT. Select a file from the list to open the file for analysis. 
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Analysis 

Auto Analysis 

 

Use this command to automatically analyze the current data file. 

The program uses the settings from the Auto Analysis Settings dialog, along with Peak Finder 
Settings, to analyze the data file. 

  

What Does Auto Analysis Do? 

When you load a data file, ModFit LT identifies peaks it finds in the sample. Automatic 
analysis looks at the peak positions, standard deviations, and other information about the 
sample and attempts to match the data to a ploidy-specific model. The model is constructed, 
ranges are positioned around the peaks, peak estimates are computed, and a non-linear least 
squares analysis is performed on the data. In addition, ModFit LT tests the S-Phase 
measurements for statistical confidence if the S-Phase assessment system is activated. 

When automatic analysis finishes, ModFit LT displays the analysis results in graphical and 
textual form on the report. 

  

See also: 

Strengths and Limitations of Automatic Analysis 

  

Shortcuts 

Keys: CTRL + A on PC; Command + A on Mac 

Auto Analyze and Auto Linearity 

 

Use this command to automatically analyze the current data file and then to perform Auto 
Linearity on the file. 

See Auto Analysis and Auto Linearity for additional details. 

  

Shortcuts 
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Keys: CTRL + Shift + A on PC; Command + Shift + A on Mac 

  

Fit with Current Model 

 

Use this command to apply a model to the analysis data with current scaling and range 
positions,. This performs a non-linear least squares analysis of the data. 

If you use Automatic Analysis, you will not need to use this command. It is done for you. 

Use this command after you have opened a data file, chosen a model, and positioned the 
model's ranges. If you change the model using the Quick Model Editor, the Full Model Editor, 
or by positioning ranges, you need to use this command to re-fit the data with the model. 

  

See also: 

Choose Model 

Ranges 

Auto Linearity 

 

This command initiates the auto-linearity process with the current model and data. Auto 
linearity adjusts the G2M and aggregate components based on iterative fitting process, and 
sets the linearity to the one that achieves the best fit. 

Choose Model 

 

Use this command to select a model to use in the manual analysis of the data. A model 
consists of a set of components, which are linked together based on the choices you make in 
this dialog. 
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Selecting a model does not actually perform an analysis. After choosing a model, you need to 

position its ranges and click the Fit button   to analyze the data with the model. 

The left portion of the dialog contains a tree diagram of the model. The top of the tree is the 
Manual Analysis branch, and the choices you need to make when selecting a model are 
described below. Also shown in the tree is a branch for each cell cycle you want to model. 
The number of cycles you see will depend on what you choose for "Number of cycles" in the 
dialog. 

After making your initial model selections with the Manual Analysis branch selected, you can 
fine-tune the model by selected each cycle branch and adjusting its properties. See the Edit 
Properties for Cycle dialog box for details on cycle properties. 

AutoDebris 

To enable debris modeling, check this option. The AutoDebris component can model debris 
from fresh, frozen, pulverized, and paraffin samples. If the sample shows little or no debris, 
you may choose to disable this option. 

AutoAggregates 

Check this option to enable a model component that automatically fits most forms of 
aggregation. Aggregates can form in the sample as cells and cell fragments stick together. 
Because all sizes and shapes of cells can form aggregates, the AutoAggregate component is 
a continuous distribution. Its shape is unique for each data file, and is based on probabilities 
of cells in each channel sticking together. To disable the AutoAggregates component, 
uncheck this option. 

Apoptosis 

Note: this is not the recommended approach to use for Apoptosis.  Secondary markers are 
much more robust and accurate.   

Check this option to model an apoptosis distribution in the sample. A Gaussian will be used to 
model a peak, and a range to identify the peak will be displayed. 
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Linearity 

Enter a linearity value for the sample. This value can be determined by dividing the G2M 
position for a cycle by the G1 position for the same cycle. The program will use the linearity 
value for computing positions for G2M populations that are not clearly defined peaks, and for 
the AutoAggregate model component. 

Standards 

Use this option to select the number of internal standards that appear as distinct peaks in the 
sample. 

Number of cycles 

Choose the number of cell cycles that appear in the sample. Each cell cycle contains model 
components for G1, S-Phase, and G2M populations. 

Model templates 

After choosing the number of cycles above, select a model template that best describes the 
cycles. The templates are named with abbreviated forms of the common cell cycle names: 
"Dip" is Diploid, "Ane" is Aneuploid, "Tet" is Tetraploid, "Hyp" is Hyper-Diploid, and "NearDip" 
is Near-Diploid. 

Notice that the model template name determines the relative positions of the cycles in the 
model. For example, with 3 cycles, there is a template for "Dip Ane Tet" and another for "Dip 
Tet Ane". The "Dip Ane Tet" template is designed for the Aneuploid appearing between the 
Diploid and the Tetraploid populations; the "Dip Tet Ane" is designed for the Aneuploid 
appearing above (to the right of) the Tetraploid population. 

The available model templates will change depending on the number of cell cycles you have 
selected to model. 

Range positions 

This option allows you to determine whether or not the program will re-position ranges upon 
choosing OK. If you have already selected a model and are making some adjustments in this 
dialog, choose "Use current range positions". If you are selecting a new model, choose 
"Compute range positions" to determine the initial locations for the ranges. 

  

OK 

Click this button to create a model matching your selections and display the ranges for the 
model. After clicking OK, position the ranges and click the Fit button on the toolbar. 

The selected model will be used until 1) another model is selected using Choose Model, 2) an 
automatic analysis is performed, 3) a new report document is loaded, or 4) you close the 
program. 

Cancel 

Click this button to close the dialog without creating a model. 
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Reset 

Click this button to restore the dialog to a default model. 

  

See Also 

Edit Properties for Cycle 

Edit Properties for Cycle 

  

These options appear when you chose a Cycle in the tree on the left side of the Edit 
Properties for Manual Analysis dialog box. The options allow you to fine-tune the properties 
for a set of components used to model one cell cycle in the model. 

 

  

Ploidy 

This option allows you to select a different ploidy label for the cell cycle. The model template 
you select in the Edit Properties for Manual analysis dialog determines the default value for 
this option. 

Range labels and results reported on the report are based on the ploidy names assigned to 
cell cycles. 

G2M 

There are three options available for the way G2M is modeled: Disabled, Visible peak, and 
Indistinct peak. When Disabled is selected, no G2M will be modeled for the cycle. Choosing 
Visible peak allows the program to adjust the mean position of the G2M component for the 
best fit, the lowest reduced chi-square (RCS). If the peak for G2M is not clearly defined, 
choose Indistinct peak. With this setting, the position of the G2M is based on the G1 position 
multiplied by the linearity factor. 

S-Phase 
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This checkbox allows you to enable or disable the S-Phase component for the cycle. 
Normally, you should disable an S-Phase if another more important cycle is significantly 
overlapping this cycle. For example, in the near-Diploid model, the Diploid S-Phase is 
disabled because the DNA Index (DI) for the Aneuploid cycle is less than 1.3 and therefore 
the S-Phases are virtually superimposed on one another. 

Scale command 

 

Use this command to manually adjust the scaling of the loaded histogram data. 

A rectangle encompassing the data is displayed. Sizing handles appear on the edges of the 
rectangle. Position the mouse over a sizing handle, click and hold the button down, and drag 
to position a new boundary. 

 

Data below the left boundary and above the right boundary will be excluded from the 
analysis. Adjusting the top of the scaling rectangle re-scales the data on the Y-axis 
graphically, but has no effect on the analysis. 

Normally when each new data file is opened, the program will automatically scale the data. 
See the section on the Options and Configuration dialog box to learn how to disable the auto-
scaling feature. 

Range command 

 

Use this command to manually adjust the ranges for the model. 

ModFit LT uses specific ranges to identify important parts of a histogram, usually peaks. 
Automatic Analysis positions ranges for you. However, if you need to correct a range position 
or if you manually select a model for analysis, you will need to position ranges yourself. 
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The rule of thumb for positioning ranges is to make sure each range identifies one, unique 
peak. Ranges should be positioned so that they do not overlap one another. When a range is 
positioned correctly, you will see the associated portion of the histogram filled in with a color 
indicating the range estimate. 

The exception to the rule for placing ranges is shown in near-Diploid histogram. In these 
histograms, you may need to place ranges so that they are not centered on the peaks. 
Instead, move the ranges slightly apart to help differentiate the two, overlapping peaks. 

Only move or resize ranges that need to be adjusted. By leaving correctly positioned ranges 
alone, you help improve user-to-user consistency. 

The vertical position of ranges has no impact on the range estimate. You can arrange ranges 
vertically so that they are easy to read and access. 

Ranges and their uses 

Debris This range provides an estimate of debris. The left side should be placed 
at the highest portion of the beginning of debris. The right side should 
extend approximately two-thirds of the histogram scale. The vertical 
position has no impact on the estimate. 

Stnd1 This range is used to identify the first internal standard, if there is one. If 
you have named the internal standard, the name of the range is changed 
to the name of the standard. Center the range over the first standard 
peak. 

Stnd2 This range is used to identify the second internal standard, if there is one. 
If you have named the internal standard, the name of the range is 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 135 

changed to the name of the standard. Center the range over the second 
standard peak. 

Apop This range identifies the apoptosis peak, if you have enabled the 
apoptosis component. The range should be centered over the peak. 

Dip G1 This range identifies Diploid G0-G1 peak. The range should be centered 
over the G1peak. 

Dip G2 This range identifies Diploid G2-M peak. The range should be centered 
over the G2 peak. 

An1 G1 This range identifies an Aneuploid G0-G1 peak. The first Aneuploid cycle 
will use An1, the second An2, and so forth. The range should be centered 
over the G1 peak. 

An1 G2 This range identifies an Aneuploid G2-M peak. The first Aneuploid cycle 
will use An1, the second An2, and so forth. The range should be centered 
over the G2 peak. 

G1 This range is used by the Sync Wizard to identify the Diploid G0-G1 peak. 
The range should be centered over the peak. 

Parent This range is used by the Cell Tracking Wizard to identify the Parent 
population. 

Gen1 This range is used by the Cell Tracking Wizard to identify a daughter 
generation population, if the Floating option is selected on the 
Generations tab of the wizard dialog. Gen1 is the generation closest to the 
parent, Gen2 is to the left of Gen1, etc. 

  

Fit Diagnostics command 

 

Use this command to add a report object that displays a summary of the Fit Diagnostics 
dialog box on the report. The object shows a legend of the elements found in the Fit 
Diagnostics dialog box. The object can be moved to any convenient location on the report. 
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To edit the properties of the object, double click on the object after it has been inserted into 
the report.  

Fit Diagnostics dialog 

  

This dialog displays information about the current analysis, comparing key aspects with DNA 
Consensus Conference recommendations and user-defined cutoffs. 

If the S-Phase Assessment system is active, the S-Phase Error Analysis for diploid, aneuploid, 
and total (average) S-Phase computations are shown in the middle portion of the dialog. In 
DNA Diploid models, the standard deviation for diploid S-Phase is computed. In DNA 
Aneuploid models, the standard deviations for aneuploid and total (average) S-Phases are 
computed. 

Probability of the S-Phase value falling into a user-defined cutoff category is shown in the 
listbox at the bottom of the dialog. 

 

  

When pressed, %CV, Cell #, Avg Cell #, % Aneuploid, %B.A.D, and RCS buttons 
display reference text explaining the generally accepted guidelines for each criterion. The 
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status boxes display green for results in the Good range, yellow for results in the Fair range, 
and red for Poor results. 

In the S-Phase Error Analysis section, you can view error distribution plots by clicking the % 
Diploid S, % Aneuploid S, or % Total S buttons. Next to the buttons, the computed S-
Phase percentage appears with its standard deviation. Values will only be computed if the S-
Phase assessment system is active. The S-Phase cutoffs dialog controls whether the system 
is active or inactive. 

  

See also: 

Histogram and S-Phase Assessment 

S-Phase cutoffs command (Edit menu) 

S-Phase Cutoffs 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

Use this command to review, edit, and create cutoff ranges for different tissue types. The 
cutoff ranges you enter are used by the Fit Diagnostics routine to assign S-Phase 
percentages into low, intermediate, or high classifications. 

Refer to the DNA Consensus Conference report (Cytometry 14, p471-500, 1993 (c) Wiley-
Liss, Inc.) for information on establishing cutoffs in your laboratory. 
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To enable the S-Phase assessment system, check the Activate Assessment System 
checkbox. 

To disable the S-Phase assessment system, clear the check from the Activate Assessment 
System checkbox. 

To add a tissue cutoff, enter a tissue type in the Tissue edit box. Then enter the thresholds 
for low-to-intermediate and intermediate-to-high for each ploidy type. Click the Add button 
to add the new type to the list of choices. 

To set a tissue type as the Current Tissue, double click the entry in the listbox. The current 
tissue is displayed at the top of the dialog and on the Toolbar in the Tissue type drop-down 
listbox. 

To edit a tissue cutoff, click the listbox entry for the tissue you want to edit. Make changes to 
the ranges in the edit boxes, and then click Replace to update the entry. 

To delete a tissue cutoff, click the listbox entry you want to delete. Then click the Delete 
button. 

To accept changes to the dialog, click OK. 

To discard changes to the dialog, click Cancel. 

  

Sync Wizard 

Sync Wizard->Create or edit model 

 

The Synchronization Wizard guides you through the process of creating or editing a model to 
analyze synchronized cell lines. You can initiate the wizard by selecting Sync Wizard-
>Create or edit model from Home tab of the ribbon bar. A dialog will appear containing 
several tabs, each presenting you with choices relative to a particular aspect of the model. 
The wizard provides full functionality for creating and editing a synchronization model while 
maintaining a simple interface. 

When starting a Sync Wizard session, you should select each tab to adjust any settings to 
your data. When you press the Analyze button, the Wizard dialog will close, the model will 
be constructed, and the data file analyzed. In addition, the Wizard toolbar will appear at the 
bottom of the main window, allowing you to open files, return to the Wizard, or exit the Sync 
Wizard. 
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If you need to adjust a setting in the model, re-enter the Sync Wizard dialog by clicking the 
Wizard button on the Wizard toolbar, or selecting Sync Wizard->Create or edit model. 
When editing a model, you only need to review the tabs containing options you want to 
change. For example, you might view the G0-G1 tab to change the model from "Adjust 
automatically" to "Lock the position", then choose Analyze to close the dialog. 

ModFit LT remains in Sync Wizard mode until you quit the Wizard, either by clicking the X on 
the Wizard toolbar, by selecting Sync Wizard->Quit. 

You can save an active Sync Wizard session in a report to preserve your settings for the 
synchronization model you create.  

  

Sync Wizard: Start tab 

  

You decide whether to create a model, or edit the one you already created on this tab. The 
option to edit is disabled if the Sync Wizard is not already running. Once a model has been 
created, you can re-enter the Wizard to edit the model's settings. 

Use the Open button to select a data file, if you haven't already selected the file you want to 
start with. 

 

  

  

Sync Wizard: G0G1 tab 
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The purpose of this tab is to allow you to identify the G0-G1 peak. A graphic of the currently 
loaded data file is displayed with a cursor used to identify the position of the G0-G1. 

The program will position the cursor automatically over the first peak in the sample. If this is 
not the correct peak for your analysis, position the G0-G1 peak cursor by clicking on the red 
triangle at the top of the graphic and dragging it over the peak. Alternately, you may type a 
channel value into the G0-G1 position edit box. 

When you close the Wizard dialog by choosing Analyze and you are creating a model from 
scratch, ModFit LT will position the G0G1 range around the channel position you indicate. 
The range is placed so that it encompasses several channels to the left and right of the peak 
position. 

When editing a model, the Sync Wizard does not adjust the range position on the data. You 
can manually adjust the range by clicking the Range button on the toolbar and moving or 
resizing the G0G1 range. 

The Sync Wizard allows you to "lock" the channel position, or to let the program adjust the 
position within the G0G1 range. When you choose Lock the position, ModFit LT will not try 
to find a better peak position. This setting is useful in case where the G0-G1 peak is indistinct 
or not present. You must also specify a standard deviation for the peak with this option. 

Choosing Adjust automatically allows the program to look for a peak within the range of 
channels encompassed by the G0G1 range, initially plus or minus 8 channels from the 
identified peak position. If the program cannot locate a peak within the G0G1 range, the 
Sync Wizard Adjustment dialog is displayed with options on how to adjust the model. 

Two options are provided for the case where no G0-G1 peak is found in a sample. Use the 
last G0-G1 position causes the program to use the last known G0-G1 location if it can't 
find a peak.  Prompt for action displays the Sync Wizard Adjustment dialog so that the 
user can be alerted to the issue and decide what to do when it happens. 
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Sync Wizard: G2M tab 

  

The purpose of this tab is to allow you to identify the G2/G1 ratio. This ratio is used to 
determine the position of the G2-M peak relative to the G0-G1 peak. A graphic of the 
currently loaded data file is displayed with a cursor used to identify the position of the G2M 
peak. 

You may adjust the G2/G1 ratio three ways: by entering a new ratio in the G2/G1 ratio edit 
box, by entering a channel position in the G2-M position edit box, or by dragging the red 
triangle cursor over the G2-M position on the graphic. 

The model created by the Sync Wizard will multiply the G0-G1 peak position and standard 
deviation by the G2/G1 ratio appearing on this tab to compute the G2-M mean position and 
standard deviation. The position of the G2-M peak is always, therefore, dependent on the 
position of the G0G1 peak. Similarly, the standard deviation of the G2-M peak is dependent 
on the standard deviation of the G0G1 peak. 
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An option is provided to perform Auto-Linearity on the sample.  When enabled, the 
program will attempt to determine the best G2/G1 ratio for each sample. 

 

  

  

Sync Wizard: S-Phase tab 

  

The purpose of this tab is to allow you to control the aspects of modeling S-Phase. 

You may adjust the shape used for S-Phase by selecting either Rectangle or Trapezoid. 

The Number of Compartments section allows you to pick how many trapezoids or 
rectangles you want to use. By choosing more compartments you allow the S-Phase portion 
of the model more freedom to conform to your data. However, giving too much freedom may 
allow the S-Phase portion of the model to take over data that truly belong to G0-G1 or G2-M. 

If you use more than one compartment in S-Phase, you can choose the spacing of 
compartments. Choosing Equal spacing distributes the compartments evenly between G0-
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G1 and G2-M populations. Choosing Exponential spacing causes compartments to increase 
exponentially in size. 

 

  

Sync Wizard: Other tab 

  

The purpose of this tab is to allow you select miscellaneous options related to the 
synchronization model you are creating. 

If you need to perform debris subtraction, enable the Debris checkbox. The Sync Wizard will 
add a debris component appropriate for fresh and frozen samples. 

If your samples contain aggregates that you want to model, enable the Aggregates 
checkbox. The Sync Wizard will add an aggregate compensation component to the model. 
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Sync Wizard: Report tab 

  

The purpose of this tab is to allow you to control what information is reported by the Sync 
Wizard model. 

For Percent report options, you may choose to report percentages for all components and 
sub-compartments, or only the primary components. 

For Mean report options, you may choose whether or not to report means. 

You can include information derived from the data file keywords and other demographic 
information by selecting "Show demographics". 

If you would like to display the %CV for the G0-G1 peak, enable the Report %CV check 
box. 

The first time the wizard is run for a project, it will automatically save a report template.  The 
template is opened automatically when the project is reopened.  If the wizard is run again 
after the initial setup, the Save project template checkbox will be displayed on the Report 
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tab of the wizard.  Check the option to update the saved report template, or uncheck it if you 
do not want to save the changes to the wizard. 

 

  

  

Sync Wizard->Open Data and Analyze 

 

Use this command to open a data file into ModFit LT and analyze the file with the model 
created by the Synchronization Wizard. The standard File Open dialog is displayed for 
selection of a file or files. After selection, the program loads and analyzes the first file. 

The batch toolbar can be used to advance through and process a set of files in the 
batch.  This toolbar appears at the bottom left of the main window.  See Batch Processing for 
additional details. 

  

Sync Wizard->Quit 
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Use this command to exit the Synchronization Wizard. The Wizard toolbar will be hidden. 

Sync Wizard Adjustment dialog 

  

This dialog is displayed when the Sync Wizard model is set to adjust the position of the G0-
G1 peak automatically but there is no peak found under the G0-G1 range. 

 

The Wizard offers several options: 

Move G0G1 to the nearest peak: This choice tells the wizard to move to the 
nearest peak. 

Use the expected position: This choice tells the wizard to use the last-known 
position of the G0G1 peak. 

Analyze the sample with no changes:  This choice tells the wizard to continue, 
even though it has not found a peak. 

Open the wizard to make changes: This choice opens the Sync Wizard so that you 
can make changes. 

  

If the sample has a visible G0-G1 peak (identified by the peak finder with a black triangle) on 
the graphic, you can choose to let the Sync Wizard move the range. It is likely that the 
position has shifted from one sample to the next, and it is safe to keep the model in "Adjust 
automatically" mode. 

If the peak suggested by the dialog is not the G0-G1 population, you should choose to lock 
the G0-G1position in its last location. In synchronization experiments, the G0-G1 population 
can disappear in the course of the treatment. Locking the position to a previously identified 
value is the best way to handle these samples. 

You can choose to analyze with no changes if you are confident that the model is still 
appropriate for the data.  Alternatively, you can open the wizard to make adjustments 
yourself. 

Cell Tracking Wizard 

Cell Tracking Wizard->Create or Edit Model 
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The Cell Tracking Wizard guides you through the process of creating or editing a model to 
analyze cell tracking dye samples. You can initiate the wizard by selecting Cell Tracking 
Wizard->Create or edit model from the Home tab of the ribbon bar. A dialog will appear 
containing tabs, each presenting you with choices relative to a particular aspect of the model. 
The wizard provides full functionality for creating and editing a Cell Tracking model while 
maintaining a simple interface. 

When starting a Cell Tracking Wizard session, you should select each tab to adjust any 
settings to your data. When you press the Analyze button, the Wizard dialog will close, the 
model will be constructed, and the data file analyzed. In addition, the Wizard toolbar will 
appear at the bottom of the main window, allowing you to open files, return to the Wizard, or 
exit the Cell Tracking Wizard. 

 

  

If you need to adjust a setting in the model, re-enter the Cell Tracking Wizard dialog by 
clicking the Wizard button on the Wizard toolbar. When editing a model, you only need to 
review the tabs containing options you want to change. 

ModFit LT remains in Cell Tracking Wizard mode until you quit the Wizard, either by clicking 
the X on the Wizard toolbar. 

You can save an active Cell Tracking Wizard session in a report to preserve your settings for 
the Cell Tracking model you create.  

Cell Tracking Wizard: Start tab 

  

You decide whether to create a model, or edit the one you already created on this tab. The 
option to edit is disabled if the Cell Tracking Wizard is not already running. Once a model has 
been created, you can re-enter the Wizard to edit the model's settings. 
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Cell Tracking Wizard: Parent tab 

  

This tab allows you to locate the peak that represents the parent population in the sample. 
The program automatically positions the cursor over the right-most peak in the histogram. If 
this is not the correct peak for your analysis, position the parent peak cursor by clicking on 
the red triangle at the top of the graphic and dragging it over the peak. 
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Alternately, you may type a channel value into the Parent channel edit box. 

This tab also allows you to "lock" the standard deviation (SD) of the Gaussian component 
used to model the parent population. The Lock SD option is most useful when analyzing 
samples in which there is a great deal of proliferation. In these cases, the parent population 
is often difficult for the model to resolve, and the modeling process may broaden the SD of 
the parent too much. When this option is enabled, the SD value can be edited. 

Cell Tracking Wizard: Generations tab 

  

This tab displays the information about how the generations will be modeled. 
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There is an editor for the number of generations to model. The number of generations 
should be based on the range between the parent population and the background of the 
measurement. For example, if the parent has a mean of 1000 and an unstained population 
has a mean of 10, the maximum number of discernible generations is five, with means at 
500, 250, 125, 62.5, 31.25, and 15.625. The variability of the populations also has an impact 
on when the last generation will no longer be discernible from background. 

A dropdown box is provided to select between the Standard and Floating option for 
modeling generations.  

In the Standard mode, the mean position of each generation is dependent on the position of 
the parent generation. Each generation is positioned at half the intensity of the previous 
generation. 

The floating option allows the mean of each generation to be computed independently of the 
other populations. This option provides much greater flexibility to the model and works well 
for samples with visually distinct generations. The floating option is not recommended for 
samples where generational boundaries are not obvious to the eye. 

The graphic displays a red line where the parent generation is positioned and dotted lines for 
each generation. 
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Cell Tracking Wizard: Other tab 

  

The purpose of this tab is to allow you select miscellaneous options related to the cell 
tracking model you are creating. 

 

The Cell Tracking Options group allows you to identify the generation that is considered 
the start of true proliferation. This value is used in computing the Precursor Frequency and 
the Upper Generation Proliferation Index (UGPI). For a description of the use of Precursor 
Frequency, see "A flow cytometric method to estimate the precursor frequencies of cells 
proliferating in response to specific antigens", Givan, A., et al, Journal Of Immunological 
Methods Vol. 230, 1999 Elsevier Science B.V. 

If you need to perform background subtraction, enable the Background checkbox. The Cell 
Tracking Wizard will add a rectangle to model background. 

When you enable Background subtraction, another option, Asymmetric cytokinesis, 
becomes available. With this option checked, the standard deviations of the generations are 
broadened by interpolation along the background rectangle. If this option is not enabled, all 
generations have the same standard deviation as the parent population. 
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With the Asymmetric cytokinesis option enabled, the program sets the name of the model to 
"Cell Tracking Wizard Cytokinesis Model". If the option is not checked, the model name is 
"Cell Tracking Wizard Basic Model". 

Two export options can be enabled for the Cell Tracking Wizard. When Export partition 
table is enabled, the program will save a text file containing the "boundaries" of the 
generations. These are the points of intersection of the adjacent generations, illustrated 
below. 

  

 

  

The export file is created each time the wizard analyzes a data file. By default, the export file 
name is ProlifWizardPartitions.txt. If you enable the Prompt for file name option, the 
wizard will display a File Save dialog before storing the partition file, allowing you to choose a 
file name and location. 

The partition file can be imported into other applications, like WinList, for further analysis. It 
is a simple, text format file that is readable by spreadsheets, databases, and word 
processors. 

The first time the wizard is run for a project, it will automatically save a report template.  The 
template is opened automatically when the project is reopened.  If the wizard is run again 
after the initial setup, the Save project template checkbox will be displayed on the Other 
tab of the wizard.  Check the option to update the saved report template, or uncheck it if you 
do not want to save the changes to the wizard. 

Cell Tracking Wizard->Open Data and Analyze 
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Use this command to open a data file into ModFit LT and analyze the file with the model 
created by the Cell Tracking Wizard. The standard File Open dialog is displayed for selection 
of a file or files. After selection, the program loads and analyzes the first file. 

The batch toolbar can be used to advance through and process a set of files in the 
batch.  This toolbar appears at the bottom left of the main window.  See Batch Processing for 
additional details. 

  

Cell Tracking Wizard->Quit 

 

Use this command to exit the Cell Tracking Wizard. The Wizard toolbar will be hidden. 

Cell Tracking Example 

  

Here is an example of a cell-tracking study that helps to explain the results that the Cell 
Tracking Wizard displays. 

Suppose that we take samples at three time points: T=0, T=3h, and T=6h. For this simple 
cell tracking example, we will start at time T=0 with four cells stained for cell tracking.  

For the population of cells at T=0, here's what we might see, and some example calculations 
for cell tracking equations.  
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We can now look at the sample at time T=3 and compute the same equations on the current 
population of cells. Note that the filled in circles above represent cells that currently exist and 
the unfilled, dashed circles are cells that have divided into two daughter cells. 

* Note, the circles containing an asterisk are those that went on to “true” proliferation. True 
proliferation is defined by g, the index of the user defined generation where true proliferation 
began. In this example, “true” proliferation begins at generation 3. Cells that remain in the 
parent or generation 2 did not truly proliferate. 

 

Here is our final time point T=6. Note that the filled in circles above represent cells that 
currently exist and the unfilled, dashed circles are cells that have divided into two daughter 
cells.  
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The number of Modeled Cells is dependent on the number of cells in the original culture and 
the amount of cell division. The number of modeled cells will increase with proliferation. This 
value is used mostly for computing other cell tracking statistics. 
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Non-parent Cells are modeled cells not in the parent generation. The number of Non-parent 
cells will be zero in the initial culture and will increase with proliferation. This value will 
always be less than Modeled Cells. This value is used mostly for computing other cell tracking 
statistics.  
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Non-parent Calculated Original Cells are the cells in the original culture that divided and gave 
rise to the modeled Non-parent Cells. The number of Non-parent Calculated Original Cells will 
be zero in the initial culture and will always be less than the Calculated Original Cells. This 
value is used mostly for computing other cell tracking statistics.  
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Calculated Original Cells are the cells in the original culture, both those that divided and 
those that did not. The number of Calculated Original Cells will be the same as Modeled Cells 
in the initial culture. This value is used mostly for computing other cell tracking statistics.  
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Percent Divided is the percent of cells in the final culture that divided at least once. The 
Percent Divided will be zero in the initial culture and will increase to at most 100%.  
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Precursor Frequency is the number of cells in the original culture that divided at least enough 
to get to the specified generation of “true” proliferation. In this example the specified 
generation is three. The Precursor Frequency will be zero in the initial culture and will 
increase with “true” proliferation to a maximum of 1.0.  

 

Proliferation Index is the number of modeled cells divided by the cells in the original culture. 
This is the average number of cells that one original cell became. The Proliferation Index will 
be one in the initial culture and will increase with proliferation to a maximum of 2^(maxGen-
1), where maxGen is the highest generation modeled. 
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Replication Index is the number of daughter cells divided by the number of cells in the 
original culture that divided. The Replication Index will be undefined (0/0) in the initial 
culture and will increase with proliferation to a maximum of 2^(maxGen-1), where maxGen is 
the highest generation modeled.  
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Proliferating Average Number of Divisions is the sum of the number of divisions that resulted 
in the cells in each generation divided by the Non-parent Calculated Original Cells. The 
Proliferating Average Number of Divisions will be undefined in the initial culture and will 
increase with proliferation to a maximum of maxGen-1 where maxGen is the highest 
generation modeled. 
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Average Number of Divisions is the sum of the number of divisions that resulted in the cells 
in each generation divided by the Calculated Original Cells. The Average Number of Divisions 
will be zero in the initial culture and will increase with proliferation to a maximum of maxGen-
1 where maxGen is the highest generation modeled. 
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Number of Divisions is the total number of divisions that resulted in the cells in each 
generation. The Number of Divisions will be zero in the initial culture and will increase with 
proliferation. 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 165 

 

Non-proliferative Fraction is the number of modeled cells divided by the cells in the original 
culture. The Non-proliferative Fraction will be one in the initial culture and will decrease with 
proliferation to a minimum of zero. 
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Upper Generation Proliferation Index is the number of modeled cells divided by the cells in 
the original culture for generations greater than g, which is 3 in this example. This is the 
average number of cells that one original cell became, excluding those in generations less 
than g. The Upper Generation Proliferation Index will be undefined in the initial culture and 
will increase with proliferation to a maximum of 2^(maxGen-1), where maxGen is the highest 
generation modeled. 
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Reports 

Reports 

The documents created by ModFit LT are called reports. Each reports contains the analysis 
information for one data sample, and can be saved to disk and re-opened by the program. 

When you start ModFit LT, a simple report is created for you automatically. It contains 
several objects which are common to all reports: a graphical element which displays the 
histogram data, a textual element which displays analysis results, and the gates that have 
been created. The histogram is not displayed until there is a data file loaded. The text objects 
remain hidden until you have analyzed the data. 

To see these elements, load a data file into ModFit LT. The histogram will be displayed. In 
addition, if you load listmode data, you can create gates on the data. The gate graphics will 
appear on the report, allowing you to manipulate the gates without reloading the sample. 

  

Report Tools 

ModFit LT reports can include additional text and graphics that you add to the report with 
report tools. These tools are found on the Insert tab of the ribbon bar.  In toolbar mode, the 
Report toolbar is displayed. 

The table below shows the report tools and their functional descriptions. Click a tool for 
additional information. 

  

Tool Description 

 

Adds free-form text objects. 

 

Adds keyword information extracted from 
the data file you analyze. 

 

Adds a solid line. 

 

Adds an arrow. 

 

Adds a filled rectangle. 
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Adds a filled ellipse. 

 

Adds a graph zoomed on the X-axis to 
magnify the Diploid G1 component. 

 

Adds a graph object zoomed on Y-axis to 
magnify S-Phase and aggregates. 

 

Adds the fit diagnostics graph to the 
report. 

  

Moving and resizing report objects 

All of the objects on the report can be moved, and most objects can be resized. This allows 
you to place objects where you want them on the report page, and adjust the size of 
graphics elements. 

To move an object, click and hold the mouse button down on the object, then move the 
object. Release the mouse to set the new position. 

To resize an object, click the object to select it. Handles will appear on the object. Click 
and hold the mouse button down on one of the handles. As you move the handle, the object 
will resize. Release the mouse to set the new size. 

  

New Report Template 

 

Use this command to create a new report template.   

Any existing objects on a report, including analysis results, are discarded, and new objects 
are created in their default locations. 

  
Shortcuts 

Keys: CTRL + N on PC; Command + N on Mac 
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Open Report Template 

 

  

Use this command to open a report template from disk.  The report template can define the 
kind of analysis, gating, and objects that appear on the report page. 

  

Save Report Template 

 

  

Use this command to save a report template. The report template can define the kind of 
analysis, gating, and objects that appear on the report page. 

Open Reports command 

 

Use this command to open one or more existing ModFit LT report documents. Choosing this 
option will display the File Open dialog to select reports to open. 

A Report document contains an analysis of data and additional report objects that you add to 
the document. 

A batch of reports may be selected at one time. When more than one report is selected, the 
Report Batch Settings dialog is displayed to allow you to set options for batch processing. 
Then, the Report batch toolbar will be displayed at the bottom of the application window. 
This toolbar will allow you to navigate through the selected reports, and provides additional 
batch processing options. 

To select a batch of reports, click the mouse on the first item you want to select and drag the 
mouse over sequential files in the list. Alternately, you can click the first item, hold down the 
Shift key and click the last item to select a group of files. Hold down the CTRL key to select 
non-adjacent files in the list. 

Shortcuts 

Keys: CTRL + O on PC; Command + O on Mac 
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Analysis command 

 

Use this command to display the report view. 

  

Save command 

 

Use this command to save the document with its current name and folder. 

When you save a document for the first time, ModFit LT displays the Save As dialog so you 
can name your document. The name for the report is based on the data file currently loaded 
into it. ModFit LT takes the name of the data file and adds ".mfl" to create the report name. 

Once a report document has been saved, this command will not display the Save As dialog; it 
will simply resave the report. 

If you want to change the name and directory of an existing document before you save it, 
choose the Save As command. 

The document contains the model, data, gates, and any additional elements that you may 
have added to the page. 

  

Shortcuts 

Keys: CTRL + S on PC; Command + S on Mac 

Save Report As 

 

Use this command to save and name the ModFit LT report document. ModFit LT displays the 
Save As dialog so you can name your document. 

To save a document with its existing name and folder, use the Save command. 

File Save As dialog box 

  

This dialog is used to save reports in ModFit LT. This is the standard File Save dialog box for 
the operating system, so its appearance and features are different on Windows and Mac 
versions. 
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Print command 

 

Use this command to print a ModFit LT report to the selected printer. The Print dialog box is 
displayed allowing you to select printing options. 

  

Shortcuts 

Keys: CTRL + P on PC; Command + P on Mac 

Page Setup command 

  

Use this command to set up characteristics of printed pages, including paper size and 
margins. 
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Zoom command 

 

Use this command to change the magnification of the report document as viewed on the 
screen. Increase the zoom to magnify the image, or decrease it to reduce the image size. 

This has no effect on printed output. 

  

Recent Reports list 

  

This menu is a convenient list that shows the most recent report files that have been opened 
in ModFit LT. Select a file from the list to open the report. 

Edit 1P Graphics 

  

This dialog is used to change the graphic properties for 1P histograms. 
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Smooth 

This value determines the amount of smoothing for the histogram. Set to 0 for no smoothing. 

Axis Line Color 

Choose the color of the axis line. 

Axis Line Weight 

Choose the weight of the axis line. 

Background 

Choose the color of the background page. 

Background Transparency 

Sets the transparency of the background. 

Y Zoom Factor 

Select a zoom factor for the Y direction. 

Show Peak Locations 

Enable this option to see where ModFit found peaks in the file. The peaks are shown as 
triangles on the axis. 

Data Line Color 

Choose the color of the data line. 

Data Line Weight 
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Choose the weight of the data line. 

 
X-axis and Y-axis properties 

Edit X (or Y) Parameter 

Displays a dialog to Edit Properties for Parameter, to edit transformations, the name, etc. 

Color 

Choose a color of the axis label. 

Font 

Select the font of the axis label. 

Number Color 

Choose the color of the axis tic numbers. 

Number Font 

Select the font of the axis tic numbers. 

Auto Minimum 

Enable this option to automatically set the minimum of the axis. 

Minimum Value 

When Auto Minimum is not enabled, this value sets the minimum value displayed by the axis. 

Auto Maximum 

Enable this option to automatically set the maximum of the axis. 

Maximum Value 

When Auto Maximum is not enabled, this value sets the maximum value displayed by the 
axis. 

Auto Calculate Major Tics 

Enable this option to automatically determine the major tic unit for the axis 

Number of Major Tics 

When Auto Calculate is not enabled, this value sets the major tic unit of the axis. 

Auto Calculate Minor Tics 

Enable this option to automatically determine the minor tic unit for the axis. 

Number of Minor Tics 
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When Auto Calculate is not enabled, this value sets the number of minor tics per major tic on 
the axis. 

 

Actions 

OK 

Click this button to accept the changes and close the dialog box. 

Cancel 

Click this button to discard any changes and close the dialog box. 

  

Edit 2P Graphics 

  

This dialog is used to change the graphic properties for 2P plots. 

 

  

Smooth 

This value determines the amount of smoothing for the histogram. Set to 0 for no smoothing. 

Axis Line Color 
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Choose the color of the axis line. 

Axis Line Weight 

Choose the weight of the axis line. 

Background  

Choose the color of the background page. 

Background Transparency 

Sets the transparency of the background. 

Enhance Pops 

Enable this option if there are small populations you need to visualize in the graph. 

Color Mode 

Choose between Rainbow and Gradient color density graphics. 

Start Color 

For Gradient color mode, this is the color of low frequency events on the axis. 

End Color 

For Gradient color mode, this is the color for the highest frequency events.. 

Show All Dots 

When enabled, all events in the plot are displayed. If unchecked, the number of dots is 
controlled by the Number of Dots edit field. 

Number of Dots 

When Show All Dots is unchecked, this field determines the number of dots to display on the 
plot. Fewer dots may appear if there are fewer events in the plot. 

Dot Size 

Enter a size for dots. A value of 0 draws a dot 1 pixel in size. 

 
X-axis and Y-axis properties 

Edit X (or Y) Parameter 

Displays a dialog to Edit Properties for Parameter, to edit transformations, the name, etc. 

Color 

Choose a color of the axis label. 

Font 
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Select the font of the axis label. 

Number Color 

Choose the color of the axis tic numbers. 

Number Font 

Select the font of the axis tic numbers. 

Auto Minimum 

Enable this option to automatically set the minimum of the axis. 

Minimum Value 

When Auto Minimum is not enabled, this value sets the minimum value displayed by the axis. 

Auto Maximum 

Enable this option to automatically set the maximum of the axis. 

Maximum Value 

When Auto Maximum is not enabled, this value sets the maximum value displayed by the 
axis. 

Auto Calculate Major Tics 

Enable this option to automatically determine the major tic unit for the axis 

Number of Major Tics 

When Auto Calculate is not enabled, this value sets the major tic unit of the axis. 

Auto Calculate Minor Tics 

Enable this option to automatically determine the minor tic unit for the axis. 

Number of Minor Tics 

When Auto Calculate is not enabled, this value sets the number of minor tics per major tic on 
the axis. 

 

Actions 

OK 

Click this button to accept the changes and close the dialog box. 

Cancel 

Click this button to discard any changes and close the dialog box. 
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Report tools 

Text tool 

 

Use this command to add editable text to the report document. 

A dialog will appear allowing you to enter text. After typing the text, click OK on the dialog. 
The text will appear on the document. It can be dragged anywhere on the page. Its 
bounding rectangle can also be resized. 

To edit the text, double click anywhere on the text block. 

To drag text, click the text and hold down the mouse button. With the button depressed, 
move the mouse. Release the button to set the new position. 

To add text to the Flash Comment list, choose the Save button in the Edit Text dialog. The 
standard File Save dialog is displayed. Type in a name for the comment file and click OK. 
Once the comment has been stored on disk, you will be prompted to type a description for 
the comment. Enter the description and click OK. The Edit Text dialog will now display the 
description in the Flash Comment list. 

To add a stored comment to the report, choose the Text report tool. The Edit Text dialog 
appears. From the Flash Comment list, click the comment you want to add. The text of the 
comment will appear in the Edit Text dialog. Click OK to add the comment. 

Keywords tool 

 

Use this command to add keywords from your data file and analysis results to the report 
document. Some keywords are stored in the file at the time it is created by the acquisition 
software. ModFit LT allows you to access these keywords and place them in the report. In 
addition, you can access the analysis results as keywords to place on the report. A list of the 
keywords appears in the Keywords section. 
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To move the object after it is inserted, click on it and hold down the mouse button. With the 
button depressed, move the mouse. Release the button to set the new position. 

Click the Properties button to set the font, alignment, and coloring for the object. 

 

Line tool 

 

Use this command to add lines to the report document. Lines can be dragged into position 
anywhere on the report. 

To drag a line, click on the object and hold down the mouse button. With the button 
depressed, move the mouse. Release the button to set the new position. 

To change the size or angle of a line, click on the line to make it the active object. Handles 
will appear on each end of the line. Click and hold one of the handles to reposition. The line 
will reorient as you move the handle.  
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To change the properties of a line, double click on the line.  

 

  

Arrow tool 

 

Use this command to add lines with arrowheads to the report document. Arrows can be 
dragged into position anywhere on the report. 

To drag an arrow, click on the object and hold down the mouse button. With the button 
depressed, move the mouse. Release the button to set the new position. 

To change the size or angle of an arrow, click on the line to make it the active object. 
Handles will appear on each end of the arrow. Click and hold one of the handles to 
reposition. The arrow will reorient as you move the handle.  

To change the properties of an arrow, double click on the arrow.  

  

Rectangle tool 

 

Use this command to add rectangles to the report document. Rectangles can be dragged into 
position anywhere on the report, and have selectable colors. 

To drag a rectangle, click on the object and hold down the mouse button. With the button 
depressed, move the mouse. Release the button to set the new position. 

To change the size of a rectangle, first click on it to make it the active object. Click and hold 
one of the handles to reposition that corner of the rectangle. Each of the handles can be 
moved in the same manner. 

To change the properties of a rectangle, double click on the rectangle. 
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Ellipse tool 

 

Use this command to add ellipses and circles to the report document. Ellipses can be dragged 
into position anywhere on the report. 

To drag an ellipse, click on the object and hold down the mouse button. With the button 
depressed, move the mouse. Release the button to set the new position. 

To change the size of an ellipse, first click on it to make it the active object. Click and hold 
one of the handles to redefine the size and shape of the ellipse. Each of the handles can be 
moved in the same manner. 

To change the properties of an ellipse, double click on the ellipse. 

X Zoom Graph 

 

Use this command to add a graph object to the report that shows a zoomed view of the 
histogram. The inserted graph can be moved and resized on the report. 

The X Zoom graph object is especially useful for visually identifying near Diploid populations. 
It is designed to crop the X-axis so that only the Diploid G1 peak is on scale. 

To edit the object zoom settings, double click on the object after it has been inserted into the 
report. Then, adjust the X-Axis minimum and maximum values to include the portion of the 
histogram you want to view. 

You can set the default values for this object using the Options and Configuration dialog box. 

Y Zoom Graph 
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Use this command to add a graph object to the report that shows a zoomed view of the 
histogram. The inserted graph can be moved and resized on the report. 

The Y Zoom graph object is designed to enhance low-level histogram data. It provides a 
detailed view of S-Phase and small G2M and aggregate forms. Use the graph to verify the fit 
of the model and ensure the correct model is selected. 

To edit the object zoom settings, double click on the object after it has been inserted into the 
report. Select a new Y Zoom factor to increase or decrease the magnification of the 
histogram. 

You can set the default values for this object using the Options and Configuration dialog box. 

Fit Diagnostics command 

 

Use this command to add a report object that displays a summary of the Fit Diagnostics 
dialog box on the report. The object shows a legend of the elements found in the Fit 
Diagnostics dialog box. The object can be moved to any convenient location on the report. 

  

 

  

To edit the properties of the object, double click on the object after it has been inserted into 
the report.  
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Batch Processing 

Batch Processing 

  

ModFit LT provides powerful batch processing of data files and reports. Batch processing of 
data files supports automatic analysis, saving and printing of reports, and databasing of 
results, in addition to other features. When processing batches of reports, you can re-analyze 
data, perform AutoLinearity adjustments, re-save and print reports, and store results in 
databases. 

  

Batch Processing FCS Files 

On the left side of the main window, ModFit LT displays a list of FCS files in the batch.  Tools 
are provided to add, remove, read, and move files in the list, as well as to set the file that is 
currently active.   The actions that will be performed on the files can be selected in the lower 
portion, and controls to move through the batch appear at the bottom. 

  

 

  

  

Batch Processing Reports 
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The Options tab contains entries for Report Batch Settings. To process of batch of reports, 
use the Open Report button on the Home tab to select the set of reports you want to 
process.  Upon opening the set of reports, the Report Batch Settings will be displayed, and 
the Report Batch Toolbar is used to process the report files. 

  

  

Batch Context Menu 

  

The batch context menu is displayed when you right-click in the file list. 

When the mouse is right-clicked on an item in the batch, the following menu is displayed: 

 

When the right-click is on white space in the batch list, a different menu is shown: 

 

  

Start Here 

Select this command to set the current item in the list.  The item will be processed by the 
next batch processing command. 

Read Data 

Select this command to set the current item in the list and read the FCS data, without 
performing additional batch processing. 
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Open File Location 

Select this command to open the folder on disk where the file is located. 

Save Output 

This command is enabled for the current batch item if it has been analyzed.  Selecting the 
command causes the batch processing options to be performed on the file, such as saving 
and printing a report. 

Reset Status/Reset All 

This command resets (clears) the status flag for the selected file in the list, or if no file is 
selected, for all files in the list. 

Remove/Remove All 

When this command is selected for one file, ModFit LT will prompt for confirmation that you 
want to remove the file from the batch.  If confirmed, the file will be removed from the bath 
list.  If the file is contained in a project, it will also be removed from the project folder. 

When the command is selected not for a specific file, it can remove all files from the batch 
list.  ModFit LT will prompt for confirmation that you want to remove the file from the batch. 

File Batch Settings 

  

These properties determine what actions the program will perform when processing FCS files 
in the batch list.  They appear at the bottom of the batch list panel on the left side of the 
main window. 
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Analysis 

Type 

The Type identifies the kind of analysis you want to perform:  

Type Usage 

Cell cycle 
Cell cycle analysis using Auto-Analysis or a model created with the 
Choose Model dialog.  Supports multiple cell cycles, debris and 
aggregate subtraction 

Synchronized cell 
cycle 

Analyze samples that have been synchronized (e.g. blocked in G0-
G1 and then released).  Supports one cell cycle, debris and 
aggregate subtraction 

Cell proliferation 
tracking 

For cells stained with cell-tracking dyes such as CFSE. Computes all 
cell proliferation statistics (e.g. Proliferation Index) 

Custom For an unrestricted analysis with a custom model 

  

Open Report Template 

Enable this option to open the project's report template before each file in the batch is 
analyzed. This ensures that each file is analyzed with the same starting conditions. 

When using a project, ModFit LT will open the project's report template when the project is 
opened. For most types of analysis, the report template does not need to be re-opened for 
each file analyzed and this option can be left unchecked. This would be true for most Cell 
Cycle, Synchronization, and Cell Tracking projects. 

If you have a custom model for your project, you may want to enable this option. 

Analysis 

Choose what analysis option you want to occur when a new data file is opened. The options 
available are listed below: 

No analysis: No analysis is performed. 

Fit with current model: The Fit command is performed with the current model. 

Auto Analyze: Automatic analysis is performed. 

Auto Linearity 

Enable this option to perform automatic linearity adjustment for each file.   

  

Output 

Save Report 
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Enable this option to save a report for each data file. The report is automatically named 
based on the name of the FCS file analyzed. Saving occurs after any analysis has been 
performed when moving to another batch item.  Reports are saved in the Reports folder in 
the Output Path. 

Save PDF 

Enable this option to generate a PDF version of the report. PDFs are saved in the PDFs folder 
in the Output Path. 

Save Report Graphic 

This option saves a report graphic for each file analyzed. Graphics are automatically named 
based on the data file that is loaded, as described in Export Report Graphic. Graphics are 
saved in the Graphics folder in the Output Path. 

Save Histogram Graphic 

This option saves a histogram graphic for each file analyzed. Graphics are automatically 
named based on the data file that is loaded, as described in Export Histogram Graphic. 
Graphics are saved in the Graphics folder in the Output Path.  

Save To 

Output can be saved to the Project Output Folder or to a Specified Output Path.  When 
Specified Output Path is selected, the Output Path field is used to select the output location. 

Output Path 

If the Save To option is set to Specified Output Path, reports will be saved to the path 
selected here. Click the Folder button to select a new location for output. 

  

Printing 

Print Report 

Enable this option to automatically print a report to the current printer. Printing occurs when 
moving to another batch item. 

  

File Batch Toolbar 

  

This toolbar is displayed at the bottom of the ModFit LT application window when you select 
more than one file in the Open FCS dialog. 

 

  



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 189 

Most of the buttons on the toolbar are used to navigate through the batch. The left-most 
button is used to edit the properties of the batch processor. See File Batch Settings for more 
on file batch properties. 

As you navigate through the batch, the actions in the File Batch Settings are performed on 
each file analyzed. This allows you to perform a series of operations just by moving to 
another batch item, such as automatic analysis, saving and printing reports. The function of 
each button is described below. 

  

 

Show or hide the batch panel 

 

Select from a list of batch items. 

 

Go to the first file in the batch. 

 

Go to the previous file in the batch. 

 

Redo the current file in the batch. 

 

Go to the next file in the batch. 

 

Go to the last file in the batch. 

 

Auto-advance through the batch. 

 

Stop the auto-advance process. 

Choose Batch 

This menu is displayed when the Choose button on the File Batch or Report Batch toolbar is 
clicked. It allows you to choose a batch item to open. 
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The menu lists all items in the batch. To select an item, click on it in the list. The item will be 
opened. 

  

Report Batch Settings 

 

This option displays the Edit Properties for Report processor dialog box, allowing you to 
choose what happens during batch processing of reports. The dialog is displayed 
automatically when you select more than one report for analysis. 

 

Batch processing options apply when you select more than one report in the Open Reports 
dialog box. When more than one report is selected, the Report Batch toolbar is displayed at 
the bottom of the application window. You can navigate through the batch one report at a 
time, or auto-advance through the batch of reports. 

Analysis 

Choose what analysis option you want to occur when a new data file is opened. The options 
available are listed below: 

No analysis: No analysis is performed. 

Auto-analyze: Automatic Analysis is run the data in the report. 

Auto-analyze and Auto Linearity: Automatic Analysis and Auto Linearity are performed 
on the report data. 

Fit with current model: The Execute Model command is executed on each data file. 

Fit and AutoLinearity: An AutoLinearity adjustment is performed for each report, and 
the model is finally fit with the best linearity setting. See Using AutoLinearity for more 
on this option. 

Add Zoom Objects 
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Enable this option to automatically add an X-Zoom and Y-Zoom graph to each report that is 
processed. These objects allow close examination of the low level events such as debris, 
aggregates, and S-Phase, and provide a magnified view of the area around the Diploid G1 
peak. 

Save Report 

This drop-down provides three report saving options described below. Saving occurs after 
any analysis has been performed, and again when moving to another batch item. 

Don't re-save report: The report is not resaved. 

Re-save report: The report is resaved, using the save report name. 

Auto-name and save report: The report is resaved using the Auto Save Report 
command. The name of the report may change from the original name with this 
option. 

Print Report 

Enable this option to automatically print the report to the current printer. Printing occurs 
when moving to another batch item. 

Save PDF 

Enable this option to automatically generate a PDF version of the report. The PDF is created 
in the same location as the Save Report Path. 

Save Graphics 

This option allows you to save graphics for the histogram or report. Graphics are 
automatically named based on the data file that is loaded, as described in Export Histogram 
Graphic and Export Report Graphic. The save operation occurs when moving to another 
batch item. The options available are listed below: 

No: No graphics are saved to disk. 

Histogram: Histogram graphics are saved. 

Report: Report graphics are saved. 

Histogram and Report: Both Histogram and Report graphics are saved. 

Database prompt 

Enable this option if you want to be prompted to store the analysis in any active databases. 
If you clear this checkbox and databases are active, records will be stored without prompting. 
If databases are inactive, this option is ignored. 

Report Batch Toolbar 

  

This toolbar is displayed at the lower right of the ModFit LT application window when you 
select more than one file in the Open Reports dialog. 
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Most of the buttons on the toolbar are used to navigate through the batch. The left-most 
button is used to edit the properties of the batch processor. See Report Batch Settings for 
more on report batch properties. 

As you navigate through the batch, the actions and options in the Report Batch Settings 
dialog are performed on each file that is opened. This allows you to perform a series of 
automatic operations just by moving to another batch item, such as rerunning the analysis 
and printing reports. The function of each button is described below. 

  

 

Edit the properties of the batch. 

 

Display the Choose Batch dialog to select a batch item to 
open. 

 

Go to the first file in the batch. 

 

Go to the previous file in the batch. 

 

Redo the current file in the batch. 

 

Go to the next file in the batch. 

 

Go to the last file in the batch. 

 

Auto-advance through the batch. 

 

Stop the auto-advance process. 

 

Exit out of batch processing reports 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 193 

Clipboard 

Copy command 

 

Use this command to copy the report or a single object to the clipboard.  

Copying to the clipboard replaces the contents previously stored there. 

To copy a single object, click the object to select it, and then choose the Copy command. The 
object will be placed in the clipboard. 

To copy the entire report, make sure no object is selected in the report, and then choose the 
Copy command. The report will be copied as a graphic image to the clipboard. 

  

Shortcuts 

Keys: Ctrl + C on PC; Command + C on Mac 

Paste command 

 

Use this command to insert a copy of the clipboard contents onto the report. This command 
is unavailable if the clipboard is empty or if ModFit LT does not support the format of the 
data. 

When the clipboard contains more than one format at a time, ModFit LT prompts you to 
select the format you want. Select the format you want from the list and click OK to paste 
the object. 

After it is pasted, the object may be selected and dragged to a new location on the screen. 

Supported formats include the following: 

PC version: Text, Bitmap, PNG 

Mac version: Text, Bitmap, PNG 

  

Shortcuts 

Keys: Ctrl + V on PC; Command + V on Mac 
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Databases 

Databases 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

Use this dialog to add, delete or edit one or more databases. See Databasing with ModFit LT 
for more on databases. 

The Edit All Databases dialog can be displayed by choosing Edit Databases from the Edit 
tab. 

 

  

Overview 

ModFit LT can have one or more databases defined at any time. The database format is 
ASCII-formatted, tab-delimited database. Any FCS keyword or analysis result can be mapped 
to a database field. A complete description of the functionality of the database system can be 
found in the Databasing with ModFit LT discussion. 

Edit 
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If a database is selected, this option shows the Edit Keyword Map dialog box. You can also 
double-click the database item to activate this option. 

Properties for the selected item 

This button appears in the group of buttons below the listbox. It allows you to edit properties 
for the selected item in the list. 

If a database is selected, the Edit Properties for Database dialog will be displayed. 

New 

This command creates a new, empty database. 

Delete 

This option will delete the selected database from the list. 

OK 

Put away the Edit All Databases dialog box. 

Help 

Show this help topic. 

Edit Properties for Database 

  

Purpose: To activate, display, and set other attributes of a database. See Databasing with 
ModFit LT for more on databases. 

The Edit Properties for Database dialog can be displayed by choosing Edit Databases from 
the Edit tab, selecting the database you want, then clicking the Properties button. If the 
Database Viewer is displayed, clicking a button on the viewer's toolbar can also access this 
dialog. 

When a project is created in ModFit LT, a database is automatically created for the new 
project in the Database folder of the project. The properties for a project database are shown 
here: 
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If you create a database using the New button in the Databases dialog, the database is 
considered to be a global database and is available for use by any project or non-project 
analysis.  Additional properties are shown for global databases: 

 

Overview 

Each database can be activated independently. Additionally, the database can be set for 
prompting or automatic mode, and a viewer window can be displayed. This dialog also allows 
you to set the path and other properties for the database. 

Active 
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Check this option to activate the database. When the database is active, it will attempt to 
store a record each time an analysis is performed. Uncheck this option to disable a database; 
records will not be saved in databases that are not active. 

Prompting 

Check this option if you want ModFit LT to prompt you each time it is ready to save a record. 
The prompt will allow you to confirm or cancel the saving of the record into each active 
database. Uncheck this option for automatic operation where ModFit LT stores the 
information without prompting. 

Viewer 

Check this option to display a Database Viewer for the database. The viewer displays the 
fields in columns and each row represents a record in the database. Additional options are 
available on the viewer window. 

Viewer Font 

Select a font to use for the database viewer. 

Choose database (for global databases only) 

This option allows you to choose an existing database on disk. Click the "Link to" button. A 
file selection dialog box will appear, allowing you to navigate to the existing database and 
select it. Linking to an existing database will rename the database in memory to match the 
one selected on disk, and the associated database map on disk will be loaded as well. 

Change location (for global databases only) 

This option allows you to change the path for the defined database. Click the "Path" button 
to display a Choose database location dialog. Navigate to the location in which you want to 
store the database. 

If a database of the same name already exists in that folder, you will be offered three 
choices. First, you can choose to overwrite the database with the one you have defined. 
Secondly, you can choose to use the database that exists in the new location, replacing the 
structure you have defined in memory. This is convenient if you have a database already 
defined that you want to use. Or you can choose to cancel the action. 

OK 

Save property settings and put away the Edit Properties for Database dialog box. 

Cancel 

Close the dialog and discard any changes you have made. 

Help 

Show this help topic. 
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Edit Keyword Map 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

Purpose: Select the information you want to save in a database. See Databasing with ModFit 
LT for more on databases. 

The Edit Keyword Map dialog can be displayed by choosing Edit Databases from the Edit 
tab, selecting the database you want to edit, then clicking the Edit button. If the Database 
Viewer is displayed, clicking a button on the viewer's toolbar can also access this dialog. 

 

  

Overview 

Each database in ModFit LT has its own structure, made up of a set of keywords to database 
and a matching set of fields in a database. The Edit Keyword Map dialog determines how the 
keywords are "mapped" to fields in the database. 

Results Tree 

This tree expands to display all of the available groups of keywords and the keywords in each 
group. A branch of the tree can be expanded by double clicking the mouse on it. Select a 
branch of the tree by clicking once on it. 

This tree is used to select the keywords you want to store in the database. It allows multiple 
selection. See the discussion in Databasing with ModFit LT for more on proper selection of 
information to database. 

Map Definition 
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This list displays the field names and the keywords they relate to. The first column showing 
the field name can be edited; other columns are for display only. To edit a field name, click 
once on the field to select it, then click again after a moment to enter edit mode. 

Add 

Click this button to add the keywords selected in the Results Tree to the database definition 
shown in the Map Definition list. Fields are named automatically to show the source of the 
information. You can also double-click on a keyword to add it to the definition. 

Replace 

The option is available when you select an item in the tree and an item in the Map Definition 
list. It allows you to map a new keyword to an existing field in the database. 

Delete 

Click this button to delete the fields selected in the Map Definition list from the database. 

Up/Down 

These buttons allow you to change the order of fields in the Map Definition list. Select one or 
more fields in the list, and then use the Up and Down buttons to move the item(s). 

OK 

Save changes to the database. If records already exist in the database, the structure of the 
records will be revised to match the new structure you have defined. 

Cancel 

Close the dialog and discard any changes you have made. 

Help 

Show this help topic. 

Database Viewer 

Purpose: Display the contents of a database. 

The Database Viewer can be displayed by choosing to show the viewer in the database 
properties. To do so, choose Edit Databases from the Edit tab, select the database you 
want, and then click the Properties button. In the Edit Properties for Database dialog, 
enable the viewer and click OK. 
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Overview 

This window can be displayed for any database you have created. The viewer displays the 
fields defined in the database as column headings. Each record in the database is shown as a 
row of information. The window can be scrolled horizontally and vertically if there is 
information out of view. Each column can be resized by dragging the partition between the 
column headings with the mouse. 

  

 

At the top, a toolbar provides buttons to manually add, delete, and replace records. 

Click the copy button to copy the database as text to the clipboard. 

Click the "+" (add) button to add the current analysis information to the database. 

Click the "-" (delete) button to delete the selected records from the database; if the button is 
grayed, there are no records selected. 

Click the replace button to store the current analysis into an existing record in the database. 

Additional buttons activate and deactivate the database, display the Edit Keyword Map 
dialog, display the Edit Properties for Database dialog, and backup the database. 

  

See Databasing with ModFit LT for more on databases. 
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Add Record 

 

This button appears on the Edit tab of the ribbon bar.  It can be used to manually trigger the 
addition of a record to active databases. 

  

See also: 

Databases 

Database Wizard 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

The Database Wizard is a tool that makes it easy to set up a database for the ModFit analysis 
results.   

To use the wizard, start by opening a data file and analyzing it so that you have a set of 
analysis results on the report.  Then, start the database wizard by clicking this button, found 
on the Edit tab of the ribbon bar. 

The wizard's greeting page will display. 

 

  

Click Next to proceed.  The Database page of the wizard will display. 
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Select an existing database from the list or use the New button to create a new one.  Once 
you have made your selection, click the Finish button to complete the wizard. 

The wizard will add fields to the selected database for all of the analysis results that are 
shown on the report.  If a field is already in the database, it will not be added again. 
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Exporting 

Export PDF 

Use this command to export the report to PDF format on disk. 

When you select this option, the File Save dialog is displayed. Navigate to the location where 
you want to store the file, and then enter a name for the file. Click the Save button to store 
the file on disk. 

Exporting is also available in batch processing. See File Batch Settings and Report Batch 
Settings for more. 

Export Histogram Graphic 

Use this command to export the graphics for the histogram to a file on disk. The default 
format of the graphic can be selected using the Options and Configuration dialog. Supported 
formats currently include JPeg (jpg), Tiff (tif), Portable Network Graphics (png), and Scalable 
Vector Graphics (svg). 

When you select this option, the File Save dialog is displayed. Navigate to the location where 
you want to store the graphic file, and then enter a name for the file. Click the Save button 
to store the file on disk. 

Exporting is also available in batch processing. See File Batch Settings and Report Batch 
Settings for more. 

See also: Options and Configuration 

Export Report Graphic 

Use this command to export the graphics for the entire report to a file on disk. The format of 
the graphic can be selected using the Options and Configuration dialog. Supported formats 
currently include JPeg (jpg), Tiff (tif), Portable Network Graphics (png), and Scalable Vector 
Graphics (svg). 

When you select this option, the File Save dialog is displayed. Navigate to the location where 
you want to store the graphic file, and then enter a name for the file. Click the Save button 
to store the file on disk. 

Exporting is also available in batch processing. See File Batch Settings and Report Batch 
Settings for more. 

See also: Options and Configuration 

  

Export Fit Data 

This command appears in the Export sub-menu of the File menu.  After analyzing an FCS file, 
the command can be used to export the model components and raw data to a comma-
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separated value (CSV) file.  The CSV file can be read by spreadsheet apps, such as Microsoft 
Excel, which can create additional charts and perform additional calculations on the data. 

The output will depend on the model that was used to analyze the data.  The first column in 
the output will be the raw data values for each channel in the 1P histogram.  The second 
column is the "total" of all model components, or the overall fit.  The next columns will 
represent each active component in the model. Finally, a column for "residuals" is included. 

Here is an example.  Suppose ModFit LT has performed the analysis shown below for a DNA 
Aneuploid sample. 

 

  

The Export Fit Data command would generate the following output: 
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A chart can be easily created in Microsoft Excel based on the exported data: 
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Logging 

Edit Log 

 

Research and Compliance Mode note: 
In RUO mode, users can turn logging on and off, and set properties. 
In Compliance mode, logging is always enabled. 

  

ModFit LT allows you to create a log of operations that you perform. This is useful if you 
have any difficulties with the program and need to interact with the Technical Support 
team.  Logging is always enabled when the program is running in Compliance mode. 

To view the current log, click the Logging button on the Edit tab of the ribbon bar. 

 

To adjust properties of the log, click the Properties button. See Edit Properties for Log for 
details on the log settings. 

Edit Properties for Log 

  

Research and Compliance Mode note: 
In RUO mode, users can turn logging on and off, and set properties. 
In Compliance mode, logging is always enabled. 
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This dialog allows you to activate and adjust the program's logging features, useful in 
isolating problems that you may have in working with the program. 

 

  

Active 

To enable logging of program operations, check this option. This file is a plain text file, with 
fields separated by tabs. It can be opened in most text editors, or attached to email 
messages. 

To disable logging, clear the check from this checkbox. 

Log File 

This read-only field shows the name of the log file on disk. 

Logging Level 

This field selects the level of detail stored in the log. Choose from "Basic" and 
"Comprehensive". Comprehensive logging is typically only used when working with a support 
technician at Verity Software House to determine the cause of a problem. 

Maximum Log Size 

Select the maximum size for the log file. If this is set for Unlimited, the log will grow without 
limitation (not recommended). 

Full Error Report 

Generally, this option should not be enabled.  However, Technical Support make ask you to 
enable this option to determine the cause of a problem. 
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Preferences 

Auto Analysis Settings 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

This dialog is used to configure several properties of the Auto Analysis command.  

 

  

AutoDebris 

When this option is checked, the program will enable the AutoDebris component to model 
debris in the data file during Auto Analysis. Debris is often created in the sample preparation 
process. If the option is not checked, the AutoDebris component will be disabled. 

AutoAggregates 

When this option is checked, the program will enable the AutoAggregate component to 
model aggregation in the data file during Auto Analysis. Aggregation in the sample can 
produce a continuum of particles that are stuck together, significantly affecting S-Phase 
estimates. If the option is not checked, the AutoAggregate component will be disabled. 
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Apoptosis 

NOTE: We strongly recommend that this option should be disabled in your configuration.  To 
get more robust and accurate results, use additional markers for apoptosis detection.   

If this option is checked, the first peak detected after any internal standards will be 
considered an apoptotic population and modeled with a Gaussian. 

  

Linearity Settings 

Linearity 

This value is used in the computation of some G2M positions, and in the AutoAggregate 
model component. The default value is 2.0, as G2M peaks are expected to appear at two 
times the associated G1 peak. Adjust this value to match the known linearity setting for your 
instrument. 

When Auto Analysis does not detect a distinct G2M peak for a cycle, it assumes the location 
of the G2M peak to be at the G1 position times this linearity setting. This is called a 
dependent G2M, because its position depends on the G1. 

The linearity value is used by the AutoAggregate model component to determine the 
expected locations of peaks created by aggregation. 

  

Standards and References 

Internal Standards 

Select the number of internal standards that your data files contain. 

Most DNA internal standards are designed to appear to the left of the first cycle's G1 
population. By default, the program will assume that the first peaks it finds should be 
assigned to the number of standards you select here. Use the Properties of Standards button 
below to give the program additional information about the internal standards in your 
samples. 

Properties of standards 

Click this button to display the Standards dialog. This dialog allows you to edit the names and 
expected locations of internal standards in your samples. By entering expected locations, the 
program can more accurately determine which peaks are standards, and where the Diploid 
population occurs. See the description of Diploid determination below for more on using this 
value to assign ploidy. 

External reference standard 

If you enter a value of an external standard location, you can make use of this value in 
assigning ploidy labels to the cycles that AutoAnalysis finds. For example, if you run a normal 
Diploid control at a particular channel, you can enter that channel position in this edit box. 
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See the description of Diploid determination below for more on using this value to assign 
ploidy. 

  

Ploidy Determination 

Maximum cell cycles 

Select the maximum number of cell cycles that Auto Analysis can model. By default, this is 
set to "Unlimited". If the program detects numerous false peaks in your data files, you may 
want to specify a maximum of 3 or 4 cycles. See the Peak Finder Settings for more 
information about finding peaks. 

Diploid determination 

This option determines the method that Auto Analysis will use to identify the Diploid cycle in 
your data files. 

First cycle is Diploid 

This is the default selection. Use this option if you want the first (leftmost) cell cycle always 
to be classified as the Diploid cycle. 

Based on external reference 

Use this option if you have entered an expected location for an external reference above, and 
you want to use that position as the basis for identifying the Diploid cycle. The expected 
Diploid location will be computed as the External reference standard location multiplied by 
the Diploid-to-Standard ratio. 

Based on Standard1 and Based on Standard2 

Use this option if you have entered expected location(s) for internal standards above in 
Properties of standards, and you want to use one of the standards to compute the expected 
location of the Diploid cycle. The expected Diploid location will be computed as the Expected 
position of the standard multiplied by the Diploid-to-Standard ratio. 

  

Examples: 

1. Suppose you have one internal standard in your samples that is normally found at channel 
38 in the DNA histogram, and that the normal Diploid G1 location is 1.3 times the standard's 
position. You would enter the expected location of the standard using Properties of 
standards, select Based on Standard1 for the Diploid determination option, and enter 1.3 in 
the Diploid-to-standard edit box. 

  

2. Suppose you run a normal Diploid control that is positioned at channel 55 everyday, and 
that you expect this to be the location of Diploid cycles in your test samples as well. You 
would enter 55 in the External reference standard field, select Based on external reference 
for the Diploid determination, and enter 1.0 for the Diploid-to-Standard ratio. 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 211 

Diploid-to-Standard ratio 

This value is used if you have the Diploid determination option selected for Based on external 
reference, Based on Standard1, or Based on Standard2. The expected location for the Diploid 
G1 is computed by multiplying this value times the expected location of the reference or 
standard. 

When Diploid determination is set for First cycle is Diploid, this value is not used. 

G1 threshold 

This value sets the minimum relative height for a peak to be considered a G1, after adjusting 
the height for aggregates. The relative height is a value relative to the largest peak, where 
the largest peak is 100%. The default setting for G1 threshold is 5%. To allow smaller peaks 
to be considered G1 peaks, lower the value. To make the setting more restrictive, increase 
the setting. 

Peak location range 

This value controls how much variation the program allows in looking for a peak at an 
expected location. It is a percentage of the expected location. If, for example, the expected 
location of the Diploid G1 is channel 50 and this value is set for 10%, Auto Analysis will look 
for a peak between channel 50 plus and minus 5 channels, or 45 to 55. 

Dependent G2M 

With this option enabled, Means and Standard Deviations for all G2M components will be 
dependent on the associated G1 components in models created by Auto Analysis. This setting 
creates more consistent analysis results from one operator to the next, and it is 
recommended. With the option disabled, any G2M component that has a well-defined Peak 
Finder peak will have a floating Mean and Standard Deviation. Those without well-defined 
peaks will be dependent on associated G1 components. 

  

S-Phase 

S-Phase shape 

This option controls the mathematical function that is used to model S-Phase. 

Rectangle 

This is the default selection. It provides the most conservative estimate of S-Phase and is the 
recommended option. 

Trapezoid 

This option provides one additional degree of freedom over the Rectangle. 

Polynomial 

This option adds two degrees of freedom over a rectangle. 
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Number of compartments 

Select the number of compartments to use in modeling S-Phase. By default, this option is 1, 
the recommended value. 

DI for S-Phase 

Enter a DNA index value (DI) below which the program will disable S-Phase modeling for the 
lower of two overlapping cycles. The default and recommended value is 1.3. 

When two cell cycles are significantly overlapped, the S-Phases can be arbitrarily inflated or 
deflated in the modeling process. In this situation, it is better to disable the S-Phase for the 
lower-positioned cycle. The DI for S-Phase setting controls the threshold for this decision. 

  

Tetraploid 

G2M Threshold 

This value determines when a peak at a G2M location is considered to be too large for a G2M 
peak, and is classified as a G1 peak for another cycle. The value used in making this decision 
is a simple statistical fit of the peak, not the modeled result for the peak. 

The value is a percentage of the estimated area of the associated G1 peak. By default, the 
G2M can be up to 15% of its associated G1 before it is reclassified as a G1 of another cycle. 

Tetraploid location range 

This value controls how much variation the program allows in looking for a potential 
Tetraploid peak. It is a percentage of the expected location. 

  

Open 

If you have previously saved Auto Analysis settings to disk, you can use the Open button to 
load those settings into the program. 

Save 

Use this option if you want to store the current Auto Analysis settings to a file on disk. The 
standard file save dialog box will be displayed, allowing you to navigate to a location and 
name the file to save. 

Reset 

Click this button to restore the Auto Analysis values to the factory default settings. 

OK 

Click this button to accept the changes you have made and close the dialog. 

Cancel 
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This option closes the dialog and discards any changes you might have made. 

Help 

This option displays the on-line help for this dialog. 

Standards 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

This dialog allows you to edit how ModFit LT interprets the internal standards in your data 
files.  

 

  

If your files contain internal standards, you should fill in the expected location for each 
standard in this dialog. Doing so will assist the program in identifying standard peaks, as well 
as to correctly classify cell cycles. After you enter location values in this dialog, you can 
choose a ploidy determination method in the Auto Analysis Settings dialog that makes use of 
the location. 

Select the standard that you want to edit in the list on the left and the right hand list will 
show the properties that you can adjust for the standard. 

  

See also: Properties for Standards 

Properties for Standards 

  

Name 
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Enter a name for the standard. This name will be assigned to a range for the standard peak. 
The range can be viewed and adjusted by clicking the Range button on the toolbar. 

Expected position 

Enter the channel location on the histogram where the standards peak is typically found. You 
should ensure that your protocols for running samples on your flow cytometer consistently 
maintain this position for the standard. 

Generate debris 

When checked, internal standard components are considered to be involved in the generation 
of debris in the histogram. 

Note: Models that are created by AutoAnalysis ignore internal standards from debris 
generation. 

Generate aggregates: 

When checked, internal standard components are considered to be involved in the generation 
of aggregates in the histogram. 

Note: Models that are created by AutoAnalysis ignore internal standards from aggregate 
generation. 

  

See also: Standards 

Peak Finder Settings 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

The Peak Finder dialog adjusts the settings used by the system to determine how peaks will 
be identified in your samples. The peak finder statistically determines what populations are 
peaks in the histogram data, and then applies filters to remove unwanted peaks from 
consideration. 

The peak finder is of fundamental importance in Automatic Analysis. Therefore, it is very 
important to approach changes to the peak finder with care and thoughtfulness. 

Changes to these settings will affect how the program defines a peak, which in turn will alter 
ploidy detection, model selection, and analysis results in Automatic Analysis. Test any 
changes you make on a reasonable sampling of your data files. Make changes to improve the 
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overall effectiveness of the peak finder, not to handle an exceptional sample. Exceptional 
samples should be handled using manual analysis. 

 

The dialog displays the analysis histogram. The graphic indicates the currently identified 
peaks with black triangles at the base of the histogram. In addition, there are controls that 
allow you to adjust the peak finder settings and see the effect immediately. 

As you move your mouse pointer over the histogram, boundaries of peaks are drawn over 
the data, illustrated in the graphic above. The status of the peak for each criterion is shown 
next to the control for the filter. Using this information, you can determine why the peak 
finder excludes peaks, and make adjustments to the filters accordingly. 

Start at 

The value controls the point at which ModFit LT starts looking for peaks. It allows you to skip 
over channels where your data has debris that may be misinterpreted as a peak. The value is 
a percentage of the histogram scale, and higher values move the starting point to higher 
channel location. 

Low %CV 

This value controls the low %CV cutoff for data to be considered a peak. %CV reflects the 
broadness of the peak; those peaks which have %CV lower than this filter are excluded. To 
remove more narrow peaks, increase the value. To allow more peaks, lower the value. 

High %CV 

This value controls the high %CV cutoff for data to be considered a peak. %CV reflects the 
broadness of the peak; those peaks which have %CV higher than this filter are excluded. To 
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allow more peaks to pass the filter, increase the value. To reduce the number of peaks that 
pass the filter, reduce the value. 

Rise 

This value controls how far a peak must rise above adjacent data to be considered a real 
peak. Peaks that extend above adjacent data less than this value are excluded from the peak 
finder. To increase the minimum rise for a peak and reduce the number of passing peaks, 
increase this value. To reduce the filter and allow more peaks to pass, reduce the value. 

Correlation 

This value controls the minimum correlation coefficient allowed for a peak to pass this 
"shape" filter. Each potential peak is fit with a Gaussian curve; the resulting correlation 
coefficient is compared to this filter. To increase the minimum allowable correlation 
coefficient and reduce the number of passing peaks, increase the value. To increase the 
number of peaks that pass the filter, reduce the value. 

  

Open 

If you have previously saved peak finder settings to disk, you can use the Open button to 
load those settings into the program. This is useful if you analyze sets of data that have 
different peak characteristics. 

Save 

Use this option if you want to store the current peak finder settings to a file on disk. The 
standard file save dialog box will be displayed, allowing you to navigate to a location and 
name the file to save. 

Reset 

Click this button to restore the peak finder values to the factory default settings. 

OK 

Click this button to accept the changes you have made and close the dialog. 

Cancel 

This option closes the dialog and discards any changes you might have made. 

Help 

This option displays the on-line help for this dialog. 

Options and Configuration 
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Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

This dialog is used to set program configuration options. 

 

  

Data Processing and Display 

Apply Dither 

When enabled, a small random value is added to listmode events to make the distributions 
continuous. This is enabled by default. 

Apply Compensation Keywords 

When enabled, the program will read compensation keywords from the FCS file and apply 
compensation defined in those keywords. 

Desired resolution 

Select the desired resolution for the analysis histogram. It is strongly recommended that you 
use the default setting of 256 channels to improve performance and consistency. The 
histogram will be displayed and analyzed at the desired resolution, provided that the 
parameter's resolution is greater than or equal to the desired resolution. 

Log Decade Option 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 218 

This option determines how many decades will be displayed for listmode data. Choose 
between "Computed Decades" and "Force Four Decades". Computed decades are based on 
the ADC resolutions stored in the FCS file keywords. 

Default Log-like Transform 

Choose the transform to use for log distributed data, by default.  Options include Log, 
HyperLog, Hyperbolic Sine, and VLog. 

Axis Units 

Choose between "Histogram channels" and "Data (ADC) values". Historically and by default, 
ModFit displayed the axis with histogram channel tic marks, and results were reported on 
that scale. To display the axis with the true resolution of the FCS data, choose "Data (ADC) 
values"; this will also change results to be on the ADC scale. 

Auto-scale X axis 

Auto-scale Y axis 

These options control the auto-scaling of the main histogram graphic. When checked, each 
data file is automatically scaled on the X-axis and/or Y-axis as it is opened. The Y scaling is 
set to the height of the highest peak. The low X scale is set to 0. The high X scale is set to 
the highest channel that contains data, to a maximum of resolution minus 1. 

Uncheck one or both of these options to leave the scaling unchanged as new data files are 
opened. This is convenient for studies where it is useful to see all histograms on a fixed 
scale. 

  

Parameter Auto-zoom 

Zoom Type 

Choose how this parameter should be zoomed when ModFit reads it. 

Off: no zooming is performed. 

To highest used channel: zooms to the highest channel that has events in it. 

To fixed upper boundary: zooms to the channel defined in the Fixed Upper Boundary edit box 
below. 

To Percentile: zooms to a percentile location in the data. 

Percentile 

This field is used when To Percentile is selected for Zoom Type. It defines the percentile of 
data to include in the zoomed area. 

  

Zoom Graphs 
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These settings determine the default values for X and Y Zoom graph objects. These objects 
can be placed on the report to show the histogram zoomed in the X or Y scale, respectively. 

Y Zoom Graph Factor 

Enter the initial value for Y Zoom graph objects. The value is the number of times to magnify 
the scale, e.g. 25 means multiply data points on the Y scale by 25. 

X Zoom Graph Width 

Enter the initial width as a number of standard deviations to display in the X Zoom graph 
object. 

Update X Zoom Window 

The X Zoom window object on the report can adjust to the position of peaks in each file, or 
only when created.  Select the appropriate option. 

  

Modeling 

Dip G2M Fraction 

This value is used to compute the relative area of the Diploid G2M in Tetraploid models. 
Because the Diploid G2M in a Tetraploid model is in the same location as the Tetraploid G1 
peak, the program disables modeling of the Diploid G2M. After the model fit is completed, 
the program adjusts the Tetraploid G1 by subtracting a portion of its area and assigning it to 
the Diploid G2M. The adjustment is computed by multiplying the Diploid G1 area by the Dip 
G2M Fraction. The default value is 0.08, or 8%, which means that the Diploid G2M area will 
be 8% of the Diploid G1, and the Tetraploid G1 will be reduced by the same area. 

Display nRCS 

This option enables the display of the "Normalized Reduced Chi Square", or nRCS, on the 
report. The nRCS is an RCS value computed on files with > Target Area for nRCS events.  
When RCS is computed on files with a large number of events, it increases simply due to the 
additional events.  This makes it difficult to determine whether the fit is good or bad.  The 
nRCS addresses this by scaling the data to the Target Area for nRCS events and then 
computing RCS on that.  The result is a value which behaves well even with large event 
counts. 

Target Area for  nRCS 

This value determines the number of events to use for the nRCS calculation.  See the 
discussion of nRCS above. 

  

AutoLinearity 

These settings control the AutoLinearity function of the program. This feature is available 
when batch processing reports, and in the Quick Model Editor. See Using AutoLinearity for 
more on this feature. 
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Low linearity 

This field sets the lowest value used by the AutoLinearity operation. Values for this field must 
be between 1.85 and 1.94, inclusive. 

High linearity 

This field sets the highest value used by the AutoLinearity operation. Values for this field 
must be between 1.95 and 2.2, inclusive. 

  

Miscellaneous 

Copy/Save DPI 

This option controls the quality of the graphics copied to the clipboard and saved to files by 
the program. DPI stands for dots per inch, with larger values providing higher quality images 
and larger file sizes.   

Default Graphic output 

Choose the desired graphic format to create when exporting histogram and report graphics. 
Export commands are found in the File menu and in the File and Report Batch Settings 
dialog. 

Supported formats currently include bitmap (bmp), JPeg (jpg), Tiff (tif), Portable Network 
Graphics (png), and Scalable Vector Graphics (svg). 

PDF Output Quality 

This option controls the quality of the PDF files created by the program.  Generally, higher 
quality PDF files are larger than lower quality files. 

Parameter Database 

ModFit LT keeps track of which parameters from the FCS file you have used for gating and 
analysis. This command allows you to view and edit settings for these parameters, including 
whether they are linear or log. See Edit Parameter Database for more information. 

Save Recovery Backup 

ModFit can save your work periodically so that if there is a problem you can recover.  Choose 
the time interval for automatic backups. 

Status Bar Text 

The field determines what will be displayed on the status bar.  By default, it is set to "Project: 
[MF_PROJECT_NAME]", which displays the word Project: followed by the name of the current 
project.  Any of ModFit's keywords can be used in this field, surrounded by square brackets, 
and the resulting expression will appear on the status bar. 

Startup Action 
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This option determines what happens when ModFit LT is opened.  By default, it will Load 
the last project.  Other options include  Don't open or create  a project, Open a 
project, and Create a new project. 

Copy Data into Poject 

This preference determines the default state for the "Copy Data Files" option in the New 
Project dialog.  Enable this option if files should typically be copied into the project 
folder.  Disable the option if files should typically not be copied into a project folder. 

  

Open 

If you have previously saved configuration settings to disk, you can use the Open button to 
load those settings into the program. 

Save 

Use this option if you want to store the current configuration settings to a file on disk. The 
standard file save dialog box will be displayed, allowing you to navigate to a location and 
name the file to save. 

Reset 

Click this button to restore the configuration values to the factory default settings. 

OK 

Click this button to accept the changes you have made and close the dialog.  

Cancel 

This option closes the dialog and discards any changes you might have made. 

Help 

This option displays the on-line help for this dialog. 

Edit Parameter Database 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

This dialog displays the parameters that have been customized by the user.  
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FCS Keyword Name($PnN_$PnS) 

This field identifies the entry and cannot be edited.  The label is composed of two keywords for a 

specific parameter in the FCS file: the $PnN and $PnS keywords.  These keywords allow ModFit 

to distinguish your preferences for each uniquely-identified parameter. 

Parameter Alias 

This field can be edited.  It is displayed on graphs that display this parameter. 

Transform 

Select the transformation that you want to use for this parameter.  Choices include: 

Linear 

Log 

HyperLog 

Hyperbolic Sine 

VLog   

Zoom Type 

This field allows you to set up automatic parameter "zoom".  It is useful for parameters where 

only a small portion of the dynamic range is used.  For example, with DNA samples acquired on 

an Accuri instrument, only a small portion of the channels are used to store data.   

The default setting is for zooming to be "Off".  Other options include: 
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"Highest used channel":  zooms the data to exclude any empty channels on the high end of the 

parameter's range. 

"Fixed upper boundary": zooms the data to exclude channels above a specified channel. 

"Percentile": zooms the data to exclude channels above the specified percentile of the data area. 

Fixed Upper Boundary 

This field is used if Zoom Type is set for "Fixed upper boundary".  It defines the channel to 

which you want to zoom.  Channels above this channel will be excluded. 

Percentile 

This field is used if Zoom Type is set for "Percentile".  Enter the percentile of data you want to 

include. 

OK 

Click this button to accept the changes and close the dialog box. 

Cancel 

Click this button to discard any changes and close the dialog box. 

Open 

If you have previously saved parameter preferences to disk, you can use the Open button to load 

those preferences into the program. 

Save 

Use this option if you want to store the current parameter preferences to a file on disk. The 

standard file save dialog box will be displayed, allowing you to navigate to a location and name 

the file to save. 

Delete All 

Click this button to clear out all entries from the parameter preferences. It is recommended 
that you Save your parameter preference to a file prior to deleting all, in case you want to 
restore settings to a previous state. 

  

Edit Properties for Parameter 
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Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

  

FCS Keyword Name 

This is the name from the FCS file for the parameter. 

Alias 

This field contains the name to display when this parameter is used in ModFit. It can be 
edited, and it appears on the axis of the graphs that display the parameter. 

Transform 

Choose either a Log or Linear transform to use for this parameter. 

Parameter auto-zoom 

Zoom Type 

Choose how this parameter should be zoomed when ModFit reads it. 

Off: no zooming is performed. 

To highest used channel: zooms to the highest channel that has events in it. 

To fixed upper boundary: zooms to the channel defined in the Fixed Upper Boundary edit box 
below. 

To Percentile: zooms to a percentile location in the data. 

Fixed Upper Boundary 
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This field is used when To fixed upper boundary is selected for Zoom Type. It defines the 
channel location to zoom to. 

Percentile 

This field is used when To Percentile is selected for Zoom Type. It defines the percentile of 
data to include in the zoomed area. 

  

OK 

Click this button to accept the changes and close the dialog box. 

Cancel 

Click this button to discard any changes and close the dialog box. 

Edit User Equations 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

ModFit LT allows you to create additional equations to compute when the model is executed, 
either with Auto Analysis or Execute Model. Equations that you enter here are remembered 
when the program closes.  They can be added to databases and displayed on the ModFit LT 
report page as keywords. 

These equations must follow the syntax described in the section on Equation syntax. 
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To add a new equation, click New and enter the equation (see Equation syntax for details). 

To change an equation, select the equation in the list and click the Properties button, or 
edit the equation directly. See Edit Properties for Equation for details. 

To display an equation on the report, check the Add to Report Results checkbox. 

Use the Model Type drop-down list to determine which model types will compute and 
display you equation. 

To save the current equations to disk so that they can be opened on another computer, click 
the Save button. 

To open a previously saved set of equations from disk, click the Open button. 

Edit Properties for Equation 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

ModFit LT allows you to create additional equations to compute when the model is executed, 
either with Auto Analysis or Execute Model. These equations must follow the syntax 
described in the section on Equation syntax. 
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You can enter a name for each equation and the equation expression. The name will be used 
as a keyword name, prefixed with "USER_", and can be selected for databasing and display 
on the report. 

For example, if you name your equation, "SumOfAneuploidAreas", you can select the 
keyword "USER_SumOfAneuploidAreas" to display on the report using the Tools menu, 
Keywords command. You can also select this keyword to be databased using the Edit menu, 
Databases command. 

Settings Manager 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

This dialog allows you to manage the program settings. You can back-up settings so that 
they can be transferred to other computers or for archival purposes. Similarly, you can select 
settings from previous back-ups and load them as current settings. 
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Export Settings 

Click this button to export the current settings. The standard file save dialog will be 
displayed.  Navigate to the location where you want to save the settings, type a file name, 
and click Save. 

  

Import Settings 

Click this button to import the settings. The standard file open dialog will be 
displayed.  Navigate to the settings file that you want to open, select it, and click Open. 

  

Reset Settings 

Click to clear the current settings and reset to defaults.  The program will confirm that you 
want to perform this operation.  If you proceed, it will offer to restart the program for you. 

  

OK 

Click this button to close the dialog box when finished importing or exporting settings. 
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Research and Compliance Modes 

Research and Compliance Modes 

  

ModFit LT can be set up to run in either a Research-Use-Only mode, or in Compliance mode. 
There are some differences in how the program operates in each mode. 

• Compliance mode depends on operating system user groups to control the level of 
access to program features. Research mode allows any user to perform any operation. 

• Compliance mode displays a login dialog when the ModFit LT is starting up to verify the 
user and determine the group to which the user belongs. 

• Compliance mode enables logging so that there is a record of the activities of each user. 
Research mode can be run with logging enabled or disabled. 

• Compliance mode is designed to support clinical labs and can be part of a compliance 
plan for the US-FDA's 21 CFR Part 11 regulations. Research mode does not provide 
compliance with 21 CFR Part 11. 

• Both modes use the same intuitive interface and ModFit LT engine. 

The program displays which mode it is operating in.  In the Ribbon bar interface, the mode is 
displayed in the upper right corner of the ribbon: 

 or   

In the Toolbar interface, the mode is displayed on the main toolbar next to the Help button. 

  

Setting Up Research Use Only Mode 

After initial installation, ModFit LT will automatically be in Research mode. There is no further 
configuration required. 

To revert to Research mode after setting up Compliance mode, the user groups that were 
created for Compliance mode must be removed. Once the user groups are removed, the 
program will revert to Research mode. 

  

Setting Up Compliance Mode 

Setting up Compliance mode is something that should be performed by IT personnel. 

While it is not a complicated task, it requires administrative access rights and a clear 
understanding of user groups and permissions. It is therefore something that we strongly 
recommend be performed by the IT team at your institution. The task involves creating 
several required ModFit LT user groups for your computer or domain, and then adding users 
to those groups. Once the groups are defined, the program automatically operates in 
Compliance mode. Click here for details. 
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21 CFR Part 11 Compliance Matrix 

This matrix provides a simple summary of how ModFit LT in Compliance mode helps you with 
21 CFR Part 11 compliance. Click here for details. 

Setting Up Compliance Mode 

  

Setting up Compliance mode should be performed by your IT team. It requires 
administrative rights and a clear understanding of your network operating 
system. 

The task involves creating several required ModFit LT user groups for your computer or 
domain, and then adding users to those groups. Once the groups are defined, the program 
automatically operates in Compliance mode. 

  

ModFit LT User Groups 

There are three (3) user groups for Compliance mode: ModFitAdmins, ModFitEditors, and 
ModFitUsers.  Optionally, you can define an additional user group, ModFitResearchers, 
for research users within the Compliance setting who are not restricted by Compliance 
requirements.   

The table below shows the kinds of features that group members can access.   

  

Feature ModFitAdmins ModFitEditors ModFitUsers ModFitResearchers RUO 
Mode 
Any 
user 

Set shared 
folder location Yes No No No No 

Edit 
Preferences Yes No No Yes Yes 

Check for 
Updates Yes No No Yes Yes 

Edit Logging 
Yes No No Yes Yes 

Create and 
Edit Models Yes Yes No Yes Yes 

Edit 
Databases Yes Yes No Yes Yes 

Select Models 
Yes Yes Yes Yes Yes 

Add files to 
batch Yes Yes Yes Yes Yes 

Run a batch 
of files Yes Yes Yes Yes Yes 

Log and 
Preference 
folder 

Shared Shared Shared Per user 
Per 
user 
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Setting Shared Folder location 

When Compliance mode is enabled, there is an additional command that appears on the 
Options tab of the ribbon bar for ModFitAdmins. In Toolbar mode, the command appears in 
the Edit menu. 

The Select Shared Folder command is used to select a settings folder that is shared by all 
users in Compliance mode. The common settings folder ensures that all Compliance-mode 
users work with the same configuration.  

ModFitAdmins can use this command at any time to set or change the location for shared 
settings.  Other users will not see this command. 

  

Creating User Groups 

The program requires at least one of the ModFit LT user groups to be defined in order to run 
in Compliance mode.  ModFit LT user groups can be defined for your computer or for your 
entire domain using tools provided by the operating system.  This is typically done by 
information technology personnel because it requires administrative rights.   

The advantage of defining the user groups at the domain (network) level is that the groups 
are defined for all computers on the domain at the same time.  If you define the user groups 
on an individual computer, those groups are available only on that computer. 

Below we describe how to create user groups on a Windows server or on a Windows 
compute as examples.  The specific methods you need to use may differ depending on the 
version of the operating system you are working with. 

After you have defined the user groups and added users to them, ModFit LT will detect the 
groups when it starts up and operate in Compliance mode automatically. 

  

Windows Server User Groups 

Follow these steps to define user groups for an entire network or domain. Note: if you use 
this technique, you do not need to define user groups on each individual 
computer. 

• On a domain server, launch the "Active Directory Users and Computers" administrative 
tool. 

• Right click the "Users" folder in the left panel and choose New->Group.  The New Group 
dialog is displayed. 
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• Type ModFitAdmins for the group name and click OK. 
• Once the group is created, double-click the group in the list to display the Properties for 

the group. 
• Click the Members tab and click Add to select members for the ModFitAdmins 

group.  You should have at least one user in the ModFitAdmins group. Members can be 
added by typing user names, or by using the dialog's search features. 
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• Repeat this process for the ModFitEditors, ModFitUsers, and optionally 

ModFitResearchers groups, adding appropriate users to each group. 
• Once the groups are created and users are added to them, the program will 

automatically use Compliance mode when it starts up and is connected to the domain. 

  

Windows Computer User Groups 

Follow these steps to define user groups for an individual Windows computer. Note, if you 
already defined user groups for your domain, you do not need to define the 
groups again for each computer. 

• On a Windows 7 computer, right click Computer and choose "Manage". For Windows 10 
and newer, right click the Windows button (lower left) and choose "Computer 
Management".  The Computer Management app will display. 

• Expand "System Tools" and "Local Users and Groups" in the left panel. 
• Right click the "Groups" folder and choose "New Group".  The New Group dialog is 

displayed. 
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• Type ModFitAdmins for the group name and enter a description for the group. 
• Click Add to select members for the ModFitAdmins group.  You should have at least one 

user in the ModFitAdmins group.  Members can be added by typing user names, or by 
using the dialog's search features. 

• Click Create to create the new local user group. 
• Repeat this process for the ModFitEditors, ModFitUsers, and optionally 

ModFitResearchers groups, adding appropriate users to each group. 
• Once the groups are created and users are added to them, the program will 

automatically use Compliance mode when it starts up on that computer. 

  

Mac OS X User Groups 

Follow these steps to define user groups for an individual Mac OS computer. 

• On a Mac OS computer, launch System Preferences. Choose "Accounts" or "Users and 
Groups", depending on the version of the OS. 

• Click the lock icon to authenticate to make changes. This will require administrative 
rights. 

• Click the "+" button under the list of users and groups. The "New Account" dialog is 
displayed. 

• Change the New Account type to "Group". 
• Type ModFitAdmins for the group name and click "Create Group". 
• Select the users you want to be members of the ModFitAdmins group. You should 

have at least one user in the ModFitAdmins group. 
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• Repeat this process for the ModFitEditors, ModFitUsers, and ModFitResearchers 
groups, adding appropriate users to each group. 

• ModFit LT will run in Compliance mode the next time it starts. 

See also: 

21 CFR Part 11 Compliance 

21 CFR Part 11 Compliance 

  

ModFit LT can be part of your lab's compliance strategy for 21 CFR Part 11 when it is setup 
and operated in Compliance mode.  It has been developed under a quality management 
system and validated with a suite of quality assurance tests. The table below summarizes 
how the key elements of Part 11 relate to ModFit LT and its use in Compliance mode 
settings. 

  
Section Summary of Rule Compliance Strategy 

11.10 
Controls for closed 
systems 

ModFit LT can be accessed only through the user 
interface; it is a closed system. 

11.10 (a) 
Validation and 
accuracy. 

ModFit LT uses externally-generated data to validate 
its results and employs proprietary binary format, 
static PDF, and/or CRC methods to ensure valid files. 

11.10 (b) 
Record generation 
and readability 

ModFit LT generates Xml-format model files, CRC-
checked log files, and static PDF that are human-
readable and machine-readable. 

11.10 (c) 
Record protection 
and retrieval 

Record retention and retrieval plan is managed by the 
laboratory’s file management practices. 

11.10 (d) Authorized access 
ModFit LT uses the operating system’s user login 
validation, and user group membership determines 
permissions within the software. 

11.10 (e) Audit trails 
ModFit LT employs a CRC-checked logging system 
with time stamps, and log files are preserved. Log 
files cannot be deleted by ordinary means. 

11.10 (f) 
Operational system 
checks 

ModFit LT enables and disables portions of the UI to 
enforce permitted sequencing of steps and events. 

11.10 (g) Authority checks 
ModFit LT uses the operating system user groups and 
login validation to assure authorized access. 

11.10 (h) 
Device checks and 
validity 

ModFit LT performs validation checks on the FCS data 
files. 

11.10 (i) 
Education, training 
and experience 

ModFit LT provides a User Guide, technical support, 
and tutorial videos to assist with the proper, intended 
use of ModFit. Specific on-site training may be 
arranged. 

11.10 (j) Electronic signatures 
This is an individual laboratory requirement beyond 
the scope of use of ModFit LT. 
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11.10 (k) 
Systems 
documentation 

ModFit LT version releases are accompanied by an 
updated User Guide. Verity employs document control 
procedures. 

11.30 
Controls for open 
systems 

ModFit LT is designed as a closed system. 

11.50 
Signature 
manifestations 

ModFit does not require or offer electronic signatures. 

11.70 Signature linking 
ModFit LT does not require or offer electronic 
signatures. 

11.100 (a) 
Unique electronic 
signatures 

Your laboratory must ensure that electronic signatures 
are unique to each user on the network. 

11.100 (b) Identity verification 
Each laboratory must verify its own employment 
records and IDs. 

11.100 (c) 
Signature 
verification 

Each laboratory must verify electronic signature 
eligibility with the FDA. 

11.200 
(a)(1) 

Two-component 
signing 

ModFit LT does not require or offer electronic 
signatures. 

11.200 
(a)(2,3) 

Authenticity and 
falsification 

ModFit LT does not require or offer electronic 
signatures. 

11.200 (b) Biometric signatures ModFit LT does not utilize biometric IDs. 

11.300 (a) 
Controls for 
identification 

ModFit LT uses the operating system user groups and 
login validation to assure unique user identities. 

11.300 (b) Identification aging 
The individual laboratory IT structure must control 
password checks and aging requirements. 

11.300 (c) 
External ID 
validation 

Not applicable. ModFit LT does not utilize external 
tokens, cards, RFID, or other physical identity-
confirming devices. 

11.300 (d) Unauthorized use 
The individual laboratory IT structure must control 
login authenticity and manage safeguards to prevent 
unauthorized use. 

11.300 (e) 
External device 
testing 

Not applicable. ModFit LT does not utilize external 
tokens, cards, RFID, or other physical identity-
confirming devices. 
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Customizing Models 

Model Descriptions 

  

This section contains descriptions of the models used by ModFit LT. 

Model naming 

When Auto-analysis or Choose model commands are used to create models, the program 
uses the following logic to create a name for the model. 

Position in name Meaning 

1 Number of cycles 

2 'D' if AutoDebris is enabled; 'n' if not 

3 'A' if AutoAggregates is enabled; 'n' if not 

4 Number of standards 

5 'A' if Apoptosis is enabled; 'n' if not 

For each cycle in the model, the name includes the following: 

An underscore (_) character; 

The first character of the cycle's ploidy, i.e. D=Diploid, A=Aneuploid, T=Tetraploid, H=Hypo-
diploid; 

'S' if S-Phase is active, or 'n' if not; and 

'F' if G2M is active and floating, 'D' if active and dependent, 'n' if G2 inactive. Floating means 
that the mean position and standard deviation are adjusted during the modeling process. 
This gives more freedom to the model, but the peak must be unambiguous. Dependent 
means that the position and standard deviation of the G2M are computed by multiplying the 
G1 position and standard deviation by a factor of 2.0 or your chosen linearity setting. Inactive 
means that the G2M is not modeled. 

For example, the model name "3DA0n_DSD_AnD_ASF" can be interpreted to mean that there 
are 3 cycles, AutoDebris is enabled, AutoAggregates is enabled, zero standards, and 
apoptosis is not being modeled. The first cell cycle is Diploid, with S-Phase active and a 
Dependent G2M. The second cycle is Aneuploid, S-Phase is turned off and the G2M is 
dependent. The third cycle is also Aneuploid, S-Phase is enabled, and the G2M position is 
allowed to float. 

  

Ranges and their uses 
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The table below shows the ranges used by ModFit LT and the populations they are used to 
identify. 

Range Usage 

Debris Left side placed at start of downward sloping debris, right side 
extended through roughly 2/3 of the histogram. Provides estimates 
for AutoDebris component. 

Stnd 1 Identifies the peak of the first standard. The range should be 
positioned to encompass the standard peak. If you have named your 
standards, the range will show the name you assign. See Auto 
Analysis Settings for details on naming standards. 

Stnd 2 Identifies the peak of the second standard. The range should be 
positioned to encompass the standard peak. If you have named your 
standards, the range will show the name you assign. 

Dip G1 Identifies the G1 of the Diploid cycle. The range should be 
positioned to encompass the peak. 

Dip G2 Identifies the G2 of the Diploid cycle. The range should be 
positioned to encompass the peak. 

Cycle G1 and G2 Identify the G1 and G2 for each additional cycle. The range should 
be positioned to encompass the associated peak. 

  

When you use automatic analysis, ModFit LT constructs a model for you based on the peaks 
it can identify in the data sample. It looks at how many peaks there are, their standard 
deviations, areas, and relative locations, then takes its best shot at deducing the ploidy, 
debris, and aggregation aspects of the sample. It builds a model that matches what it finds. 
The black triangles at the base of the histogram show the peaks the program has identified. 

When you select a model yourself using the Choose Model option, you are presented with 
the dialog pictured below. With this dialog, you make the decisions about the sample. 
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Colors 

ModFit LT allows you to edit the colors used by the model using the Colors command. The 
default color assignments are listed in the table below. 

Component Color 

Diploid G0-G1 red 

Diploid G2-M red 

Diploid S-Phase reverse-hatched blue 

Aneuploid G0-G1 1st is bright yellow; others become darker shades of yellow 

Aneuploid G2-M 1st is bright yellow; others become darker shades of yellow 

Aneuploid S-Phase forward-hatched blue 

AutoAggregates light green 

AutoDebris medium blue 

Apoptosis sky blue 

1st Standard dark gray 

2nd Standard light gray 

  

Component Shapes 

The parts of ModFit LT's models are comprised of several component shapes. The table 
below shows the shapes used by the models, and where they are used. 

Component Shape Uses 
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Gaussian 

 

Gaussian 
components 
are used to 
model peaks. 
They are 
often linked 
to ranges. 
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Rectangle 

 

This 
component is 
typically 
used to 
model S-
Phase. The 
peaks on 
either side of 
it determine 
boundaries 
and standard 
deviations. 
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Trapezoid 

 

This 
component 
can be used 
to model S-
Phase. It has 
an additional 
degree of 
freedom over 
the rectangle 
and 
generally 
yields higher 
S-Phase 
values. The 
peaks on 
either side of 
it determine 
boundaries 
and standard 
deviations. 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 243 

Polynomial 

 

This 
component 
can be used 
to model S-
Phase. It has 
an additional 
degree of 
freedom over 
the trapezoid 
and should 
be used with 
caution. The 
peaks on 
either side of 
it determine 
boundaries 
and standard 
deviations. 
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AutoDebris 

 

The 
AutoDebris 
component is 
used to 
model 
debris. Its 
starting point 
is based on 
the position 
of the Debris 
range. 
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AutoAggregat
e 

 

This 
component is 
used for 
aggregate 
compensatio
n. Its shape 
is unique to 
each 
histogram. It 
does not use 
a range. 
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Weibull 

 

This 
component 
can be used 
to model 
skewed 
peaks in 
custom 
models. 

Contact 
Verity 
technical 
support for 
assistance 
with this 
component. 

  

See also: 

Choose Model command (Analysis menu) 

Manual analysis with ModFit LT 

Analysis Results 
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Colors command 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

Use this command to adjust colors and other graphical aspects of the model. You can change 
color, fill style, and transparency for colors in the current model. The changes you make can 
also be remembered and applied to other models. 

 

  

Model Definition 

With the Model Definition selected in the tree on the left, you can edit characteristics of the 
fit line displayed on the modeled histogram.  The color, style, and weight of the fit line can 
be adjusted. 

Components 

To choose a new color for a model component, click the color swatch next to the component. 
The standard dialog for choosing colors will appear. Select a new color and click OK. 

To choose a new fill style for a model component, click the sample fill for the component. A 
drop-down list of choices will appear. Select a new fill style from the list. 

Each component can either be transparent or opaque. This determines how overlapping 
components are drawn. To make a component transparent, enable the checkbox in the 
Transparent column. Uncheck the option to make a component opaque. 
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OK 

When you click OK, you will be asked whether you want to apply the changes to all models, 
or just the current model. If you choose to apply to all models, the changes are stored for 
future sessions of ModFit LT. If you choose to apply the changes only to the current model, 
the changes will be lost when you load a new model, perform an Auto Analysis, or close the 
program. 

Reset All 

Click this button to clear all color selection overrides. 

Cancel 

Click this button to discard changes to colors. 
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Quick Model Editor 

 

Overview 

The Quick Model Editor allows you to make changes to the current model. It is available 
when the model you are using is created by AutoAnalysis or by using the Choose Model 
option. 

Changes you make with this dialog are applied to the model when you click OK. In order to 
see the changes to the model, you need to re-analyze the data by clicking the Fit button or 
choosing Execute Model from the Analysis menu. 

 

  

AutoDebris 

This checkbox determines whether the AutoDebris model component is active or not. When 
checked, AutoDebris is activated. The AutoDebris component is used to model debris in data. 
It can be left active even when samples display little or no debris, because its shape and 
amplitude are based on probability distributions unique to each sample. 

AutoAggregates 

When this option is checked, the AutoAggregates model component is activated. This 
component is used to model the continuum of aggregate forms found in many samples. It 
can be left active even when there is little or no aggregation in the sample, because its shape 
and amplitude are based on probability distributions unique to each sample 

Linearity 

This field modifies the appropriate G2M dependency settings and modifies the aggregate 
model component's linearity setting. When the user indicates that a G2M is not visible, the 
program makes the position and standard deviation of the G2M model component dependent 
on the G1 by this linearity setting. It updates the linearity setting for the aggregate model 
component as well. 
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Internal standards 

This option determines the number of peaks attributed to standards. Standard peaks typically 
occur below the first G1 peak. However, you can configure the expected locations for 
standards in your samples using the Auto Analysis Settings dialog box. 

G2M Section 

The options in this section of the dialog allow you to control how the G2M for each cycle is 
modeled. If the option is checked (Visible), the program will use the associated G2M range to 
estimate the position and it will allow that position to be adjusted by the modeling process. If 
the option is not checked, the position of the G2M will be computed by multiplying the G1 
position by the linearity value. 

Generally, if a G2M is a well-defined peak that does not overlap another peak, you can 
enable the option and the model will provide a more accurate result. However, if the G2M 
peak is not clearly defined or if it substantially overlaps another peak, uncheck the option. If 
the option is checked when a peak is not well defined, the model will produce less accurate 
results. 

S-Phase Section 

The options in this section control the state of the S-Phase model component for each cell 
cycle in the model. If a check appears in the checkbox, the S-Phase component is active and 
the program will attempt to model it. Clear the check to disable the S-Phase component for 
the model. 

In samples such as near Diploid histograms, the S-Phases of two or more cycles can be 
significantly overlapped. This can create problems for the modeling process. In these cases, 
it is better to disable one of the S-Phase components, normally the Diploid S-Phase. 

  

OK 

Apply the settings to the current model and put away the dialog box. 

Cancel 

Close the dialog and discard any changes you have made. 

Reset 

This option resets the the properties in this dialog to their default states. 
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Full Model Editor 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

  

This dialog allows editing of existing models and creation of new models. It can be used to 
change any and all aspects of a model, and therefore should be used with great care. 

The listbox displays the aspects of the model that can be edited: ranges, components, and 
results. 

Ranges: 

Ranges are used to provide estimates for the model components. They are displayed when 
you click the Range button on the ribbon bar. Most ranges are used to identify peaks in the 
model, and associated model components use the range position, size, and statistical data as 
a starting point in the modeling of the histogram. See Edit Ranges for more on this topic. 

Components: 

Components of the model define the mathematical pieces and their interdependencies. There 
are components to model debris, aggregates, peaks, and broad distributions. Each 
component, in turn, has a set of details that further describe the properties of the 
component. See Edit Properties for Component for more on this topic. 

Analysis Results: 
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Analysis results are defined using equations. They can show simple information, such as 
keywords stored in the data file, or sophisticated mathematical expressions based on details 
of model components. See Edit Analysis Results for more on this topic. 

Report Results: 

Report results define what analysis information will be displayed on the report. See Edit 
Report Results for more on this topic. 

  

OK: 

Click this button to close the dialog and apply the changes to the current model. 

Open: 

This option allows you to open a previously saved model from disk. The File Open dialog box 
is displayed, allowing you to navigate to and select the model. Note: Models from ModFit LT 
2.0 and earlier cannot be opened with this option. 

Save: 

This option allows you to save the current model to disk for later use. The File Save dialog is 
displayed, allowing you to navigate to the location where you wish to store the model. 

Help: 

Click this button to display online help for this topic. 

Edit: 

This button is enabled when one of the list entries is selected. Clicking the button will display 
the edit dialog for the selected item. 
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Edit Components 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

  

This dialog allows you to add, delete, and edit components of the model. Each model 
component mathematically describes a piece of the model. The collection of components 
attempts to fully define the histogram as a mathematical model. 

Component names can be edited by clicking slowly once on the name, then clicking again. 
The list item will enter edit mode; press the Tab key or click another item to accept the 
revision. 

Select a component in the list, and then click one of the action buttons to modify it. 

OK: 

Click this button to close the dialog and accept the changes. 

Help: 

Click this button to display online help for this topic. 

Properties: 

This button is enabled when one of the list entries is selected. Clicking the button will display 
the edit properties dialog for the selected item. 

Edit: 
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This button is enabled when one of the list entries is selected. Clicking the button will display 
the edit dialog for the selected item. 

Copy: 

Click this button to copy the selected component. The new copy will be added to the end of 
the component list, and can be selected for editing. 

Delete: 

Click this button to delete the selected component. If other components are dependent on 
the deleted component, they will become inactive. Use great care when deleting components 
to ensure the remaining model components are not adversely affected. 

  

See also: 

Edit Properties for Component 
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Edit Properties for Component 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

This dialog allows you to edit properties for a single model component. In addition, you can 
select and edit the properties for each detail of the component. Component details vary 
depending on the type of component. 

A tree showing the component and its details is displayed on the left side of the dialog. 
Initially, the component itself is selected, and the list on the right shows the properties of 
that component. 

When you click one of the details in the tree on the left, the properties for that detail will 
appear. See Edit Properties for Detail for more on this topic. 

Component State: 

This checkbox shows the current state of the component.  

Name: 

This edit box displays the name of the component. It can be edited by clicking inside the edit 
box and typing new text. 

Type: 

This drop-down list displays and selects the type of mathematical expression used for this 
component. Changing the type may also change the details, shown in the tree on the left of 
the dialog. See Model Descriptions for details on each model component type. 

Associated range: 
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This drop-down list displays and selects the model range, if any, used to provide estimates to 
this model component. In most cases, ranges identify peak locations. They appear on the 
histogram when you click the Range button on the toolbar, or select Position ranges from the 
Analysis menu. If a component is not associated with a range, the selection will display "No 
range". 

Number of compartments: 

This list selects the number of sub compartments for the component. Some components, like 
the Polynomial, do not support more than one compartment. Setting this to 0 will disable the 
component. 

Color: 

Click this button to display the standard color selection dialog and choose a new color for the 
component. 

Fill Style: 

This list contains graphical fill options to use when drawing the component. Using a fill 
pattern allows an additional degree of transparency to overlapping components, in some 
cases, making it easier to review the model.  

Transparency: 

This option determines whether the component coloring will be transparent or not. 

Generate Debris: 

Enable this option if the population associated with the component contributes to debris in 
the sample. The debris modeling uses this to determine the expected shape of debris. 

Generate Aggregates: 

Enable this option if the population associated with the component contributes to aggregates 
in the sample. The aggregate modeling uses this to determine the expected shape of 
aggregates. 

  

OK: 

Click this button to accept the changes and close the dialog. 

Cancel: 

Click this button to cancel changes and close the dialog. This button may be disabled if 
changes are made that cannot be cancelled. 

Help 

Click this button to display online help for this topic. 
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Edit Properties for Detail 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

This dialog allows you to edit the properties of a model component detail. The details of a 
component will depend on the particular component type. The properties of each detail 
define how the detail is related to other component details, how it is computed, and the 
source of its estimates. See Edit Properties for Component for additional information. 

Dependency: 

This option determines how the detail is computed. Floating means that the modeling 
process will adjust the detail to find the best value. Floating details are commonly used for 
means and standard deviations of well-defined peaks modeled with Gaussian component. 
Dependent details are computed directly by applying a multiplicative and/or additive factor to 
the value of the controlling detail. Fixed details are not adjusted during the modeling 
process; their values are determined either by a static value or from a range estimate. 
Interpolate can be selected to compute the value of the detail by interpolation. It is only 
applicable to standard deviation details. An example best describes the use of this option. 
Suppose you have a model that describes a diploid population. Now suppose there is an extra 
peak in S-Phase that you believe should be broadened in the same way as the S-Phase is 
broadened. You would choose Interpolate for the standard deviation of the extra peak, and 
make its controlling component and detail the S-Phase lower standard deviation. The upper 
boundary of the interpolation is automatically the upper standard deviation. 

Controlling component: 

If Dependent or Interpolate is selected as the Dependency option, the controlling component 
determines what model component this detail is dependent upon. You must also select a 
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Controlling detail (below) to complete the dependency. If the Dependency option is Floating 
or Fixed, the controlling component is ignored. 

Controlling detail: 

If Dependent or Interpolate is selected as the Dependency option, the controlling detail 
determines the detail of the Controlling Component on which this detail depends. If the 
Dependency option is Floating or Fixed, the controlling component is ignored. 

Multiplicative factor: 

If Dependent is selected as the Dependency option, the final value of the controlling 
component's detail is multiplied by the multiplicative factor. As an example, the G2M 
component's mean position is often made dependent on the G1 component's mean by a 
factor of 2. 

Offset: 

If Dependent is selected as the Dependency option, this value is added to the final value of 
the controlling component's detail, after it has been multiplied by the multiplicative factor.  

Estimation: 

This drop down provides choices for the source of the estimate for the detail. Outside-in and 
Inside-out draw the estimate from simple statistics performed before the modeling process. 
Range draws the estimate from a range associated with this component. User-entered 
estimate uses the value entered in the Estimated value field as the source of the estimate. 

Estimated value: 

This field displays the estimate that was used for the detail when the model was last run. If 
Estimation is set to User-entered estimate, the value will not be adjusted. In all other cases, 
the value may change each time you choose Fit, depending on how the details dependencies 
are set. 

Final value: 

This read-only field displays the result of the last modeling process for this model. 

  

OK: 

Click this button to accept the changes and close the dialog. 

Cancel: 

Click this button to cancel changes and close the dialog. This button may be disabled if 
changes are made that cannot be cancelled. 

Help 

Click this button to display online help for this topic. 
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Edit Ranges 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

This dialog allows you to add, delete, and edit ranges of the model. Ranges are graphical 
elements that you can position on the histogram. They are used to supply estimates to model 
components. 

Range names can be edited by clicking slowly once on the name, then clicking again. The list 
item will enter edit mode; press the Tab key or click another item to accept the revision. See 
Edit Properties of Range and Edit Properties for Component more on this topic. 

  

OK: 

Click this button to close the dialog and accept the changes. 

Help: 

Click this button to display online help for this topic. 

Properties: 

This button is enabled when one of the list entries is selected. Clicking the button will display 
the edit properties dialog for the selected item. 

Delete: 

Click this button to delete the selected range. If components are dependent on the deleted 
range, they will become inactive. Use great care when deleting range to ensure model 
components are not adversely affected. 
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Properties: 

This button is enabled when one of the list entries is selected. Clicking the button will display 
the edit dialog for the selected item. 
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Edit Properties of Range 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

This dialog allows you to edit the properties of a model range. Ranges are graphical elements 
that you can position on the histogram, used to supply estimates to model components. 

  

Label: 

This edit box displays the name of the range. It can be edited by click inside the edit box and 
typing new text. 

Active: 

When checked, the range is displayed on the histogram (in Range view) and it can be used 
as an estimation source for model details. When unchecked, the range will not be displayed 
and any components that use the range will be deactivated. 

Left: 

The edit box shows the location of the left side of the range. You can edit the field manually, 
or position the range graphically to change the value. To display ranges, click the Range 
button on the toolbar, or choose Position Ranges from the Analysis menu. 

Width: 

The edit box shows the width of the range. The right side of the range is positioned at Left 
plus this value. 

Y Position: 

This value determines the vertical location of the range label. The value is a percentage of 
the Y scale. 
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Color: 

Click this button to display the standard color selection dialog and choose a new color for the 
range. 

Type of estimate: 

There are three types of range estimates: Gaussian, Debris and Aggregate. Most ranges are 
Gaussian type, used to identify peaks in the histogram. There is typically only one Debris 
estimate range in a model, used by the AutoDebris component for estimation of the debris. 
The Aggregate estimate can be associated with the AutoAggregate component, but is 
typically not used. 

Auto-position to: 

In most models, the ranges are positioned and sized by the user for manual 
analysis.  Automatic analysis positions ranges based on the peaks it finds in the 
data.  However, you can create your own custom models, too, and for those models you can 
tell ranges how to position themselves. 

The peaks that are considered by the auto-positioning logic are those that show a black 
triangle on the main histogram. 

  

 

  

No peak: This turns off auto-positioning and leaves the range where it is. 
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Closest peak:  Moves the ranges to the closest peak. 

Dimmest peak:  Moves the ranges to the dimmest peak. 

Brightest peak:  Moves the ranges to the brightest peak. 

Largest peak:  Moves the ranges to the largest peak (by area). 

Smallest peak:  Moves the ranges to the smallest peak (by area). 

Tallest peak:  Moves the ranges to the tallest peak. 

Shortest peak:  Moves the ranges to the shortest peak. 

  

OK: 

Click this button to accept the changes and close the dialog. 

Cancel: 

Click this button to cancel changes and close the dialog. This button may be disabled if 
changes are made that cannot be cancelled. 

Help 

Click this button to display online help for this topic. 
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Edit Analysis Results 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

This dialog displays the list of analysis results that are computed for the current model.  Each 
item in the list has a Result Name and a Result Equation. The equation uses ModFit LT's 
equation syntax to compute the results. 

For models that are created by ModFit LT's Auto Analysis, Choose Model, Sync Wizard, and 
Cell Tracking Wizard, there is little need to edit the Analysis Results. The main use for this 
dialog is for models that you design yourself from scratch, or models you customize from a 
ModFit LT model. 

The items in this list are available for databasing as well as being added to the report. 
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Edit Properties for Analysis Result 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

This dialog is used to edit an Analysis Result.  It allows editing of the Result Name and the 
Result Equation. 

See Equation Syntax for details on writing equations. 
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Edit Report Results 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

  

This dialog allows you to edit the equations used to display results on the report. 

You can edit equations by selecting an item in the list and clicking Properties. Alternately, you 
can edit an equation directly by clicking once slowly to select the equation, then clicking 
again to enter edit mode. To leave edit mode, press the Tab key or click another item in the 
list. 

Properties: 

This button is enabled when one of the list entries is selected. Clicking the button will display 
the edit properties dialog for the selected item. 

New: 

Click this button to add a new equation. The new equation will be added to the end of the 
list, and can be selected for editing. 
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Delete: 

Click this button to delete the selected equation. Be careful when deleting equations that 
contain "T[n]" expressions, where n is an integer. These equations compute temporary 
variables used by other equations; the other equations may fail if they make use of a deleted 
expression. 

OK: 

Click this button to close the dialog and accept the changes. 

Help: 

Click this button to display online help for this topic. 
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Edit Properties of Report Result 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins and ModFitEditors have permission to 
perform them. 

  

 

  

This dialog allows you to edit an equation for a line of results that appears on the report. 

Equation: 

Type or edit the equation expression.  See Equation syntax for details. 

Equation syntax 

  

ModFit equations are expressions that are compiled by the program and evaluated each time 
the model is analyzed. Equations can contain literal text, keywords from the FCS file being 
analyzed, and symbols that provide access to the computed results of the analysis. 
Mathematical operations include addition, subtraction, division, and multiplication, grouping 
of operations using parentheses, and use of build-in functions. 

  

Strings 

String literals are enclosed in quotation marks. 

Example equation: "This is text." 

Report output: This is text. 

  

Keywords: 
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Keywords can be draw from the FCS file and from internally computed values. Keywords are 
enclosed in square brackets. 

FCS keywords vary from file to file, and are generally created by the software that was used 
to acquire the data file. 

Internal keywords include the following: 

[DATE] displays date of analysis. 

[TIME] displays time of analysis. 

[FILE] displays name of data file analyzed. 

[REPORT] displays name of report. 

[AUTONAMEREPORT] displays name generated by AutoNameReport. 

[MODEL] displays the name of the model. 

[ANALYSIS] displays the type of analysis performed, e.g. Automatic, 
Manual. 

[RCS] displays the reduced chi-square value from the last fit of 
the model. 

[GATE1] displays name of gate one, or "Off" if no gate 

[GATE2] displays name of gate two, or "Off" if no gate 

[GATE3] displays name of gate three, or "Off" if no gate 

[FILEPATH] displays full path to data file. 

[MODELPATH] no longer supported 

[REPORTPATH] displays full path to the report 

[VERSION] displays the internal version of the program 

[LINEARITYFACTOR] displays the configuration setting for linearity 

[EXTREFMEAN] displays the value for the External Reference Mean 
position from the Auto Analysis Settings dialog. 

[DIPTOSTDRATIO] displays the value for the Diploid-to-Standard Ratio from 
the Auto Analysis Settings dialog. 

[RANGEnNAME] displays the name of range with ID of n 

[RANGEnLEFT] displays the left channel position of range with ID of n 

[RANGEnRIGHT] displays the right channel position of range with ID of n 
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Example equation: "Today is ";[DATE] 

Report output shows date of analysis (for example): Today is 28-Feb-2022 

Example equation: [RANGE4NAME] 

Report output shows name of range with ID of 4: "Dip G1" 

  

Internal functions 

Internal functions are used to gain access to component details, areas, and other computed 
values. Below is a table describing each function. Note that component and compartment 
indexing start at zero (0). 

Function Description 

A[m, n] Returns the area of component m, compartment n. To return the 
area of all compartments for a component, use an asterisk (*) for n. 
To return the area of all components, use an asterisk for m. 

M[m, d] Returns the value of detail d for model component m. 

T[n]=equation Sets the value of temporary variable n to the expression in equation. 
After setting a temporary variable, you can use the variable without 
the "=equation" portion to return the value of the equation. 

T[n] Returns the value stored in temporary variable n. 

P[n] Set the floating-point precision for the rest of the equation to n 
decimal places. 

Y[m, start, end] Returns the portion of the area of component m that falls between 
channels start and end. 

S[start, end] Returns the sum of events between channels start and end. 

U[start, end] Returns the mean between channels start and end. 

H[ ] Returns the mean of the highest active cycle component. NOTE: 
There is no space between the open and close square brackets. 

F[expression] Returns the value of a keyword converted into a floating-point 
number. This allows the keyword to be used in calculations. 

For example, the $P1B keyword stores the number of bits used to 
store a value for parameter 1 in an FCS file. To compute the number 
of bytes used by parameter 1, the following equation could be used: 
"Parameter 1 bytes = ";F[[$P1B]]/8 
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Mathematical operations 

The following operations are supported. 

Operation Usage 

Addition Use the plus symbol (+) between numeric values. 

Multiplication Use the asterisk (*) between numeric values. 

Subtraction Use the minus symbol (-) between numeric values. 

Division Use the slash (/) between numeric values. 

Grouping Use parentheses to group mathematical operations. 

  

Concatenation 

Equations can contain multiple elements separated by a semi-colon (;). 
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Help 

Updates 

 

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

  

This command is found on the Help tab of the ribbon bar.  In the menu & toolbar interface, 
the command is in the Help menu. 

Use this command to check the Verity Software House web site for program updates. It will 
launch your default browser and display a list of available updates for the version you are 
running. 

Ask Tech Support 

 

This command interacts with your email application to create a new message to Verity 
Software House Tech Support. A new message is created to the Tech email address and 
some information about your application in the body of the email. 

Fill in the email message with your contact information and the questions you want to ask. A 
member of the Tech Support team will respond to your question as quickly as possible. 

Make a Suggestion 

 

This command interacts with your email application to create a new message to Verity 
Software House Tech Support. A new message is created to the Tech email address and 
some information about your application in the body of the email. 

We value your suggestion very highly, and make every attempt to incorporate changes into 
the software that address suggestions from our clients. 

Fill in the email message with your contact information and your suggestion for the program. 
A member of the Tech Support team will respond to your email as quickly as possible. 
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Report a Problem 

 

This command interacts with your email application to create a new message to Verity 
Software House Tech Support. A new message is created to the Tech email address and 
some information about your application in the body of the email. 

When reporting a problem, please try to include as much detail as possible about the 
conditions that caused the problem. If at all possible, please try to reproduce the problem 
and list the steps that will cause it to occur. While it is sometimes possible to correct 
problems that are not reproducible, it is much more likely that we can fix a problem that we 
can reproduce. 

A member of the Tech Support team will respond to your email as quickly as possible. 

Application Info 

 

This command displays a dialog that contains information about the program and its 
installation. It is useful when interacting with tech support. 
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User Guide 

 

Use this command to display the User Guide in your browser. 

About command 

 

Use this command to display the About dialog box. 
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Appendices 
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Analysis Results 

  

This section describes the results that are displayed by ModFit LT after an analysis has been 
performed. The results are usually displayed on the upper right side of the report, although 
you can move the results to anywhere on the report. 

There are several types of models available in the program, each with its own set of results. 
Standard models are created by Automatic Analysis and by choosing a model for manual 
analysis. These models include components and results for debris, standards, aggregates, 
and apoptosis, as well as for one or more cycling populations. For each of the cell cycles, a 
G0G1, G2M, and S-Phase component is included. 

Sync Wizard models are created when using the Sync Wizard. These models are designed for 
the special demands of perturbed cell cycle analysis. 

The Cell Tracking Wizard creates Cell Tracking Wizard models. These models are used to 
study cell proliferation in samples using cell-tracking dyes and proliferation markers. 

The program calculates percentages based on the number of events that are actually 
modeled. The number of events modeled can be less than the total number of events in a 
sample if you apply a gate, scale the data to eliminate events, or if the model itself does not 
fit the data exactly. Suppose, for example, that a listmode file contains 10,000 events. If you 
gate out 10% of the events, the analysis will be performed on 9,000 events, or 90% of the 
total events. 

Standard Models 

Label 
Description 

Model This shows the name of the model used for the analysis.  For information 
on how to decode model names, see Model Descriptions. 

Analysis type: This will show either "Automatic analysis" or "Manual analysis", depending 
on how the model was selected and whether any user-edits were made to 
the model set up. 

Auto Linearity This will show "Yes" if Auto Linearity was performed, or "No" if it was not. 

Ploidy Mode Displays the Auto Analysis Diploid Determination setting. 

Diploid 
Reference 

If the Diploid Determination setting is External Reference, Based on 
Standard 1, or Based on Standard 2, this result will display the location of 
the ploidy reference. 
If First Cycle is Diploid mode, this result is meaningless and is not 
displayed. 

% Cycle Percent of all events that are associated with cycling populations 

%G0G1 G0G1 as a percent of all cells in that cycle 

G0G1 mean G0G1 mean channel 

%G2M G2M as a percent of all cells in that cycle 

G2M mean G2M mean channel 

% S-Phase S-Phase as a percent of all cells in that cycle 

G2/G1 ratio Ratio of G2 mean channel to G1 mean channel 
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%CV Coefficient of variation for G0G1 cells 

DI DNA Index, defined as the mean channel of G1 cells of an aneuploid 
population compared to Diploid G1 mean channel. 

DI based on 
reference 

If the Diploid Determination setting is External Reference, Based on 
Standard 1, or Based on Standard 2, this result will display the DNA index 
based on the computed reference position for the Diploid G1. 

    

Total Aneuploid 
S-Phase 

Sum of all Aneuploid S-Phase areas as a percentage of the total (G1G1 + 
S + G2M) area for all Aneuploid populations. This result is not displayed 
for Diploid models. However it is computed as a keyword even for Diploid 
models. For Diploid models, the "tumor" S-Phase is considered to be the 
Diploid S-Phase, and so the keyword reports the S-Phase of the Diploid. 

Total S-Phase Also called "Average S-Phase". Sum of all S-Phase areas as a percentage 
of the total area for cycling cells of all populations. 

Total B.A.D Amount of debris and aggregates found within the region between the 
first G1 and the last G2 peak. 

    

Standards   

Stnd % Area of standard as a % of all modeled events minus debris 

Stnd mean Mean channel position of standard 

DI DNA Index of standard as standard mean channel relative to the Diploid 
G1 mean channel. 

Dip G1 Ratio Diploid G1 mean channel divided by mean channel of the standard 

%CV Coefficient of variation for standard 

    

%Debris Debris area as a % of all modeled events 

%Aggregates Aggregate area as a % of all modeled events 

%Apoptosis Apoptosis area as a percent of all modeled events minus debris 

Modeled events Number of events accounted for by all components in the model 

All cycle events Number of modeled events in the G0G1, G2M, and S-Phase components of 
all cycling populations 

Cycle events 
per channel 

All cycle events divided by the number of channels between the first G0G1 
and the last G2M of the model. 

nRCS Normalized reduced chi-square, a measure of goodness of fit. This 
produces an RCS equivalent results as if the sample file contained 10,000 
events. 
See Options and Configuration for more information on this statistic. 

RCS Reduced chi-square, a measure of goodness of fit. Values from 1.0 to 3.0 
are good, 3.0 to 5.0 are fair, and greater than 5.0 are poor.   
Note, RCS will increase as the number of events in the sample file 
increase.  The nRCS can be used in cases where samples routinely have 
50,000 or more events. 

  

Tetraploid Model 
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ModFit LT handles Tetraploid histograms slightly differently than most other ploidy types. 
Because the Diploid G2M and the Tetraploid G1 peaks are superimposed, the program 
disables the Diploid G2M during the modeling process. After the model has been applied to 
the histogram using the Fit with Current Model command or Auto Analysis, the program will 
add back a specified amount to the Diploid G2M and reduce the Tetraploid G1 by the same 
amount. This amount is computed as a percentage of the Diploid G1 peak, and the 
percentage is specified in the Options and Configuration dialog box. The default percentage 
is 8% (0.08). 

  

Sync Wizard Model 

In addition to many of the results described for standard models, the Sync Wizard also 
computes the percentage for sub-compartments of S-Phase 

Result Computation 

S-Phase Cells in S-Phase as a percent of all the cells in that cycling population 

Compartment 
n 

Area of S-Phase sub compartment as a percent of all the cells in that 
cycling population 

  

Cell Tracking Wizard Model 

See the Cell Tracking Example for an explanation of Cell Tracking results. 
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Keywords 

This section lists and describes the keywords that are created by ModFit LT. These keywords 
can be selected for display on reports using the Keywords command in the Tools menu, and 
can be stored in a database as well. 

Some keywords are available only when the conditions they relate to exist. For example, 
keywords related to a second DNA Aneuploid population will only be available if the model 
that is used contains components for a second Aneuploid cycle. 

NOTE: The keywords for second, third, and fourth aneuploid cycles are identical to those for 
the first, except that they are prefixed with Z_An2, Z_An3, and Z_An4 instead of Z_An1. 

  

Standard Model 
Keywords 

Comment 

Z_Aggregates % aggregates 

Z_AllCycleEvents Sum of events in cycles 

Z_An1 % events in first aneuploid cycle 

Z_An1_BAD % BAD in first aneuploid cycle 

Z_An1_CV % CV for first aneuploid cycle G1 

Z_An1_DI DNA index of G1 in first aneuploid cycle 

Z_An1_G1 % of first aneuploid cycle in G1 

Z_An1_G1_Mean Mean of G1 in first aneuploid cycle 

Z_An1_G2 % of first aneuploid cycle in G2 

Z_An1_G2_Mean Mean of G2 in first aneuploid cycle 

Z_An1_G2G1Ratio G2/G1 ratio for first aneuploid cycle 

Z_An1_Ploidy Ploidy of first aneuploid cycle 

Z_An1_S % of first aneuploid cycle in S-Phase 

Z_AneuploidS_Bnd S-Phase assessment cut-off value 

Z_AneuploidS_Class S-Phase assessment classification 

Z_AneuploidS_PValue S-Phase P-value 

Z_AneuploidS_Std S-Phase assessment standard deviation 

Z_CycleEventsPerChannel Average number of events per channel in cycles. 

Z_Debris % debris 

Z_Dip % events in diploid cycle 

Z_Dip_BAD % BAD in diploid cycle 

Z_Dip_CV % CV for diploid cycle G1 

Z_Dip_G1 % of diploid cycle in G1 

Z_Dip_G1_Mean Mean of G1 in diploid cycle 

Z_Dip_G2 % of diploid cycle in G2 

Z_Dip_G2_Mean Mean of G2 in diploid cycle 

Z_Dip_G2G1Ratio G2/G1 ratio for diploid cycle 

Z_Dip_Ploidy Ploidy of diploid cycle 

Z_Dip_S % of diploid cycle in S-Phase 

Z_DiploidS_Bnd S-Phase assessment cut-off value 
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Z_DiploidS_Class S-Phase assessment classification 

Z_DiploidS_PValue S-Phase P-value 

Z_DiploidS_Std S-Phase assessment standard deviation 

Z_LinearityFactor Linearity value used in the model 

Z_MAE Mean Absolute Error 
For details, see 
https://en.wikipedia.org/wiki/Mean_absolute_error 

Z_ModeledEvents Number of events accounted for by the model 

Z_nRCS Normalized RCS value, which is the RCS computed 
on the area normalized to 10,000 events. 

Z_PloidyStatus S-Phase assessment ploidy 

Z_RCS Reduced chi-square 

Z_RMSD Root Mean Square Deviation.   
For details, see 
https://en.wikipedia.org/wiki/Root-mean-
square_deviation 

Z_Stnd1 % of events in first internal standard 

Z_Stnd1_DI DNA Index of first standard 

Z_Stnd1_DipG1Ratio DipG1 mean/First Std mean 

Z_Stnd1_Mean Mean of first standard 

Z_Stnd2 % of events in second internal standard 

Z_Stnd2_DI DNA Index of second standard 

Z_Stnd2_DipG1Ratio DipG1 mean/Second Std mean 

Z_Stnd2_Mean Mean of second standard 

Z_TotalAneuploidFraction Percentage of cells in aneuploid cycles 

Z_TotalAneuploidS (Sum all aneuploid S-Phase areas)*100/(Sum all 
aneuploid areas). For simple Diploid models, the 
keyword reports the value of Diploid S-Phase. You 
may think of this keyword as "tumor S-Phase." 

Z_TotalBAD % BAD for histogram 

Z_TotalS Average or total S-Phase 

Z_TotalS_Bnd S-Phase assessment cut-off value 

Z_TotalS_Class S-Phase assessment classification 

Z_TotalS_PValue S-Phase P-value 

Z_TotalS_Std S-Phase assessment standard deviation 

  

The following keywords store configuration values used by the program. The Auto Analysis 
Settings, Peak Finder Settings, and Options and Configuration dialog boxes set these values. 

  

Configuration Keywords Comment 

CF_APOPTOSIS Auto Analysis state for apoptosis 

CF_AUTOAGGREGATE Auto Analysis state for AutoAggregates 

CF_AUTODEBRIS Auto Analysis state for AutoDebris 
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CF_MOD_S_COMPARTMENTS Number of S-Phase compartments in this 
model 

CF_MOD_S_SHAPE Shape of S-Phase in this model 

CF_G2G1RATIO Auto Analysis state for linearity or G2/G1 
ratio 

CF_PLOIDY_DIP_STD_RATIO Auto Analysis state for diploid-to-
standard ratio 

CF_PLOIDY_MODE Auto Analysis state for ploidy detection 
mode 

CF_SPHASE_COMPARTMENTS Auto Analysis state for number of S-
Phase compartments 

CF_SPHASE_SHAPE Auto Analysis state for shape of S-Phase 

CF_SPHASE_DI_THRESHOLD Auto Analysis state for DI for S-Phase 

CF_TET_RANGE Auto Analysis state for Tetraploid range 

CF_PF_STATE State for Peak Finder 

CF_PF_RISE Peak Finder setting for rise 

CF_PF_LOWCV Peak Finder setting for low CV 

CF_PF_HIGHCV Peak Finder setting for high CV 

CF_PF_CC Peak Finder setting for correlation 
coefficient 

CF_PF_PCNTSTART Peak Finder setting for starting threshold 

  

MF keywords 

Internal keywords are prefixed with "MF_" and store data computed by the program. They 
are listed in the table below. 

Internal Keywords Comment 

MF_ANALYSIS Type of analysis performed 

MF_AUTODEBRIS_FIRSTCUT Setting for AutoDebris first cut 

MF_AUTODEBRIS_RESOLUTION Setting for AutoDebris resolution 

MF_AUTODEBRIS_SECONDCUT Setting for AutoDebris second cut 

MF_AUTODEBRIS_THIRDCUT Setting for AutoDebris third cut 

MF_DATE Date of analysis 

MF_FILE Full path name of the data file 

MF_FILEPATH Pathway to the data file 

MF_GATE1 Parameters for gate 

MF_GATE1_PERCENT Percent of events in gate 

MF_GATE2 Parameters for gate 

MF_GATE2_PERCENT Percent of events in gate 

MF_GATE3 Parameters for gate 

MF_GATE3_PERCENT Percent of events in gate 

MF_MODEL Name of the model used in analysis 

MF_PLOIDYINDEX 0=Diploid, 1=Tetraploid, 2= One 
Aneuploid, 3=Two Aneuploid, etc. 
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MF_RCS Reduced chi-square 

MF_REPORT Name of the report 

MF_REPORTPATH Pathway to the report 

MF_TIME Time of the analysis 

MF_VERSION Version of the program 

  

USER keywords 

These keywords show the results of user-entered equations found in Options and 
Configuration dialog. The name for the keyword is prefixed with "USER_". This allows you to 
display and database results of user-entered equations. 

  

C keywords 

Keywords that begin with "C_" display the final value for a detail of a model component. The 
naming convention starts with "C_", followed by the name of the component, an underscore, 
and the name of the detail. For example, "C_An1 G1_Area" displays the area of the An1 G1 
component. 

  

Sync Wizard keywords 

When using the Sync Wizard, several additional keywords are made available. These allow 
you to extract the percentage of each compartment used in modeling S-Phase. If, for 
example, you use 3 rectangles to model S-Phase, you will find three additional keywords: 
Z_DIPS_C1, Z_DIPS_C2, Z_DIPS_C3. 

  

Proliferation Wizard keywords 

When using the Proliferation Wizard, additional keywords are available to allow you to display 
and database all of the information generated by the wizard. These keywords are prefixed 
with "Z_PROLIF", and are named to indicate the value that it stores. 
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Database 

  

Research and Compliance Mode note: 
In RUO mode, all users can create and edit databases. 
In Compliance mode, databases can only be created and edited by ModFitAdmins 
and ModFitEditors. 

This section introduces the concepts and functions of ModFit LT's database features. It is 
more of a discussion than a tutorial, however there are examples to clarify some aspects of 
the system. 

ModFit LT has a simple, powerful database engine that allows you to store large amounts of 
data easily in one or more database files. You can view databases from within the program, 
manually add, delete, and replace records, and select the fields you want to store in each 
database. The databases are created in a simple, text format known as tab-delimited text, 
which can be read by common database and spreadsheet programs. These features give you 
a great deal of flexibility in choosing what information to store, where to store it, and how to 
integrate the information into other database and information systems. 

When you create a new project in ModFit LT, the program automatically creates a database 
file for the project. 

  

How do you create a database? 

It is best to run an analysis of a data file before you create or edit a database. Open one of 
your data files and perform an Auto-Analysis. This will fill the program with the information 
you can choose to store in your database. You can set up a separate database for each kind 
of analysis you do, one database for everything you do with the program, or anything in 
between. 

The fastest way to create a database from your results is to use the Database Wizard, 
found on the Edit tab of the ribbon.   

 

The wizard helps you to select a database (or create a new one) and it adds fields for all of 
the results that are shown on the current report.  This is by far the fastest and easiest way to 
set up a database. 

If you want to select additional fields or have greater control over the database structure, 
you can click the Databases on the Edit tab of the ribbon.  The Edit All Databases dialog 
will display. 
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There is one database created by the program automatically. This database will not store 
anything until you tell the program what information you want to save in the database. To do 
so, you need to select the database in the list and click the Edit button. You can also double-
click the item in the list to do this. 

 

  

The Edit Keyword Map dialog is displayed. The left side of this dialog presents the 
information available to store, and the database fields are shown on the right. Initially, the 
right-hand list is empty. 

  

What can you store in the database? 

ModFit LT allows you to database virtually any statistic it generates, as well as keyword 
information from the files that you analyze. The tree on the left of the dialog can be 
expanded to display branches of keywords. To open or close a branch of the tree, double 
click the label or click the arrow next to the label. Each branch of the tree contains a set of 
related keywords. 
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To add an item to your database definition, select it in the tree on the left and click the Add 
button. A field will be appended to the database. You can also select more than one Keyword 
at a time and click Add to create multiple fields at once. 

 

  

The field names initially assigned when you click the Add button are based on the keyword 
added. 

 

  

You can edit the names for the fields after they are added to the list, if you wish. To do so, 
click once on the field name to select it, then after a brief pause, click slowly again. An edit 
control will appear around the field name, allowing you to type a new name for the field. You 
can also use the Tab key to move from one field to the next if you need to edit the names of 
several fields. 

To remove one or more fields from the database, select the fields in the list and click the 
Delete button. 
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To replace an existing field with a new keyword, select the new field in the Keywords list and 
the one to replace in the list. Then, click the Replace button. The name of the field will not 
change, only the keyword used to evaluate the field. 

To change the order of fields in the database, select one or more fields in the list and then 
use the Up and Down buttons to move the fields. 

When you have finished selecting information to store in the database, click the OK button to 
close the Edit Keyword Map dialog. 

  

What files are created? 

When you create a project in ModFit LT, there is a database created automatically for the 
project.  It is located in the Database folder of the project, and the project it typically created 
in the user's Documents\ModFit LT\Projects folder. 

You can also create databases outside of a particular project. This are stored in the location 
shown in the table below. You can choose another location, as long as you have read/write 
permissions to that folder. 

Operating System Default Location 

Windows C:\Users\[user name]\Documents\ModFit LT for Windows 

MacOS [user name]/Documents/ModFit LT for Mac 

  

A file is created to store a "map" of keywords to database fields. The map file name uses the 
name of the database object and appends ".map" to it. For "Database1", the map file is 
named "Database1.map". 

Next, the program creates the actual database file. This is the tab-delimited, ASCII text file 
that you may open in other database or spreadsheet programs. The database file name uses 
the database object name and appends ".txt" to it. This file is readable in virtually any 
program that can open unformatted text. The first line of the file contains the names of the 
fields separated by tabs; it is known as the database header or definition. Each subsequent 
line contains a record of information. 

If the database had been created previously, ModFit LT will automatically create a backup of 
the database before overwriting the existing one. The backup file will have the same name as 
the database, with "backup" appended to it. 

Finally, the program creates a text file called a "key" file. This is a text file that explains the 
database and mapping files. You can open this file in a text editor to review the structure of 
the database you have created. Its name is based on the database object name, with 
"key.txt" appended to it. 

  

How do you activate the database? 
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Once a database has been defined, there are several additional properties you can specify. 
These properties determine whether the database is active, whether it will prompt you before 
saving a record, whether or not you want to see the records in a database viewer, and where 
you want to store the database. 

To edit these properties for a database, select the database in the Edit All Databases 
dialog box and click the Properties button at the bottom of the dialog. The Edit Properties 
for Database dialog will be displayed. 

 

  

The properties are enabled or disabled with simple check boxes. If you create a database 
outside of a project, there are several additional actions in this dialog.  You can use the 
Choose button to use an existing database that you have defined previously. You can 
change the location of the database using the Path button. 

In order to store records of information in a database, it must be "active". To make a 
database active, check the Active checkbox in the Edit Properties dialog. Database records 
are saved after Automatic Analysis or Execute Model commands are performed. Additionally, 
you can save a record at any time by clicking the "+" button on the database viewer. 

If the Prompting checkbox is checked, ModFit LT will display a message each time it is 
about to save a record to the database. You can choose at that time whether or not you 
want to save the record. If Prompting is disabled, the database will save a record without 
prompting. 

To view the database while you work with ModFit LT, check the Viewer checkbox. A 
database viewer window will be created and displayed. The database viewer can be moved, 
resized, and scrolled horizontally or vertically. It has a toolbar that provides some additional 
manual database functions. See the topic Database Viewer for more information. 

The size of the font used for the database viewer can be set with the Viewer font property. 



ModFit LT™ User Guide 

© 2022 Verity Software House.  All rights reserved.    Page 288 

To select an existing database on disk, click the Choose button. A file selection dialog box 
will appear, allowing you to navigate to the existing database and select it. Linking to an 
existing database will rename the database in memory to match the one selected on disk, 
and the associated database map on disk will be loaded as well. 

To change the location of a database, click the Path button. A path navigation dialog will 
appear. Navigate to the new location. 

  

How do you rename or create additional databases? 

To rename a database, display the Edit All Database dialog box by selecting Edit Databases 
from the Edit menu. Select the database you want to rename and click Properties. You can 
then edit the name for the database.  Note, you cannot edit the name of a project database. 

If a file with the new name already exists, you will be given a chance to overwrite the 
existing file, use the existing file, or cancel the operation. 

When you want to create an additional database, click the New button. This will create an 
empty database with a new name. 

Each database has its own map of keywords to fields, and its properties determine whether it 
is active, prompting, and showing a viewer. 

  

Errors with databases 

Since the database system involves creating and manipulating files on disk, there are 
conditions where errors can occur. If, for example, one of the critical database files is moved 
or deleted, the program will not be able to use the database. When the program runs into a 
problem like this, it displays a dialog box of choices. 

When you see this dialog, it means that the database "txt" file and the "map" file are out-of-
sync with one another. They may have a different number of fields, a different order, 
different fields defined, or one of the files may be missing.  

If you choose the first option, Use the database and manually create a new map, the 
map file is emptied and partially recreated with the fields defined in the database header. In 
this case, you need to recreate the keyword-to-field "map" using the Edit Keyword Map 
dialog.  

If you choose the second option, Use the map file and DESTROY the database, all 
records in the database txt file are emptied and a new "header" is written into it to match the 
database map file. 

The third option, Cancel and de-activate the database,  leaves the map and the txt files 
out-of-sync and deactivates the database, allowing you to investigate the problem before any 
action is taken. 

  

See also: 
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Edit Databases 

Edit Keyword Map 

Edit Properties for Database 

Database Viewer 
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Histogram and S-Phase Assessment 

  

ModFit LT contains two systems to evaluate confidence in the S-Phase estimates it computes. 
The first method evaluates several histogram features that have been published as affecting 
S-Phase accuracy (Cytometry. Vol. 14. Number 5, 1993.): %CV, Cell Number and %B.A.D. 
The Prout's Neck DNA Consensus Conference published a set of guidelines for these 
histogram attributes and ModFit LT uses these published guidelines to provide you with a 
graphical and quantitative picture of how the histogram satisfies the requirements. By 
pushing the button next to each of these features you can examine the actual published 
quote. 

ModFit LT evaluates an additional feature not covered by the Consensus Conference: RCS. 
Reduced Chi-square is a measure of how well the model fitted the data. Based on our 
experience with RCS values, we added our own guidelines for this feature. 

The second method of S-Phase assessment is unique to ModFit LT and is based on a 
statistical approach to the problem rather than a consensus of experiences. By using 
established statistical methods, ModFit LT calculates the error probability distribution about 
each of its S-Phase estimates (e.g. Total or Average S, Aneuploid S, and Diploid S). The 
standard deviation of this probability distribution provides a direct quantifiable way of 
evaluating the confidence of a given S-Phase estimate. If you are getting glassy-eyed on this 
statistical stuff, let us show you four graphs that will make it crystal clear how this system 
works. The first graph demonstrates how cell cycle programs used to work. 

 

Let's say that your old cell cycle program reported a Total (average) S-Phase estimate, also 
known as "Average S-Phase", of 20.5%. Since the program did not give you any information 
on the variability associated with this estimate, you had to assume that it was correct. 
Another way of saying the same thing is that the probability of the Total S-Phase being 
20.5% was assumed to be unity or one. Largely because of this limitation, a number of S-
Phase criteria were developed that normally would be conducive to obtaining accurate S-
Phase estimates (cell number>10,000, %CV<8.0, etc). 

ModFit LT has an exclusive statistical method of estimating the probability distribution about 
each of its S-Phase estimates. Let's take a look at how that changes our figure. 
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Since ModFit LT calculates the probability distribution about its estimate, you now have a way 
of quantifying the S-Phase estimate's variability with a standard deviation. Rather than 
20.5% in this example, you now know that it is really 20.5% +/- 1.2%.  However, ModFit LT 
takes this S-Phase assessment one step further. By evaluating S-Phase cutoffs against this 
probability distribution, the program can calculate the probability of the estimate being in a 
particular category (e.g. Low, Intermediate, or High). Let's look at the next graph to see how 
this works. 

 

The areas of the probability distribution between each of the S-Phase cutoffs indicate how 
likely the S-Phase estimate is within that category. For example, the area of the High 
category is 0.95; thus, there is a 95% chance that the specimen has a high S-Phase with 
your laboratory's specific S-Phase cutoffs. Normally in statistics, you express the probability 
of the hypothesis not being correct (p-value). In this case, the p-value is simply 1.0 - 0.95, or 
0.05, and it is the p-value which ModFit LT displays. 

That's just about all there is to it. Not only does ModFit LT indicate the variability of its 
estimate, but it also merges your S-Phase cutoffs with the derived probability distribution to 
provide you with just the information you need to convey to the physician about the 
proliferative activity of the specimen. Is the S-Phase high? How sure are you of this 
assessment? You can now answer both questions quantitatively. 

We promised you four graphs and have only shown three so far. Suppose the derived S-
Phase estimate was one of those borderline calls. It overlaps one of your S-Phase cutoffs. 
Let's modify the above graph to show that situation. 
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How do you classify this specimen? If you choose High, then you have a 25% chance of 
being wrong. When confronted with this situation it's best to combine two categories. By 
calling the specimen: Intermediate to High, the probability of being wrong is back to a 
reasonable level. What you are really saying is that the S-Phase is probably not Low. 

If ModFit LT determines that the certainty (probability) of a particular S-Phase level is less 
than 0.9, it will automatically combine the two most probable categories. If the certainty is 
still less than 0.9 with the combined categories, then the program will display a question 
mark (?) next to the corresponding S-Phase assessment. 

ModFit LT enables the inspection of the error distributions about each of its S-Phase 
estimates. If the sample is DNA diploid, only the diploid S-Phase error distribution can be 
evaluated. If the sample is DNA aneuploid or tetraploid, only the aneuploid and total S-Phase 
error distributions can be evaluated. 
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Using Auto Linearity 

  

Purpose: 

The purpose of this tutorial is to demonstrate the appropriate use of ModFit LT linearity 
controls. The goals of the tutorial are listed below. 

1. Define linearity and its potential effects on cell cycle analysis. 

2. Show an example of a fit with an inappropriate linearity setting. 

3. Demonstrate the manual method of adjusting linearity. 

4. Discuss the linearity configuration settings. 

5. Discuss a recommended approach to modeling with an optimized linearity setting. 

  

Definition and Potential Effects 

Linearity, in this discussion, is defined as the observed ratio between the DNA Diploid G2M 
and G0G1 positions. Theoretically, this value should be 2.0, but it can vary from this ideal 
value. 

Linearity affects cell cycle analysis in several ways. The first effect is that for models that 
have indistinct G2M peaks, the program uses the linearity setting to position the G2M in the 
fitting process. For example, if a G1 peak is found at channel 100, the G2M position would be 
at 200 with the linearity setting of 2.0. If the linearity setting were 1.9, the G2M position 
would be 190. 

The second major effect is on the aggregation model component. This model component 
assumes, for example, that doublet positions are twice singlet positions and triplet positions 
are three times the singlet positions. ModFit LT uses the linearity setting to transform the 
data so that it is perfectly linear prior to creating the theoretical shape of the aggregate 
distribution. Thus, linearity can also affect the positions of computed aggregates and affect 
the model fit and S-Phase estimate. 

How important is the linearity setting in estimating the S-Phase fraction? It can change S-
Phase estimates significantly, as shown in the next graph. 
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In this particular example, a linearity setting of either 1.90 or 2.1 results in approximately 
twice the aneuploid S-Phase estimate as a value of 1.99. 

Therefore, it is important to optimize this setting for a particular histogram and model in 
order to obtain accurate and consistent S-Phase estimates. 

  

Example of inappropriate linearity setting 

Here is a report demonstrating a model that used an inappropriate linearity setting. 

 

  

Notice that the Aneuploid S-Phase is quite high and the reduced chi-square is 1.97 for this 
analysis. 

In order to better appreciate the linearity effects, we also show a zoomed view of the graph. 
This allows us to easily see the Diploid G2M peak and aggregates. 

Notice that the diploid G2M model component has disappeared - overwhelmed by the 
aggregate component. 
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Automatic linearity detection from Quick Model Editor 

Let's use a feature in ModFit LT that is designed to automatically find this optimal linearity 
setting. 

Click the down-arrow on the right of the Fit button on the ribbon bar and choose Auto 
Linearity to trigger the command. 

 

  

With this method, the program models the data with a set of linearity settings, searching for 
the one that results in the lowest reduced chi-square. The message status bar in the lower-
left corner indicates its progress. 

After it has completed this analysis, it re-fits the histogram with the optimized linearity 
setting. For this example the optimized linear setting is 1.96. 
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The advantage of using the automatic linearity detection is that it potentially eliminates an 
important factor in S-Phase estimate variability. 

We can also automate the entire process with batch processing. 

  

Automatic linearity adjustment 

When you are processing a batch of files in a project, you can enable an option to perform 
auto-linearity on each sample file. This option is available for Cell Cycle projects. 

 

  

This setting optimizes linearity automatically for each file. 

  

Linearity configuration settings 

How does the program determine the starting and ending linearity value to test in the auto 
linearity detection system? These settings are stored in the Options and Configuration section 
of the program. This dialog can be displayed if you have administrative access to the 
program by choosing the Configuration command from the Options tab of the ribbon bar. 

 

  

ModFit LT contains reasonable default values for these settings. If your laboratory has a 
smaller range of possible linearity values, you can save considerable time by making the Low 
linearity and High linearity settings more restrictive. 

  

A recommended approach to modeling with an optimized linearity setting 
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Our recommended approach to the routine analysis of DNA files is as follows. First, find a 
good average linearity setting for your laboratory and enter it into the Auto Analysis Settings 
option in the program. You may also need to tailor other aspects of the auto analysis system 
as well. 

Second, enable Auto Linearity in your Cell Cycle projects to optimize the linearity value for 
each sample. 
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Optimizing Auto Analysis 

  

Research and Compliance Mode note: 
In RUO mode, all users can perform these tasks. 
In Compliance mode, only ModFitAdmins have permission to perform them. 

This section describes how to configure Auto Analysis to work with your data files. Three 
configuration dialogs are used to set up the program for Auto Analysis: Peak Finder Settings, 
Auto Analysis Settings, and Options and Configuration dialogs. By modifying the content of 
these three dialogs, you can optimize Auto Analysis to handle your data sets. 

There are two major benefits to configuring the Auto Analysis system correctly. First, it will 
reduce the amount of time you have to spend analyzing each file. Of equal importance, you 
will increase user-to-user consistency of analysis results. The time you spend configuring the 
system can save analysis time in very few analyses. 

  

Prerequisites 

In order to complete this process, you need a data set of twenty or more data files of the 
same cell type that have been acquired according to the same protocol. Your protocol for 
sample preparation, staining, and acquisition should be well defined and strictly followed. 
Since different types of samples may have different characteristics and preparation 
procedures, you may need to configure the program differently for each type of sample you 
analyze. 

  

Setting Options and Configuration 

From the Options tab, choose Configuration. This will display a dialog containing a 
number of configuration settings. Most of these settings do not need to be changed from the 
program default settings. 

One set of values you may need to adjust is found under the AutoLinearity section. The 
Low and High linearity values define the range over which the program can adjust the 
linearity during AutoLinearity adjustments when the AutoLinearity option is enabled. You 
should enter the acceptable range for G2/G1 ratios for your data set. 

Review other settings in this dialog. For details on each setting, see Options and 
Configuration. 

Make any adjustments required to the values. You may want to save these settings to a file 
that can be manually loaded back into the program. To do this, use the Save button at the 
bottom of the list in the dialog. When you need to re-open the saved settings, use the Open 
button. This also allows you to transfer settings from one computer to another. 

Click OK to close the dialog and accept the changes you have made. 
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Reviewing a Data Set for Important Peaks 

Next, the peak finder needs to be tested for your data set. 

Click the Open FCS button on the Home tab. Navigate to the location of your data set and 
select twenty or more of the files to be analyzed. Click the Open button. 

The program will open the first file in the set. If the file is a listmode file, you will need to 
select the parameter to analyze. 

There are two things to notice at this point. At the bottom of the application window, the 
program now displays a batch navigation toolbar. We will use this to review the data set. 
Secondly, the first histogram has one or more peaks identified with black triangles along the 
x-axis. These are the peaks that the program's Peak Finder has identified. When the program 
is correctly configured for your data set, it will identify the vast majority of the internal 
standards and G1 peaks for cell cycles in your data set. It will also identify many of the well-
defined G2M peaks, but these are not as critical as the G1 peaks. It should not identify many 
false peaks, that is, portions of the histogram that you do not consider to be real peaks. 

To review the data set, we need to tell the program what to do as we navigate through the 
batch of files. Click the left-most button on the batch control toolbar to display the properties 
for processing files. 

 

Set the options as follows: No analysis and do not save or print reports, do not prompt for 
database or files. This tells the program that all we want to do is open the data files as we 
navigate through the batch. 

Now, here is the process for peak finder review. For each file in the batch, record whether 
the program has identified all of the internal standards and the G1 peaks for each cell cycle. 
If the program misses an important peak, note the locations of peaks omitted. The major 
reasons peaks are missed are that they are too small, too wide, or they do not represent a 
normal, Gaussian distribution. All of these parameters can be adjusted in the program's peak 
finder. Also note the locations for any false peaks. For missing peaks and false peaks, try to 
note the characteristics of the peak, e.g. short, wide, shoulder. 

Make notations for the files, and then click the "Next" button on the batch toolbar. 
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Repeat this process for each file in the data set. 

  

Configuring Peak Finder Settings 

Review the notations you made for the data set. If the program correctly identified 95% or 
more of the peaks in your test data set, you probably do not need to make any adjustments. 
If the Peak Finder did not perform as well as it should, here is how to make adjustments to 
the settings. 

Hopefully, there are some common characteristics to the files that caused problems for the 
Peak Finder. 

Use the batch navigation buttons on the batch toolbar to re-open a histogram that is 
representative of the mistakes the Peak Finder made. 

Next, choose Peak Finder from the Options tab. The Edit Properties for Peak Finder 
settings dialog is displayed. 

Click the Show button at the top of the list of options. This will display a dialog that allows 
you to see the current histogram, and to understand the characteristics of each peak. 

As you move your mouse over the histogram, vertical lines will be displayed showing the 
boundaries for a peak that the program found. The lower portion of the dialog shows a 
number of peak filters, as well as the statistics for the peak your mouse is over. 
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Example of Peak Finder with a "missing peak" 

Move the mouse over a peak that the program did not identify. Look at the lower portion of 
the dialog for one or more of the settings that do not show the word "Pass". Adjust the 
sliders for the failing settings until all of the settings show "Pass" for the peak. 

If no vertical lines appear for a peak, the peak does not qualify as a statistically valid peak. 
This kind of error cannot be corrected in the Peak Finder. 

As you make adjustments, sweep your mouse across the histogram to review the status for 
all of the peaks. If you find that false peaks now "pass", you may need to compromise on 
your adjustments. If, however, the false peaks are very small, the program may exclude 
them from Auto Analysis for not passing other thresholds, so you should not worry about 
them at this point. 

Once you have made adjustments that satisfy the histogram, click OK to close the Peak 
Finder dialog and return to the Edit Properties for Peak Finder settings dialog. You may at 
this point choose to save these settings to a file using the Save button at the bottom of the 
list. Alternately, you may want to write down the new settings. Since this process is 
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experimental and may require several iterations, it is good to keep track of each set of 
adjustments. 

Click OK to close the dialog. 

Now you need to try out the new settings on the data set again. Move to the first file in the 
batch. Make notations for missing peaks and false peaks, and then move to the next file. 

Repeat this process of reviewing and adjusting until the Peak Finder is tuned for your data 
set. 

  

Adjusting Auto Analysis Settings 

The final phase in optimizing Auto Analysis for your data makes use of the Auto Analysis 
Settings dialog. This dialog controls how the program interprets the peaks in a histogram. 

From the Options tab, click Auto Analysis. The Auto Analysis Settings dialog will be 
displayed. 

The first three options are straightforward. We recommend that you enable AutoDebris and 
AutoAggregates, as these components are robust and automatic in the way they handle 
debris and aggregation in samples. The Apoptosis option should be disabled for Auto Analysis 
unless you have a series of files in which you want to model apoptosis as a Gaussian 
distribution below the first cycle's G1 peak. 

For Linearity, either leave the value at 2.0 or enter the average G2/G1 ratio of a data set. 
The G2/G1 ratio is easily computed by dividing the mean channel of a G2 peak by the mean 
channel of the G1 peak of the same cycle. Typical ranges are 1.95 to 2.0. 

In the Standards and Reference section, enter the number of internal standards your samples 
contain. If you have internal standards, you should click the Edit button to set the properties 
of the standards. The most important property to set for each standard is its expected 
channel position. By entering an expected position, the program can make better decisions 
about when peaks shift and where the first cycle begins. 

If you want to make use of an external reference standard for determining the location of the 
Diploid population, you should enter its channel location. This is only required if you want to 
base the Diploid position on the external reference. 

The Ploidy Determination section provides a number of interesting possibilities for assigning 
ploidy labels to peaks. We will examine these in detail. 

First, the Maximum cell cycles entry can in most cases be set to Unlimited. However, if you 
want to restrict Auto Analysis to creating models with a limited number of cell cycles, select 
the number of cycles in this drop down listbox. 

The Diploid determination list presents 4 options for determining which cycle is labeled 
"Diploid". The first option, "First cycle is Diploid", simply assumes that the first peak, after 
any internal standards and apoptosis, is the Diploid G1 peak. This option should be used for 
paraffin samples. When you use this option, you do not need to enter a value in the related 
field, Diploid-to-Standard ratio. 
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You can also choose to base the Diploid cycle decision on the position of one of the internal 
standards or an external reference channel position. In these cases, you need to enter the 
expected Diploid-to-Standard ratio. For example, if your 2nd internal standard appears at 
channel 40 and you expect the Diploid G1 to be at channel 50, you can choose "Based on 
Standard2" for Diploid determination and enter 1.25 for the Diploid-to-Standard ratio. (Note: 
The value 1.25 in this example is for PI-stained trout red blood cells in relation to PI-stained 
human Diploid cells. For DAPI staining or other internal standard cells, the ratio will be other 
values.) 

The G1 threshold field determines how big a peak has to be in order for it to be called a G1 
peak. This is a relative height after adjustment for aggregates. In essence, it acts like 
another filter in the Peak Finder specifically for G1 peaks. If you have a number of small 
peaks that Auto Analysis is calling G1 peaks and you do not want them classified that way, 
increase the G1 threshold about 2 or 3 units at a time until they are not longer considered G1 
peaks. 

The Peak Location Range field determines how much of a shift from the expected locations 
you will allow. For example, if the value is set for 10 (percent) and the Diploid is expected to 
occur at channel 50, the program will look for a peak between channel 45 and 55. Generally, 
values between 5 and 10 are best for this field. 

The S-Phase group does not require adjustments for most users. The settings are based on 
industry-standard recommendations and practices, so if you change these settings, it will be 
difficult or impossible to compare results in your lab with results of other labs. 

The Tetraploid group allows you to set the threshold at which the program will call a peak a 
Tetraploid G1 instead of a Diploid G2M. Recommended values range from 15 to 25, and you 
may need to experiment with these values on your data set. 

When you finish making your first adjustments to the settings, use the Save button to save 
the settings to a file on disk. As with other configuration dialogs, you may need to go through 
several iterations before you find the best settings for your data set. 

Choose OK to close the dialog. 

  

Testing the Auto Analysis settings 

At this point, you are ready to test the full system. 

Change the file processing settings to Auto-analyze each data file that you open.  

Click the "go to first" button on the batch control toolbar. The first file will be opened and an 
Auto Analysis will be performed. Make a notation to indicate whether the program correctly 
analyzed the data. Pay particular attention to the ploidy classifications for each cycle and the 
graphical representation of the fit. 

Advance to the next file. After the program auto-analyzes the file, make notations about the 
success or failure of the program. Repeat this process for the entire data set. 

After all files have been processed with Auto Analysis, review your notations. The goal is to 
have the program work automatically for greater than 95% of the files. If you need to make 
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additional adjustments, repeat the process of reviewing and adjusting until you achieve the 
best results. 

When you have the settings that work best, display the Auto Analysis Settings dialog once 
again. Save the settings to a file using the Save button. Click OK to close the dialog. 

  

Summary 

The process of tuning Auto Analysis for your own data sets involves three dialog boxes: 
Options and Configuration, Peak Finder Settings, and Auto Analysis Settings. After setting up 
configuration options, an iterative process is used to find the best Peak Finder Settings for a 
data set. As the final step, a similar iterative process is used to tune the Auto Analysis 
Settings to a data set. 

Use a data set of samples from the same cell or tissue type. As you perform this process for 
a data set, save your settings for each dialog box so that they can be reloaded at any time. 

You should perform this process for different sample types if the preparation process or the 
data files themselves have difference characteristics from the data set initially used to 
optimize Auto Analysis. 

You will always find some files in a data set that are unusual when compared with the rest. 
Do not try to optimize Auto Analysis for unusual data, or you will find that it fails more often 
than it works. Instead, base your decisions on the typical data in a data set, and you will find 
the system has a much higher success rate. 

  

See also: 

Options and Configuration 

Peak Finder Settings 

Auto Analysis Settings 
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DDE Support 

  

NOTE: This feature is only available on Windows versions of ModFit LT. DDE is not supported 
on the Macintosh. 

Dynamic Data Exchange (DDE) in ModFit LT allows the program to be driven by and to 
provide information to other applications. WinList 3D can use DDE to connect with ModFit LT 
and to share data with it. In most cases, the DDE scripts provided with WinList 3D are 
sufficient for this interaction. If you have another application you want to connect with 
ModFit LT using DDE, please contact Verity Customer Support. 
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Strengths and Limitations of Automatic Analysis 

  

ModFit LT uses some very sophisticated logic when it attempts to automatically analyze your 
data. The system has been designed to work with a great variety of data samples, samples 
that vary in almost an unlimited number of ways. When your data samples fit into the 
assumptions built into the automatic analysis functions, the program works well in 
automatically modeling them. Conversely, as you might expect, the automatic systems do not 
work as well when your samples differ from what it has been designed to analyze. 

To better understand the strengths and limitations of automatic analysis, it may be helpful to 
examine some of the assumptions built into the system. 

Peak Finder 

When you open a data file with the program, one of the first things the software attempts to 
do is locate "peaks" in the sample. This step is the foundation of automatic analysis: if it finds 
the important peaks in the sample, the remaining steps in auto-analysis have a good chance 
at succeeding. If it cannot detect the important peaks, it will more than likely have difficulty 
or may fail to automatically analyze the sample. 

While it is relatively easy for our eyes to see peaks in a histogram, the computer algorithms 
that perform this function are anything but simple. The process ModFit LT uses works well 
with the large library of data files we use to test the system. Here is how it works. 

The program performs a statistical analysis of the histogram to identify potential peaks. Then 
the peak finder begins to filter out peaks that do not meet certain criteria. There are filters 
for high and low %CV, relative peak height, and how well the peak can be fitted with a 
Gaussian in a quick analysis. These filters can be viewed in the Peak Finder Settings dialog. 

If one or more of the filtering criterion filters out an important peak, the system will likely fail 
in a later step. For this reason, you can adjust some of the filters used by the peak finder so 
that the system better matches the data samples analyzed in your laboratory. 

A very important note on the peak finder settings: adjusting one or more settings to work 
with a single sample is a bad idea. The reason is simple: without looking at numerous 
samples to test your new setting, you may find you have fixed the peak finder for one 
exceptional sample, and broken it for the typical sample. Weigh your adjustments carefully. 
Do not make adjustments to accommodate a single sample; use manual analysis to handle 
the exception. 

Ploidy Detection 

The peak finder identifies the peaks it finds by displaying a small, black triangle under the 
peaks on the histogram display. The next step in automatic analysis is to look at the pattern 
presented by those peaks and attempt to match the pattern to a type of histogram the 
program knows about. This occurs when you click the Auto button on the toolbar, or choose 
Automatic Analysis from the Analysis menu. 

So just what is an "important" peak? 
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The most important peaks the program needs to find are peaks for internal standards, 
apoptosis, and G0G1 peaks for each cycling population. If the program finds these peaks, it 
generally succeeds in auto-analysis. 

You need to tell the program how many standard peaks your sample contains. This is done in 
the Auto Analysis Settings dialog box. The program assumes that standard peaks, if any, are 
the first peaks, followed by an apoptosis peak, if selected, and the remaining peaks are 
cycling population peaks. 

If you have correctly informed the program as to how many standard peaks the sample 
contains and whether or not it has an apoptosis peak, and the peaks found by the peak 
finder are the important peaks, the ploidy detection step is off to a good start. 

The remaining step is a pattern-matching step, which ignores standard and apoptosis peaks. 
Here, the program analyzes relative sizes and positions of the peaks remaining, looking for 
cell cycles. ModFit LT is designed to handle any number of cell cycles in a histogram, though 
it is rare to find samples with more than 4 cell cycles. 

In general, the more complicated the histogram, the more difficult it is to classify. You may 
need to manually analyze very complex samples. 

Once the sample is classified, a model is created to match the pattern. Then ranges are 
assigned to important peaks, and the non-linear least-squares analysis of the sample is 
performed. 

Debris and Sample Quality 

As you might expect, the success of automatic analysis is closely linked to the quality of the 
data you want to analyze. Samples with lots of debris or aggregation detract from the 
program's ability to find peaks or determine the right model to use. Efforts to gate out debris 
and aggregation sometimes work, but they are usually going to work against the program's 
built-in functions designed to compensate for debris and aggregates. The better solution is to 
perfect the sample preparation and acquisition techniques you use. Starting off with a cleaner 
sample greatly simplifies the peak and ploidy detection operations, and helps ensure that the 
peaks seen by you and the program are real peaks. 

Follow the suggestions of experts to prepare and analyze your samples. Establish standards 
that must be met before a sample can be considered for analysis. The DNA Consensus 
Conference (Cytometry. Vol. 14. Number 5, 1993) made many specific recommendations on 
DNA analysis, many of which relate to sample quality. Your standards should be at least as 
restrictive as those presented in that report. 

Be aware of obvious things, as well. If you accidentally try to analyze forward angle light 
scatter instead of the DNA parameter, you will end up with nonsensical information when you 
perform automatic analysis. 

Your Responsibilities 

Based on this discussion, it is probably obvious that there are numerous ways automatic 
analysis of your samples can fail. The problem is that the program itself doesn't know when it 
has failed; only you can make that determination. 
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You should view automatic analysis with scientific skepticism. You must review the 
information on the report to ensure all the model matches your understanding of the 
histogram. You should always review the results of an automatic analysis to ensure that the 
program has identified the standard peaks, apoptosis peaks, and G0G1 peaks of the cycling 
populations. In addition, you should verify that the ploidy classification assigned by the 
program concurs with your knowledge of the sample. 
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